NetWitness Platform
Version 12.4

System Maintenance Guide

S NETWITNESS

Platform




Contact Information

NetWitness Community at https://community.netwitness.com contains a knowledge base that answers common
questions and provides solutions to known problems, product documentation, community discussions, and case
management.

Trademarks

RSA and other trademarks are trademarks of RSA Security LLC or its affiliates ("RSA"). For a list of RSA
trademarks, go to https://www.rsa.com/en-us/company/rsa-trademarks. Other trademarks are trademarks of their
respective owners.

License Agreement

This software and the associated documentation are proprietary and confidential to RSA Security LLC or its
affiliates are furnished under license, and may be used and copied only in accordance with the terms of such
license and with the inclusion of the copyright notice below. This software and the documentation, and any copies
thereof, may not be provided or otherwise made available to any other person.

No title to or ownership of the software or documentation or any intellectual property rights thereto is hereby
transferred. Any unauthorized use or reproduction of this software and the documentation may be subject to civil
and/or criminal liability. This software is subject to change without notice and should not be construed as a
commitment by RSA.

It is advised not to deploy third-party repos or perform any change to the underlying NetWitness Operating System
that is not part of the supported NetWitness version. Any such change outside of the NetWitness approved image
may result in a service or functionality conflict and require a reimage of the NetWitness system to bring
NetWitness back to an optimized functional state. In the event a third-party repo is deployed, or other non-
supported change is made by the customer without NetWitness approval, the customer takes full responsibility for
any system malfunction until the issue can be remediated through troubleshooting efforts or a reimage of the
service.

Third-Party Licenses

This product may include software developed by parties other than RSA. The text of the license agreements
applicable to third-party software in this product may be viewed on the product documentation page on NetWitness
Community. By using this product, a user of this product agrees to be fully bound by terms of the license
agreements.

Note on Encryption Technologies

This product may contain encryption technology. Many countries prohibit or restrict the use, import, or export of
encryption technologies, and current use, import, and export regulations should be followed when using, importing
or exporting this product.

Distribution

Use, copying, and distribution of any RSA Security LLC or its affiliates ("RSA") software described in this
publication requires an applicable software license.

RSA believes the information in this publication is accurate as of its publication date. The information is subject to
change without notice.

THE INFORMATION IN THIS PUBLICATION IS PROVIDED "AS IS." RSA MAKES NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND WITH RESPECT TO THE INFORMATION IN
THIS PUBLICATION, AND SPECIFICALLY DISCLAIMS IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Miscellaneous

This product, this software, the associated documentations as well as the contents are subject to NetWitness’
standard Terms and Conditions in effect as of the issuance date of this documentation and which can be found at
https://www.netwitness.com/standard-form-agreements/.

© 2024 RSA Security LLC or its affiliates. All Rights Reserved.
April, 2024


https://community.netwitness.com/
https://www.rsa.com/en-us/company/rsa-trademarks
https://www.netwitness.com/standard-form-agreements/

Contents

System Maintenance ... . 12
Review Best Practices ... .. . 13
Safeguarding Assets with NetWitness Supplied Policies ............................................................ 13
Safeguarding Assets with Policies Based on Your Environment ..................................................... 13
Creating Rules and Notifications Judiciously ............................... 13
TroublesShoOting ISSUES ......... ..o e 13
Monitor NetWitness Platform Health ... . ... 14
Monitor Health and Wellness using NetWitness Platform UI ... 15
Manage PoliCies ... ... ... 16
Add a PoliCy ... 16

Add Policy Example ... 19

Edit @ POliCY o 21
Duplicate a POLICY ... 22

Assign Services Or GrOUPS ... 23
Remove Services O GrOUDPS ... 25

Addor Edita Rule ... 25

Hide or Show Rule Conditions Columns ..................................................................... 26

Delete a RuUle ... 27
Suppress a Rule ... 27
Suppress @ PoliCY ... 28

Add an Email Notification ... 28

Delete an Email Notification ... 28

Include the Default Email Subject Line ... 29

Monitor System StatiStiCs ... 32
Filter System StatiStics ... ... ... 33

View Historical Graphs of System Statistics .................................................................. 36
Monitor Service StatiStics ... 37
Add Statistics to a Gauge or Chart ... 38

Create a Gauge for a StatiStic ............. ... 38

Create a Timeline Chart for a Statistic ... 38

Search for a Statistic in the Chart Stats Tray ... 39

Edit Properties of Statistics Gauges ... 40

Edit Properties of @ Gauge ... 40

Add Stats to the Gauges Section ... 40
Edit Properties of Timeline Charts ... ...
Edit Properties of a Timeline ... 42



System Maintenance Guide

Edit Properties of a Historical Timeline ................................................................ 42

Add Stats to Timeline Charts ... 43
Monitor HOStS and SETVICES .................oiiiiiii e 44
Filter Hosts and Services in the Monitoring View ... 45
Monitor Host Details ... 47
Monitor Service Details ... 48
Monitor Event SOUICes ... 51
Monitor AIArmS ... ... 52
Monitor Health and Wellness Using SNMP Alerts ... 54
SNMP Configuration ... 54
Thresholds ... ... 54
Configure SNMPv3 fora Host ... 54

Set the Threshold for a Service ... 55

SNMP Traps for System Status ... 56
Troubleshooting Health & Wellness ... 57
Issues Common to All Hosts and Services ..o 57
Issues Identified by Messages in the Interface or Log Files ................................................ 57
Issues Not Identified by the User Interface or Logs .......................................................... 62
Monitor New Health and Wellness ......................... 64
Dashboard ... 64
ViISUAlIZALION ... 64
IMIOMIEOTS ..o 65
NOHTICAtIONS ... ..o 65
Installing New Health and Wellness ... . .. ... 65
Accessing New Health and Wellness Dashboards ........................................................... 65
Configuring Notifications ... 66
Adding Alert Notifications ... 67
Suppressing Notifications ... 68
Monitoring through Dashboards ......... ... . 69
Creating a Custom Dashboard .......... ... .. . 70
Monitoring through Alerts ... 71
Creating Custom MONILOTS ... 73
Adding Custom Trigger to an Existing Monitor ............................................................... 74
Managing Dashboards and Alerts ... 76
Modify a Dashboard ... ... 76
Delete a Dashboard ... 76
Delete a VISUALIZAtION ..............cooiiiii i e 77
Modify an Existing Trig@er ... ... 77
Managing Notifications ... 78
Modify a Notification ... . 78
Modify a Notification Suppression Policy ... 78




System Maintenance Guide

Advanced Configurations ... ... ... 79
Restore Default Content ... 79

Enable SeTVICES ... 79

DiSable SETVICES .........coo it 80

Update an Interval .. .. . 81

Update the Default Configuration ... 82

Configure the Data Retention Policy ... 84

Backup and Restore New Health and Wellness ... 88
Troubleshooting New Health and Wellness ............................... . 89
ADPPCNAICES ... 91
New Health and Wellness Dashboards ... 92
Deployment Health Overview Dashboard ... 92

Hosts Dashboard ... 94

Logs Dashboard ... 96
Packet Overview Dashboard ... 98
Analysis Dashboard ... 100
Endpoint Dashboard ... 102

ESA Correlation Overview Dashboard ... 104
Logstash Input Plugin Dashboard ........................................................................ 105
License Usage Dashboard ... . 107

New Health and Wellness MONItOrs ... 112
Uninstall New Health and Wellness ... ... 115
Manage NetWitness Platform Updates ... 119
Reissue Certificates ... . 120
Introduction ... .. ... 120
CA Certificate ReISSUES ... 120
Service Certificate REISSUC ... 120
Reissuing Service CertifiCate .......... ... 121
When to Use the --host-all Argument ... .. 122
cert-reissue Arguments and Options for AIL HOStS ... 122
When to Use the Individual Host Argument (--host-key <ID, IP, hostname or display name of host>) ...123
Reissuing Certificates for All Hosts Except Windows Legacy Collection (WLC) host ........................ 124
Running the Cert-Reissue Command for AL Hosts ... 124
Running the Cert-Reissue Command for an Individual Host ................................................... 124
Reissuing Certificates for a WLC HOSt ... ... .. 124
Successful Reissue Summary Report ... 125
Unsuccessful Reissue Summary Reports ... 125
Reissue Failed for Host and Aborted Command ................................................................. 125
Reissue Certificate Partially Executed .............................. ... 126




System Maintenance Guide

Display System and Service LOgS ... 127
VIeW SYS e L0 @S .. 127
Display Service LOZS .......coooiii 127
Filter Log ENtries ... ... 128
Show Details of a Log ENtry ... 128
Access Reporting Engine Log File ... 130

ANl Log Files ... oo 130
UPSTart LO@S ... o 130
Search and Export Historical Logs .................o. 131
Display the Historical System Log ... 131
Display a Historical Service Log ... 131
Search Log Entries ... 132
Show Details of a Log Entry ... 132
Page Through Log Entries ... 133
Export a Log File ... 133

Maintain Queries Using URL Integration ... 134
Edit a QUeTY .o 134
Delete a QUETY ... i 135
Clear ALl QUETIES ... e 135
Usea Query in a URI ... 135

Manage the deploy_admin Account ... ... 137
Change the deploy_admin Account Password ................................. .. 137
Change the deploy admin Account Password in a Mixed Version Environment ................................ 137
Change the deploy_admin Account Password for a Component Host that is Unavailable .................... 138

NW Server Host Secondary IP Configuration Management ... . 139

Change Host Network Configuration ... 140
Change Host Network Configuration ................................. ... 140

S 0 143
Reporting Engine ... ... 144
UCE 145
P A 145
B AT 145
RSA NetWitness Orchestrator (By Demisto) ..., 148
AUdit LOZINg ..o 149
Health and Wellness ... 149
Malware ANalySIS ... ... 149
Windows Legacy Collection .....................o 150
Change Network Configuration for Warm Standby (Secondary) Server ........................................... 151
Reconnecting Component Hosts with NW Server Hosts ... ... 151




System Maintenance Guide

Manage Custom Host Entries ... . 153
Manage Custom Host Entries in /etc/hosts ... ... . 153
Manage Public or NAT IPv4 Addresses for Hosts ... ... 153
Manage Custom Jetty Configuration ... 153

Configure FIPS SUppoOrt ... . 155
FIPS support for Log Collectors ... .. ... 156
FIPS support for Log Decoders and Decoders ... 156

DISA STIG 158
How STIG Limits ACCOUNt ACCESS ... ...t 158
NetWitness PassWords ... ... 158
Generate the OpenSCAP Report ... ... 158

Install Open S C A P . 159

Sample RO POTt . 159

Report Fields ... 160

161

Create the OpenSCAP Report ... 161

Manage STIG Controls Script (manage-stig-controls) ... 161

CommMANAS ... 162

Control GrOUPS .. ... 162

Other ATGUMENTS ... .. .. e 163

RuULes LSt . 164

Exceptions to STIG Compliance ....................o 187

Key to Elements in Exception DesCriptions ........... .. ... 187

CCE NUMDECT ... 187

Control Group ID ... . 187

OOk o 188

COMIMENTS ... o 188

Customer Responsibility EXCEPtiONS ....... ... 188

CCE-80844-4 Install AIDE (Control Group =1/a) ... 188

CCE-80869-1 Ensure SELinux State is Enforcing ......................................................... 188

CCE-80901-2 Disable SSH Root Login (Control Group = ssh-prevent-root) ......................... 188

CCE-86260-7 Virus Scanning Software Definitions Are Updated (ENSL) (Control Group =

TV@) 188

CCE-80942-6 Enable FIPS Mode (Control Group = fips-kernel) ........................................ 189

CCE-82891-3 Configure Notification of Post-AIDE Scan Details (Control Group =n/a) ......... 189

CCE-84220-3 Configure AIDE to Verify Access Control Lists (Control Group =n/a) ............ 190

CCE-83733-6 Configure AIDE to Verify Extended Attributes (Control Group =n/a) ............. 190
CCE-84029-8 Install Smart Card Packages For Multi-Factor Authentication (Control Group =

TV @) 190

CCE-27309-4 Set Boot Loader Password in grub2 (Control Group = fips-kernel) .................. 191




System Maintenance Guide

Exceptions That Are Not a FINAing ... 191
CCE-80852-7 Ensure /var Located On Separate Partition (Control Group =n/a) ................... 191
CCE-80775-0 Set GNOME3 Screensaver Inactivity Timeout (Control Group =n/a) .............. 191
CCE-80670-3 Set Lockout Time For Failed Password Attempts (Control Group = auth) ......... 192

CCE-80854-3 Ensure /var/log/audit Located On Separate Partition (Control Group = audit) .... 192
CCE-80916-0 Enable Randomized Layout of Virtual Address Space (Control Group =n/a) .... 192

CCE-80763-6 (Control ID = 2) Modify the System Login Banner (Control Group = ssh) ........ 193
CCE-80905-3 Enable SSH Warning Banner (Control Group =mna) ..................................... 193
CCE-80156-3 Disable Kernel Parameter for Sending ICMP Redirects for All Interfaces
(Control GroUP = 1/8) ..o 194
CCE-80157-1 Disable Kernel Parameter for IP Forwarding (Control Group =n/a) ................ 194
CCE-80158-9 Configure Kernel Parameter for Accepting ICMP Redirects for All Interfaces
(Control GroUP = 1/a) ..o 194
CCE-80163-9 Configure Kernel Parameter for Accepting ICMP Redirects By Default (Control
GIOUP = 11/8) ..o 194
CCE-80165-4 Configure Kernel Parameter to Ignore ICMP Broadcast Echo Requests (Control
GIOUP = 11/8) ..o 195
CCE-80438-5 Configure Multiple DNS Servers in /etc/resolv.conf (Control Group =n/a) ....... 195
CCE-80447-6 Configure the Firewalld Ports (Control Group =n/a) .................................... 195
CCE-80877-4 Verify firewalld Enabled ... 196
CCE-80854-3 Ensure /var/log/audit Located On Separate Partition ..................................... 196
CCE-80851-9 Ensure /tmp Located On Separate Partition ................................................ 197
CCE-80852-7 Ensure /var Located On Separate Partition ................................................. 197
Rules Supported in a Future Release ... 197
CCE-80920-2 Disable Kernel Parameter for Accepting Source-Routed Packets on IPv4
Interfaces by Default ... . 197
CCE-86220-1 Disable Kernel Parameter for IPv4 Forwarding on all IPv4 Interfaces .............. 198
CCE-81006-9 Disable Accepting ICMP Redirects for All IPv6 Interfaces ............................ 198
CCE-81013-5 Disable Kernel Parameter for Accepting Source-Routed Packets on all IPv6
INEEITACES .. .o 198
CCE-82863-2 Disable Kernel Parameter for IPv6 Forwarding ........................................... 198
CCE-81007-7 Disable Accepting Router Advertisements on all IPv6 Interfaces by Default ..... 199
CCE-81010-1 Disable Kernel Parameter for Accepting ICMP Redirects by Default on IPv6
It aces .. o 199
CCE-81015-0 Disable Kernel Parameter for Accepting Source-Routed Packets on IPv6
Interfaces by Default ... 199
Troubleshoot NetWitness Platform ... 200
Debugging Information ................. ... 201
NetWitness Log Files ... 201
Files Of INTETEST ..o e 201
Error Notification ................ . 203
MISCRllANEOUS TIPS .. . 204
AUt Log M eSS ..o 204




System Maintenance Guide

NwConsole for Health & Wellness .......... ... ... 204
Thick Client Error: remote content device entry not found ..................................................... 204
View Example Parsers ... ... 204
Configure WinRM Event SOUICES ... ... 204
Troubleshoot Feeds ... 205
OVEIVIBW .o 205
DtaIlS 205
How 1t WorKS ... 205
Feed File ... 205
TroUbl eSO I g . 206
Feed File EXISteNce ... 206

Group Meta Populated on LD ... . 206

Device Group Meta on CONCentrator ............... ... 207

SMS Log File ..o 207

Verify Logstats Data is Getting Read and Published by ESMReader and ESMAggregator ....... 208
Configure JIMX Feed Generator Job Interval ................................................................ 210
Troubleshooting Cert-Reissue Command ... 212
Argument Options Used for Troubleshooting ... ... . 212
Problems and How to Troubleshoot Them ................. ... ... . . 213
References ... . 217
Health and Wellness VIEW ... 218
Health and Wellness View - Alarms View ... ... 219
What do you want to do? ... ... 219

Related TOPICS ... 219

QUICK 00K . 219

Alarm Details Panel ... 221

Event Source Monitoring VIeW ... .. 222
Health and Wellness Historical Graphs ... . 223
Historical Graph View for Events Collected from an Event Source .................................... 224
Historical Graph for System Stats ... 225

Health and Wellness Settings View - Archiver ... 227
What do you want to do? ... ... 227

QUICK 00K . 227
Features .. ..o 227

Health and Wellness Settings View - Event SOurces ... 229
Health and Wellness Settings View - Warehouse Connector ................................................... 230
Access the Warehouse Connector Monitoring View .......................cccooiiiiiiiii 230

What do you want t0 do? ... ... 230

Related tOPICS ... ..o 230

QUICk 00K .o 230




System Maintenance Guide

Warehouse Connector Monitoring parameters ....................oooii e 231
Monitoring VIEW ... 232
What do you want to do? ... .. ... 232
QUICK 00K . 232
Groups Panel ... ... 232
Hosts Panel ... 233
Archiver Details VIeW ... 235
Broker Details VIEW ... .. ... 237
Concentrator Details VIEW ... 238
Decoder Details VIEW ... 239
ESA Correlation Details VIeW ... 241
Health Stats Tab ... 241
JVMITAD Lo 242
ESA Analytics Details VIeW ... 243
Host Details VIEW ... 244
Log Collector Details VIeW ... .. .. 246
Collection Tab ... 246
Event Processing Tab ... .. 246
Log Decoder Details VIEW ... .. ... 248
Malware Details VIEW ... ... 250
Warehouse Connector Details VIew ... 251
Policies VIEW ... . 252
What do you want to do? ... ... . 252
QUICK 00K . 252
Policies Panel ... 252
Policy Detail Panel ... ... . 253
Groups dialog ... ... 255
RULES DIalog ... 255
Threshold Operators ... .. ... 257
Health & Wellness Email Templates ............................. ... 258
Health & Wellness Default SMTP Template ... ... 258
Alarms Template ... 259
NetWitness Platform Out-of-the-Box Policies ................................... . 260
System Stats Browser VIeW ... ... 266
What do you want to d0? ... . 266
Related TOPICS .. ..o 266
QUICK 00K . 266
o TS 267
Commands ... 267
System Stats View Display ... ... 267

10



System Maintenance Guide

New Health & Wellness Tab ... 269
What do you want t0 d0? ... . 269
Related TOPICS ... 269
QUICK 00K . 269

System View - System Info Panel ........................ .. 271

System Updates Panel - Settings Tab ... 273
What do you want t0 d0? ... ... 273
Related TOPICS ... 273
QUICK 00K . 273
Features ... 273

System Logging - Settings VISW ......... ... 275
What do you want t0 do? ... ... 275
Related TOPICS ... 275
QUICK 00K 275
B atUTeS . 276

L0g SetINgS ..o 276
Package Configuration ... .. ... .. 276

System Logging - Realtime Tab ... 278
What do you want to do? ... .. ... . 278
Related TOPICS ..o 278
QUICK 00K 278
FeatUreS o 279

TO0Ibar .. 279
Log Grid Columns ........ ... 280

System Logging - Historical Tab ... ... 281
What do you want to d0? ... . 281
Related TOPICS ... 281
QUICK 00K . 281
Features ... o 282
Search Log Entries ... ... 283
Show Details of a Log Entry ... 283

Page Through the Entries ... 284
B OTt 284

11



System Maintenance

This guide tells administrators how to manage hosts and services in the network, maintain and monitor
the network, run jobs, and tune performance after initial network setup.

The following diagram shows the different system maintenance tasks available to you.

Monitor . Maintain .
Manage NW Review queries used Configure Change Host EENT

Troubleshoot

Review best health of NW Platform SsT 2 NW Platform

practices Platform host ) for FIPS Support |IP Addresses
updates service logs . .
system investigation

DISA STIG
Hardening

system issues

The following topics describe these tasks:

e Review Best Practices

e Monitor Health and Wellness using NetWitness Platform Ul

e Manage NetWitness Platform Updates

e Display System and Service Logs

e Maintain Queries Using URL Integration

e Configure FIPS Support

e Change Host Network Configuration
e DISA STIG

¢ Troubleshoot NetWitness Platform

12 System Maintenance



Review Best Practices

Review the following best practices to maintain your NetWitness Platform deployment.

Safeguarding Assets with NetWitness Supplied Policies

The purpose of the NetWitness core policies delivered with NetWitness are for safeguarding your
NetWitness domain assets immediately (before you configure rules specific to your environment and
your security policy).

NetWitness recommends that you set up email notifications to the appropriate asset owners for these
policies as soon as possible. This will notify them when performance and capacity thresholds are crossed
so they can take action immediately.

NetWitness also recommends that you evaluate the core policies and disable a policy or change its
service and group assignments according to your specific monitoring requirements.

Safeguarding Assets with Policies Based on Your

Environment

NetWitness core policies are generic and may not provide sufficient monitoring coverage for your
environment. NetWitness recommends that you gather issues over a period of time, that are not
identified by the NetWitness core policies, and configure rules to help you prevent these issues.

Creating Rules and Notifications Judiciously

NetWitness recommends that you make sure that each rule and policy is necessary before you implement
it, if possible. NetWitness also recommends that you review implemented policies on a regular basis for
their validity. Invalid alarms and email notifications can adversely affect the focus of the asset owners.

Troubleshooting Issues

NetWitness recommends that you review Troubleshooting Health & Wellness and Troubleshoot
NetWitness Platform when you receive error messages in the user interface and log files from hosts and
services.

13 Review Best Practices



Monitor NetWitness Platform Health

Monitor the Health & Wellness of the NetWitness using any of the following:
e Monitor Health and Wellness using NetWitness Platform Ul

e Monitor New Health and Wellness

14 Monitor NetWitness Platform Health



Monitor Health and Wellness using NetWitness Platform Ul

The Health & Wellness module of NetWitness enables you to:

e View the current health of all the hosts, all services running on the hosts, and various aspects of the
health of your hosts.

* Monitor the hosts and services in your network environment.
e View details of various event sources configured with NetWitness.

* View system stats for the selected hosts by filtering the views as required.

You can also configure Archiver and Warehouse Connector monitoring, monitor host statistics, and
work with system logs to monitor NetWitness.

Note: All users have permission to view the entire Health and Wellness interface by default. The
Administrator and the Operator roles are the only roles that can manage the Policies view by default.
Refer to the "Role Permissions" topic in the Security User Management Guide for a complete list of
the default permissions for the NetWitness Interface.

The following figure displays the Health & Wellness module of the NetWitness user interface.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness
Time State Severity  Rule Name Service Hostname 1P Address Stat Value 35
2021-04-30 01:48:36 M Active @ Critical  Lockbox Access Failure Warehouse Connector logdecoder 10.125.250.160 Lockbox/Lockbox Status NotFou 3
[ 2021-04-3001:43:04PM  Active @ Critical  Lockbox Access Failure Warehouse Connector decoder 10.125.250.155 Lockbox/Lockbox Status NotFou %
2021-04-3001:42:37 PM  Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder endpointloghybrid1 10.125.250.162 Pool/Packet Capture Queue 0 %
[ 2021-04-3001:42:37 PM  Active @ Critical  Log Decoder Capture Rate Zero Log Decoder endpointloghybrid1 10.125.250.162 Capture/Capture Packet Rate (current) 0
2021-04-30 01:42:37PM Active @ Critical  Log Decoder Capture Not Started Log Decoder endpointloghybrid1 10.125.250.162 Capture/Capture Status stoppec
[ 2021-04-3001:4224 PM  Active @ Critical  Concentrator Meta Rate Zero Concentrator endpointloghybrid1 10.125.250.162 Concentrator/Meta Rate (current) 0
2021-04-30 01:42:24 P Active @ Critical  Concentrator Aggregation Stopped Concentrator endpointloghybrid1 10.125.250.162 Concentrator/Status stoppec
[ 2021-04-3001:33:03PM  Active @ Critical  Decoder Capture Rate Zero Decoder decoder 10.125.250.155 Capture/Capture Packet Rate (current) 0
2021-04-3001:32:13PM  Active @ Critical  Decoder Capture Not Started Decoder decoder 10.125.250.155 Capture/Capture Status stoppec
[ 2021-04-3001:32:13PM  Active @ Critical  Decoder Packet Capture Pool Depleted Decoder decoder 10.125.250.155 Pool/Packet Capture Queue 0
[ 2021-04-3001:31:42 PM  Active @ Critical  Log Decoder Capture Rate Zero Log Decoder logdecoder 10.125.250.160 Capture/Capture Packet Rate (current) 0
2021-04-30 01:31:42PM  Active @ Critical  Log Decoder Capture Not Started Log Decoder logdecoder 10.125.250.160 Capture/Capture Status stoppe(
[ 2021-04-3001:31:42PM  Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder logdecoder 10.125.250.160 Pool/Packet Capture Queue 0
2021-04-30 01:07:52PM  Active @ Critical  Broker Aggregation Stopped Broker adminserver 10.125.250.154 Broker/Status stoppe(
[ 2021-05-0607:33:37 PM  Active @ High High System Swap Utilization Host adminserver 10.125.250.154 Systeminfo/Swap Utilization 50.84%
2021-04-30 01:07:56 M Active @ High  Respond Server in Unhealthy State Respond Server adminserver 10.125.250.154 Processinfo/Overall Processing Status Indicator PARTIAI
[T 2021-04-3001:07:52 PM ___ Active @ Higf Broker Session Rate Zero Broker adminserver 10.125.250.154 Broker/Session Rate (current) 0 h
>
| Page 1 of1 | | C ™ AutoRefresh Items 1-19 of 19
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Manage Policies

Policies are either user-defined or supplied by NetWitness. A policy defines:
e Services and hosts to which the policy applies.

* Rules that specify statistical thresholds that govern alarms.

e When to suppress the policy.

e Who to notify when an alarm triggers and when to notify them.

For related reference topics, see NetWitness Platform Out-of-the-Box Policies

Note: You can now configure a policy to notify Public Key Infrastructure (PKI) certificate expiration
status.

Add a Policy

A
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

The Policies view is displayed.

NETWITNESS Iny te Respond sers Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES END ES  HEALTH & WELLNESS

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness

Policies Admin Server: Admin Server Monitoring Policy save
+ Z B Rules and suppression schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them
™ Enable Last Modified: 2017-02-20 12:00:00 AM
43 Admin Server )
Admin Server Monitoring Policy Services

» D Archiver o Choose the hosts, services, and groups that your health policy applies to.
» (8roker D +
» (D concentrator () Name ~ Group Type

Al 10 Grouj
» [ Config Server o P
» [JContent Server )

< Rules
» [ Contexthub Server ) Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the
alarm clears). After you define the alarm rule, enable o disable the alarm

» (I Decoder
» [JEsA Correlation o

Enable Name ~ Severity Category Statistic Threshold
» (JEndpoint Broker Server

Admin Server in Crit... ~ Critical Processinfo Overall Processing Status Indicator Alarm = ERROR for 2 MINUTES
» CJendpoint S )
Dendpoint server o Admin Server in Un...  High Processinfo Overall Processing Status Indicator Alarm = PARTIALLY_WORKING for 2 MINUTES

» (JHost o Admin Server Stopp...  Critical Processinfo Service Status Alarm 1= started for 0 MINUTES
» Cintegration Server (1]

Palicv Siinnraccinn

3. Click + - in the Policies panel.
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A list of your hosts and services displays for which you can create health policies.

Alarms Monitoring

Policies

+ - I ‘el
Admin Server
Archiver
Broker

Cloud Gateway Server
Concentrator

Config Server
Content Server
Contexthub Server
Correlation Server
Decoder

Endpoint Server
Entity Behavior Analytics
Event Stream Analysis
Host

Integration Server
Investigate Server
Log Collector

Log Decoder
Malware Analysis
Orchestration Server
Reporting Engine
Respond Server
Security Server
Source Server

UEBA Server

Warehouse Connector

E Workbench

Policies

17



System Maintenance Guide

4. Select a host or service (for example, Concentrator).
For a PKI policy, you must select a host (for example, Host).
The host or service is displayed in the Policies panel with a blank Policy Detail panel.

Polic
$o =~F | B X
» A
b D Broker
4 & Concentrat
|

The name (for example, Concentrator Policy Status) is now displayed as the policy name in Policy
Detail panel.

6. Create a Policy in the Policy Detail panel:
a. Select the Enable checkbox.

b. Add relevant services (in this example, any relevant Concentrator services) that you want to
monitor for health statistics.
For a PKI policy, you must select the LOCALHOST to monitor for health statistics.

c. Add rule conditions to configure the policy.
d. Suppress enforcement of the policy for the time periods you want.

e. Add any email notifications you want for the policy.
f. Click Save in the Policy Detail panel.
The Policy is added.

18
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Add Policy Example

Below is a high-level example of configuring a PKI policy:
1. Add a new PKI policy.

NETWITNESS v Respond U Hosts Files Dashboard

admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Marms  Monitoring ECSISIENE  System Stats Browser  Event Source Monitoring  Settings  New Health & Wellness

Policies Host: SA PKI

— = ™ Enable st Modified: 2016-05-04 03:51:14 PM
+o =By 1 Last Modified:
» [ Archiver © | Hosts
» ClBroker @ | Choose the hosts, senvices, and groups that your health policy applies to
» [ Concentrator © +-
» [JContext Hub ©® U name~ Group Type
» CDecoder @ DO tocawost font
» [JEvent Sw e{ﬁ Analysis o
Rules
4 Host o
Define the ler which you alarm for the NetW atform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define
the alarm rul e the al
SAPKI + -
» []1PDB Extractor ©® & Erovic| Name~ e Cotegony, Statistic Threshold
» [Jincident Management o ¥ Alert When a CRL Expi...  Critical PKI SA Server PKI CRL Expiration Alarm <= 0 for 0 MINUTES
» [ Log Collector o
Policy Suppression
» [JLog Decoder o ¥ SUPP
Define the time periads to suppress policies,
» [IMalware Analysis o
+ Time Zone:  UTC (GMT+00:00) v
» CIReporting Engine o
O pays Time Range
s 5
» [Warehouse Connector o
Click on + to add suppression to palicy
» CWorkbench o
Notification
Mot b uban tha - T 2 2nd dacs ba

2. Add a Rule with Statistics:
o For CA Expiration

Enable ™

Mame Trusted CA Certificate Expiry Time

Description

Severity High v

__Statistig PEI v | | SA Server PKI Certificate Expiration ~ | TRUSTED_CA ~
Alarm = v | 2400 For |0 & Minutes

Threshold

w2400 For

Minutes

Time Zone: UTC (GMT+00:00)

Time Range

Click on + to add sup

Cancel Save

o For CRL Expiration
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Add Rule

Enable ™

MName CRL Expiration Based On Time
Description

Severity High v

~ | | 5A Server PKI CRL Expiration hd
w2400 For 0 < Minutes
w0 For 1 < Minutes L\\:

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For CRL Status

Add Rule

™
Name CRL Status
Description
Severity High e
PKI ~ | |5A Server PKI CRL Status hd
1= ~ Valid For 0 £ Minutes
= ~ Valid For 1 £ Minutes

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For Server Certificate Expiration
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Add Rule

Enable “

lagme |Sewer|Cer‘ti"cate Expiry Time |

Description

Severity High e
PKI ~ | | SA Server PKI Certificate Expiration ~ | SERWER_CERT w
<= v || 2400 For |0 | Minutes
= w2400 For 1 < Minutes

+ Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

Edit a Policy

1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, Concentrator Policy Status) under a host or service.

The Policy Detail is displayed.

4. Click I—'JIE

The policy name (for example, Admin Server Monitoring Policy) and policy detail panel become
editable.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES URCES ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness

Policies Admin Server: Admin Server Monitoring Policy
+ Z® 2 Rules and suppression schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them

™ Enable Last Modified: 2017-02-20 12:00:00 AM
45 Admin Server

Admin Server Monitoring Policy Services
» Dl Archiver a Choose the hosts, services, and groups that your health policy applies to.
» (I Broker Q +
» [ Concentrator @ Name ~ Group Type
Al 10 G
» [Jconfig Server 0 roup
» [ Content Server
< Rules

» [ Contexthub Server o Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the

alarm clears). After you define the alarm rule, enable or disable the alarm
» [(JDecoder Q

» (J€esA Correlation

Enable Name ~ Severity Category Statistic Threshold
» CJEndpoint Broker Server

Admin Server in Crit... ~ Critical Processinfo Overall Processing Status Indicator Alarm = ERROR for 2 MINUTES
» CJEndpoint Server

endp: a Admin Server in Un...  High Processinfo Overall Processing Status Indicator Alarm = PARTIALLY_WORKING for 2 MINUTES
» CJHost Admin Server Stopp...  Critical Processinfo Service Status Alarm 1= started for 0 MINUTES
» (Jintegration Server Q
T Palicy Stinnrecsinn e

5. Make the required changes and click Save in the Policy Detail panel. You can:
¢ Edit the policy name.
¢ Enable or disable the policy.
¢ Add or delete hosts and services in the policy.
¢ Add, delete or modify rules in the policy.
¢ Add, edit, or delete suppressions in the policy.

¢ Add, edit, or delete notifications in the policy.

Note: Save applies the policy rules based on the selection of enable or disable. It also resets the rule
condition timers for changed rules, and the entire policy.

Duplicate a Policy

4
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

3. Select a policy (for example, Concentrator Monitoring Policy) under a host or service.

4. Click ® .NetWitness copies the policy and lists it with (1) appended to the original policy name.
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NETWITNESS Investigate Respond (VECTeS Hosts Files Dashboard Reports admin v

EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS  SYSTEM SECURITY

Aarms  Monitoring SIS System Stats Browser  Event Source Monitoring ~ Settings  New Health & Wellness

Policies Concentrator: Concentrator Monitoring Policy(1)
teo - 1B BlEnecie Las: Modified: 2019-03-06 10:24:10 PM
» [ Admin Server services
¥ [ archiver Choose the hosts, services, and groups that your health policy applies to.
» [araker +
» [ Coud Gateway Server Name ~ Group Type
45 o or Click on + to add assignment to policy

Cony

Rules

Concentrator Monitoring Polic... -
Define the conditions un

ant to trigger an alarm for the NetWitness Platform health problems {definition includes severity, statistic the slarm applies to, threshold, and threshold at which the alarm clears).
le or disable the alarm

» [ Config Server After you define the alarm rule, ena

» [J Content Server +

» [ Contexthub Server Enable  Name Severny category statistic Threshold
» [ Desoser Concentrator »5 Pen..  Medium Concentrator Queries Pending Alarm>=

Devices Sessions Benind Alarm>=
» [ E4 Correlation

Sessions Benind Alarm >=
» [ Entity Behavior A

Iytics -
s Behind Alarm>=

» [ Event Stream Analysis A
[ Event Seream Analysi Alarm 1=

» [Hest

Alarml=

Concentrator

Alarm =

Concentrator Alarm =

es suming

Processinfo

1= ‘started’, ready" for 0

—

5. Click l—"'lt and rename the Policy [for example, rename Concentrator Monitoring Policy(1)] to New
Concentrator Policy.

Note: A duplicated policy is disabled by default and the host and service assignments are not
duplicated. Assign any relevant hosts and services to the duplicated policy before you use it
to monitor health and wellness of the NetWitness infrastructure.

Assign Services or Groups

To assign hosts or services to a policy:

1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, First Policy) under a host or service.

The Policy Detail view is displayed.

4. Click + in the Services and Groups list toolbar.
5. Choose one of the following actions:
e For hosts, select Groups or Hosts from the selection menu.
¢ For services, select Groups or Services from the selection menu.
6. Depending on whether you are assigning services or groups, perform one of the following actions:

o Groups, the Groups dialog is displayed from which you can select predefined groups of hosts or
services.
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Add Groups
Groups Services
MName Filter *
= Name Host Type
Concentrator MWAPPLIANCEZ2655 Concentrator

Cancel Select

o Services, the Services dialog is displayed from which you can select individual services.

Add Service
Groups Services
Mame Filter *
= Name Host Type
[l Concentrator MNWAPPLIANCEZ22655 Concentrator

Cancel Select

7. Select the checkbox next to the groups or services you want to assign to the policy, click Select in
the dialog, and click Save in the Policy Detail panel.
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Note: Services are filtered for selection based on the type of policies. For example, you can only
select Concentrator services for a Concentrator type of policy.

Remove Services or Groups

To remove a host or service from a policy:

1.
2.

Go to (Admin) > Health & Wellness.
Click the Policies tab.

The Policies view is displayed.

Select a policy under a service.

The Policy Detail view is displayed.

Select a host or service.

Click ~— .

The host or service is removed from the policy.

Add or Edit a Rule

To add a rule to a policy:

1.
2.

Q
Go to (Admin) > Health & Wellness.
Click the Policies tab.

The Policies view is displayed.

Select a policy (for example, Checkpoint) under a host or service.

The Policy Detail view is displayed.

Depending on whether you are adding or editing rule, do the following:

* To add a rule, click + in the Rules list toolbar.

—

To edit a rule, select a rule from the Rules list and click j .

Complete the dialog to define or update the rule.

Add a description as shown in the following example.
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Add Rule

Enable “ -
MName Check Point
Description Trigger alarm when Check Point Log Collection stops
Severity Medium M
Checkpoint Collection ~ | | Collection State ~
= v | | stopped For |1 £ | Minutes
= v | | started For |1 & | Minutes

Time Zone: UTC (GMT+00:00)

Time Range
™ sun Maon Tue Wed Thur Fri Sat 00:00 To 00:15

7. Click OK.
The rule is added (or updated) to the policy.

Hide or Show Rule Conditions Columns

To hide or show rule conditions columns in the Rules panel:

1. Goto (Admin) > Health & Wellness.
2. Click Policies tab.
The Policies view is displayed.
3. Select a policy under a service.
The Policy Detail view is displayed.
4. Go to the Rules panel.
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Rules

Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes
severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or
disable the alarm.

O Enable  Name ~ Severity Category Statistic Threshold

O Concentrator...  Medium Cancentrator Queries Pending for 10 MINUTES

O Concentrator...  Medium Devices Sessions Behind Alarm == 100000 for 30 MINUTES

O Concentrator...  High Devices Sessions Behind Alarm == 1000000 for 30 MINUTES

O Concentrator...  Critica Devices Alarm >= 50000000 for 30 MINUTES

O Concentrater...  Critica Cancentrator Status Alarm !="started’ for 0 MINUTES

O Concentrator...  Critica Database Status Alarm !="opened' for 0 MINUTES

O Concentrator..  High Cancentrator Rule Error Count Alarm =0 for 0 MINUTES

(| e Caisi o A= D fe — N foe 3 RAIBIITES

5. Click v to the right of Category , set Columns, and clear the Static and Threshold rule conditions.

You can set or clear any Rules column to show or hide it.

The Rules panel displays without the rule conditions.

Delete a Rule

To remove a host or service from a policy:

Q
1. Goto (Admin) > Health & Wellness.

2. Click the Policies tab.
The Policies view is displayed.

3. Select a policy under a service.

The Policy Detail view is displayed.

4. Select a rule from the Rules list (for example, Checkpoint).

5. Click —.

The rule is removed from the policy.

Suppress a Rule

1. Click the Policies tab.
The Policies view is displayed.

2. Select a policy under a service.

The Policy Detail view is displayed. You can specify rule suppressions time ranges when you
initially add it or you can edit the rule and specify suppression time ranges.

3. Add or edit a rule.

4. In the Rules Suppression panel of the Add or Edit Rule dialog, specify the days and time ranges

during which you want the rule suppressed.
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Suppress a Policy

1. Add or edit a policy.
The Policies view is displayed.

2. In the Policy Suppression panel:
a. Select a time zone from the Time Zone drop-down list.
This time zone applies to the entire policy (both policy suppression and rule suppression).
b. Click + in the toolbar.

c. Specify the days and time ranges during which you want the policy suppressed.

Add an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.
The Policies view is displayed.

2. In the Notification panel:
a. Click + in the toolbar.
A blank EMAIL notification row is displayed.
b. Select the email:

¢ Notification types in the Recipient column (see "Configure Notification Outputs" in the
NetWitness System Configuration Guide for the source of the values in this drop-down list).

» Notification server in the Notification Server column (see 'Configure Notification Servers" in
the NetWitness System Configuration Guide for the source of the values in this drop-down list).

¢ Template server in the Template column (see "Configure Notification Templates" in
the NetWitness System Configuration Guidefor the source of the values in this drop-down list).

Note: Refer to Include the Default Email Subject Line if you want to include the default
Email subject line from the Health & Wellness template in your Health & Wellness
Email notifications for specified recipients.

Delete an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.
The Policies view is displayed.

2. In the Notification panel:
a. Select an email notification.

b. Click —=.
The notification is removed.
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Include the Default Email Subject Line

The emails generated by the notifications you set up for policies do not include the subject line from
the Health & Wellness Default Email Notification templates. You need to specify the subject line in the
do not include subject lines. This procedure shows you how to insert a subject line into the templates.

For related reference topics, see Policies View and NetWitness Platform Out-of-the-Box Policies.

To include the subject line from a Health & Wellness email template in your email notification:

A
1. Goto (Admin) > System.

2. In the options panel, select Global Notifications.

Select a Health & Wellness Email Template (for example, Health & Wellness Default SMTP
Template).

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports ] < admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

o Global Notifications
Updates
QOutput Servers Templates
Licensing
+ | & Search X
Email
Name ~ Template Type Description Actions
I Global Notifications o
Default Audit CEF Template Audit Logging Default Audit CEF Template o]
Legacy Notifications
[ Default Audit Human-Readable Format Audit Logging Default Audit Human-Readable Format &
System Logging
o Default SMTP Template Event Stream Analysis Default SMTP Template o]
Global Auditing
Jobs [ Default SNMP Template Event Stream Analysis Default SNMP Template &
Live Services Default Script Template Event Stream Analysis System default FreeMarker template for Script notifications &
URL Integration Default Syslog Template Event Stream Analysis Default Syslog Template &
Context Menu Actions [ ESM Default Email Template Event Source Monitoring ESM Default Email Template £l
Investigation ESM Default SNMP Template Event Source Monitoring ESM Default SNMP Template Foy
HTTP Proxy Settings -
ESM Default Syslog Template Event Source Monitoring ESM Default Syslog Template o]
NTP Settings -
Health & Wellness Default SMTP Template Health Alarms Health & Wellness Default SMTP Template L]
Dashboard Settings
Health & Wellness Default SNMP Template Health Alarms Health & Wellness Default SNMP Template o]
Health & Wellness Default Syslog Template Health Alarms Health & Wellness Default Syslog Template L]
New Health & Wellness Default Email Template New Health & Wellness Alarm New Health & Wellness Default Email Template Using Kibana... &
»
| Page 1 of1 | | C' Pagesize 25 Displaying 1 - 14 of 14 templates

The Define Template dialog is displayed.

4. Click 'l—"'lllIE , then in the Template field, copy the Subject Line (Highlight the subject line and press

Ctrl-C) into the buffer.
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Define Template

Mame * Health & Wellness Default SMTP Template
Template Type | Health Alarms

Description Health & Wellness Default SMTP Template

Template * <html=

4.':!__

// RECOMMEND: Use this line from the template as the Email Subject line
when defining Motification Type

MW Health <#if state == "ACTIVE">%{severity?lower_case?cap_first}
Severity<#elsex${state?lower_case?cap_first}</#if> Alarm:
${ruleName!"Unknown Rule Name"} on ${hostName!"Unknown Host Name™?}
—
<hgad>

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

<fhead=>
<body bgcolor="#eeeeee" leftimargin="0" topmargin="0" marginwidth="0"
marginheight="0">
<table border="0" cellpadding="0" cellspacing="0" height="100%"
width="100%" id="bodyTable">

Click Cancel to close the Template.
Click the Output tab and select a notification (for example Health & Wellness).

Click E

The Define Email Notification dialog is displayed.

Replace the value in Subject field text box with the subject line that you have in the buffer (highlight
the existing text and press Ctl-V).
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Define Email Notification

Enable U
H&W Email notification

To Email Addresses *

Subject Template Type  Health & Wellness default email subject

MW Health <#if state == "ACTIVE">${severity?lower_case?
cap_first} Severity<#else=${state?lower_case?cap_first}</#if>
Alarm: ${ruleMame!"Unknown Rule Name"} on
${hostName!"Unknown Host Name"}

Cancel

9. Click Save.
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Monitor System Statistics

The System Stats Browser filters statistics by the selected host, component running on the host, statistical
category, individual statistic, or any combination of host, component, category, and statistic. You can
also choose the order in which to display this information.

To access the System Stats browser:

QA
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click the System Stats Browser tab.
The System Stats Browser tab is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

JRCE HEALTH & WELLNESS YSTEM  SECURITY

Alarms Monitoring Policies System Stats Browser WNVZISSEINEIICIGITFS Settings New Health & Wellness

Host Component Category Statistic Order By

Any v Any v Any - I cer v

Regex Regex Or ding 3

Host Component Category Statistic Subitem Value Lost Update Historical Graph oy

logdecoder Host FileSystem Error Status 0 2021-05-14 12:00:14 PM o =
o
oder Host Hlesystem Disk Usage rdev 2021-05-14 12:00:14 PM &
logdecoder fost Filesystem Mounted Filesystem Disk Usage 2021-05-14 12:00:14 PM &
logdecoder Host FileSystem Mounted Filesystem Disk Usage Isys/fslcgroup 2021-05-14 12:00:14 PM o
logdecoder Host FileSystem Mounted Filesystem Disk Usage devishm 2021-05-14 12:00:14 PM &
logdecoder Host FileSystem Mounted Filesystem Disk Usage /home 2021-05-14 12:00:14 PM By
logdecoder Host FileSystem Mounted Filesystem Disk Usage 2021-05-14 12:00:14 PM h
logdecoder Host Filesystem Mounted Filesystem Disk Usage 2021-05-1412:00:14 PM i
oder Hos 2021-05-14 12:00:14 PM o

Page 1 of40 y»i1 ¢ Items 1 - 50 of 1994
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Filter System Statistics

You can filter system statistics to monitor:

* Statistics collected for a particular host

» Statistics collected for a particular component

 Statistics collected of a particular type or that belong to a certain category

* Statistics listed in an ordered way as per the selection chosen

To filter the list of system statistics:

A
Go to (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

Click System Stats Browser.

The System Stats Browser tab is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dz d Reports admin v

Host Component Category Statistic Order By
Any v Any v Any v I clear
Regex = ®Ascending ODescending
Host Component Category Statistic Subitem Value Last Update Historical Graph
logdecoder Host FileSystem Error Status 0 2021-05-14 12:00:14 PM i
o

logdecoder Host FileSystem Mounted Filesystem Disk Usage 2021-05-14 12:00:14 PM o
logdecoder Host Filesystem Mounted Filesystem Disk Usage un 2021-05-14 12:00:14 PM &
logdecoder Host FileSystem Mounted Filesystem Disk Usage sys/fsicgroup 2021-05-14 12:00:14 PM By

logdecoder He FileSystem ted Filesystem Disk Us ‘devishm 2021-05-14 12:00:14 PM &
logdecoder Host Filesystem Mounted Filesystem Disk Usage home 2021-05-14 12:00:14 PM &
logdecoder Host FileSystem Mounted Filesystem Disk Usage 2021-05-14 12:00:14 PM o
logdecoder Host FileSystem Mounted Filesystem Disk Usage ar/netwitness 2021-05-14 12:00:14 PM Bl

gdecoder Host FileSystem Mounted Filesystem Disk Usage 2021-05-14 12:00:14 PM o

Page 1  of40 Y»i1 ¢ Items 1- 50 of 1994

URCES  HEALTH & WELLNESS  SYSTEM  SECURITY

Alarms Monitoring Policies System Stats Browser SVERISGIIERNCLIEINTS Settings New Health & Wellness

Filter the list of system statistics in one of the following ways:

To view system statistics for a particular host, select the host in the Host drop-down list.
The system statistics for the selected host is displayed.

To view system statistics for a particular component, select the component in the Component
drop-down list.
The system statistics for the selected component are displayed.

To view system statistics for a particular category, type the category name in the Category field.
Select Regex to enable the Regex filter. It performs a regular expression search against text and
lists the specified category. If Regex is not selected, it supports globbing pattern matching.

The System Stats for the selected category is displayed.

To list statistics in a preferred order, you can set the order in the OrderBy column.
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o To view a particular statistic across hosts, type the statistic name in the Statistic field.

Select Regex to enable the Regex filter. It performs a regular expression search against text and

lists the specified category. If Regex is not selected it supports globbing pattern matching.
The information for the selected statistics is displayed.

The following figure shows the System Stats Browser filtered by the 111Conc host listed in
descending statistical category order.

NETWITNESS

Alarms

Host

111Conc

Host
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc
111Conc

111Conc

To view the details for an individual statistic:

SERVICES EVENT SOURCE

Respond Users

Hosts Files

Dashboard

OINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Monitoring Policies System Stats Browser [MSENGIGANNelg)l

| Page |1

Component

v Any

Component

Monitor

eBus

MessageBus

MessageBus

eBus
eBus
Bus

=Bus

ofs | >R I1C

Category Statistic

[CJRezex CRegex
Category Statistic
Collectd

a. Select a row to select a statistic.

b. Click ™.
The Stat Details pane is displayed.

Settings

Order By

Any v

Oscending @Descending
Subitem

message published

<d Change Rate

New Health & Wellness

Apply

Clear

Reports

Value

420690

o o o o o o o f

8666

50.12GB

50.26 GB
False

32

459

Last Update

201902

admin w

Historical Graph

tems 1 - 50 of 208

-

Sieta( 1ey
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Stat Details

Hostname 111 Conc

Component ID messagebus

Component MessageBus

Mame Mode Sockets Used

Subitem rabhit@hs15154b-6ba2-4508-95c4-4eb53df02 eed
Path

Plugin messagebus_localhost

Category

Last |

Value

ares

-

[=]

Zauge
rabbit@be15194b-6ba2-4508-35c4-
Aeh53df02eed_sockets_used

Mumber sockets used by this message broker,

MessageBus

2015-02-01 07:31:55 PM
3]

6.0

b519194b-6ba2-4508-95c4-
4epb53dfl2eed/messagebus_localhost/zauge-
rabbit@be19194b-6ba2-4508-95c4-
4ep53dfi2eed _sockets_used

b519194b-6ba2-4508-95c4-
deh33df0Zeed/messagebus_localhost/gauge-
rabhit@hs15154b-6ba2-4508-95c4-
4eph53dfiZeed_sockets_used

11.3.0.0

false

4
For details on various parameters in the (Admin) > Health & Wellness > System Stats

Browser view, see System Stats Browser View
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View Historical Graphs of System Statistics

The historical graph of the collected system stats gives you information about the variation of the stats

over a selected time frame.

To view a historical graph:

A
1. Goto (Admin) > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.

2. Click the System Stats Browser tab.

3. In the System Stats Browser tab, specify the filter criteria to display the statistics you want.

4. In the Historical Graph column, select b

The Historical graph for the selected statistic is displayed.

The figure below gives an example of the historical graph for the Memory Utilization statistic for

a host.

Historical Graph

Concentrator: Memory Utilization

Zoom 1h 6h  12h 1d All

08:00 09:00 10:00 11:00 12:00 13:00 14:00

average

15:00

Click and drag in the plot area to zoom in

From

16:00

17:00

Time Frame | Current Day

Feb 1, 2019

18:00

w

To | Feb1, 2019

19:00

45M

40M

35M

30M

anep

The graphical view is customized to display the statistics collected for the current day and the values
are zoomed in for an interval of an hour (10.15 - 11.15 hrs). Hover over the graph to view the details

at a particular instant. For example, in the figure it displays the memory utilization at 12.00 hrs.

Note: You can customize the graph view by selecting the Time Frame and Date range. You can zoom
in using the zoom in value, time window, or by just clicking and dragging in the plot area. For details
on the parameters to customize and zoom in functions, see Historical Graph for System Stats. Any
break or gap in the chart line indicates that the service or host was down during that time.
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Monitor Service Statistics

NetWitness provides a way to monitor the status and operations of a service. The Service Stats view
displays key statistics, service system information, and host system information for a device. More than
80 statistics are available for viewing as gauges and in timeline charts. Only statistics for session size,
sessions, and packets are viewable in historical timeline charts.

Although different statistics are available for different types of services, certain elements are common for
any Core device.

To monitor service statistics in NetWitness:

4
1. Goto (Admin) > Services.
The Services view is displayed.

2. Select a service, and select View > Stats in the Actions column.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

- Change Service | endpointloghybrid2 - Log Decoder | Stats  ©
General Log Stats
endpointloghybrid2 - Log Decoder o
Key Stats Service System Info Host System Info Physical Drives Y}
£
Capture  OEPS 10% > 5% [~] -
Packet Rat %)
ster or 13.8GB System Mer 13.8GB = 15
M 324 Max EPS Total Memo 15.7 GB or 157 GB sda %
; . lemory 158.4 MB Process Memory ~ 33.6 MB 5
10,319 Packets ry 15.7GB lax Proces 15.7GB <
2 days, 22 hours and 30 femc
Tota 0 Packets (0% minutes Uptime 2 days, 22 hours and 30
loss) atus Ready minutes
10,319 Packets R g Sinc 2022-5ep-20 11:46:33 Status Ready -
»
Gauges - Page 1 of 1
Memory Process cpPU Memory Process Max
158 48 s0%
1250m8 1901148
9518 21em8 21908
s3amB 253508 25108
a7 iy 285218 2268
00 Memory 316.9M8 007 Momory Process  31.368
rrrrrrr Max
Timeline Charts - Page 1 of 1 o

3. To customize the view, collapse or expand charts. For example, expand the Chart Stats Tray to see
available charts, and then drag a section up or down to change the sequence. Or, drag the Gauges
section to the top so that it is above the Summary Stats section.
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Add Statistics to a Gauge or Chart

In the Services Stats view, you can customize the monitored statistics for individual services. The Chart
Stats Tray lists all available statistics for the service. The number of statistics varies according to the type
of service being monitored. Any statistic in the Chart Stats Tray can be displayed in a gauge or a
timeline chart. Only statistics for session size, sessions, and packets are viewable in historical timeline
charts.

Create a Gauge for a Statistic

To create a gauge for a statistic in the Services Stats view:

D
1. Goto (Admin) > Services.
The Admin Services View is displayed.
2. Select a service and select View > Stats in the Actions column.

The Chart Stats Tray is displayed on the right side.

3. If the tray is collapsed, click to view the list of available statistics.
4. From the Chart Stats Tray, click on any statistic and drag it into the Gauges section.

A gauge is created for the statistic. If there is no space for the gauge, a new page is created in the
Gauges section and the gauge is added to the new page. In the example, the Active CPU Time chart
was added to the Gauges section by dragging it from the Chart Stats Tray.

Gauges - Page 1 of 1

H CPU Memory Process Max Active CPU Time

Name < Value

Dis...  Memory Process Max
Path  /sys/stats/memory.process.max
St MEMmory.process.max

Active CPU
Time

Process
4

Create a Timeline Chart for a Statistic

To create a timeline for a statistic:

From the Chart Stats Tray, click on a statistic and drag it into the Timeline Charts or the Historical
Timeline Charts section.

A timeline chart is created for the statistic. If there is no space for the chart, a new page is created in the
Timeline Chart section and the chart is added to the new page. In the example, the Assembler Packet
Pages chart was added to the Timeline Charts section by dragging it from the Chart Stats Tray.
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Timeline Charts - Page 1 of 1

Memory Process @&X CPU

T I
1:08 am 11:10 am 1:11 am 11:13am

e
[ ad i i

~A—+
X
| I I
1:08 am 1:08 am 11:10 am 11:11am 11:13 am
Assembler Packet Pages X
:'

Search for a Statistic in the Chart Stats Tray

To search for a statistic, type a search term; for example, session, in the Search field and press Enter.

Statistics that match are displayed with the matching word highlighted.

Chart Stats Tray

Search |session| X

Stats

Assembler Sessions
Stat Mame:assembler.sessions
Path:/decoder/stats/assembler.zessions

Session Bytes
Stat Mame:session.bytes
Path:/database/stats/session. bytes

Session Bytes Last Hour
Stat Name:session.bytes.last.hour
Path:/database/stats/session. bytes.last.hour

Session Completion Queue
Stat Mame:pocl.session.complete
Path:'decoder/parsers/stats/pocl.session.complete

Session Correlation Queue
Stat Name:pool.session.correlate
Path'decoder/stats/pool.session.correlate

5ession Decrement Queue
Stat Name:pool.session.decrement
Path:'decoder/stats/pool.session.decrement

Session Export Cache Files
Stat Name:=xport.session.cache.files
Path:/'decoder/stats/export.session.cache.files

| Page 1 of2 | ) » I C

|2

Stats 1-12o0f 24
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Edit Properties of Statistics Gauges

The Gauges section of the Service Stats view presents statistics in the form of an analog gauge. The
properties of each individual gauge are editable; all gauges have an editable title and some have
additional editable properties.

Edit Properties of a Gauge

A
1. Goto (Admin) > Services
The Admin Services view is displayed.

2. Select a service and select View > Stats in the Actions column.
The Service Stats view includes the Gauges section.

3. Go to the gauge for which you want to edit properties (for example, Memory Process).

Memory Process Max

Max

4. Click the Properties icon () to display the parameter names and values.

5. To highlight the value of the Display Name field, double-click on the value; for example, Memory
Process.

Note: Clicking the other two values does nothing because the properties are not editable in the
gauge.

6. Type a new value for the Display Name and click the Properties icon ().
The new title replaces Memory Process.

Add Stats to the Gauges Section

You can add more gauges by dragging a statistic from the Chart Stats Tray into the Gauges section.

1. To expand the Chart Stats Tray, click

2. Scroll down and select a statistic, for example, Session Rate (maximum).
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3. Drag the statistic to the Gauges section.
The new gauge is displayed in the Gauges section.
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Edit Properties of Timeline Charts

Timeline charts display statistics in a running timeline. The Service Stats view includes two types of
timelines; current time and historical. You can drag any statistic available in the Chart Stats Tray to the
Timeline Charts section. Only statistics for session size, sessions, and packets are viewable in historical
timeline charts. The properties of an individual timeline chart are editable; all timeline charts have an
editable title and some have additional editable properties.

To access the charts:

Q
1. Goto (Admin) > Services.
2. Select a service and click Stats.

The Services Stats view is displayed. The charts are in this view.

Edit Properties of a Timeline

To edit properties of a timeline chart:

1. Go to the timeline chart for which you want to edit properties (for example, Memory Process).

Timeline Charts - Page 1 of 1 a

Memory Process X CPU

Memory Process Max Assembler Packet Pages

g
&
3
1

2. Click the Properties icon (= ) to display the parameter names and values.

3. Double-click on a value (for example, the Display Name field) to make the value editable.

Note: Clicking the other two values does nothing because the properties are not editable in the
chart.

4. Type a new value and click the Properties icon.

The timeline chart is displayed with new values.

Edit Properties of a Historical Timeline

To edit properties of a historical timeline chart:

1. Go to Historical Timeline Charts.

2. Click the Properties icon () to display the parameter names and values.
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3. Click on a value (for example, 01/27/2019 for the Begin Date field) to make the value editable.
4. Type a new value.

5. Edit the End Date and Display Name if required.

6. Click the Properties icon ().
The historical timeline is displayed with new values.

Note: To return the properties of the historical timeline chart back to the default so that the values
dynamically update, remove the Begin Date and the End Date, place your cursor in the Begin Date
field, and refresh your browser.

Add Stats to Timeline Charts

You can add timeline charts by dragging a statistic from the Chart Stats Tray into the Timelines section.

1. To expand the Chart Stats Tray, click
2. Scroll down and select a statistic; for example, Session Rate (maximum).

3. Drag the statistic to the Timelines Section.
The new timeline is displayed in the Timelines section.
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Monitor Hosts and Services

NetWitness provides a way to monitor the status of the hosts and services installed in your
environment. You can view the current health of all the hosts, services running on the hosts, their CPU
usage and memory consumption, and the host and service details.

To monitor hosts and services in NetWitness:

QA
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
A list of all hosts and their associated services that belong to the group All is displayed by default.
The operational status, CPU usage, and memory usage for each host is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms

Monitoring

Policies System Stats Browser New Health & Wellness

Event Source Monitoring Settings

Groups Hosts Filter
Name Count %
Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
Sal
=i 0 o 0 host(s) 0 host(s) 0 host(s)
@ adminserver Status: CPU: 24.75% Memory: 30.53 GB/31.42 GB
B endpointbroker Status: CPU: 1.95% Memory: 2.16 GB/15.67 GB
Service Health Status  Rate Name Service Type cPU Memory Usage Uptime
Ready endpointbroker - Endpoint Bro...  Endpoint Broker Server  0.2% 848.18 MB 2 days 22 hours 20 minutes 13 seconds
B endpointioghybrid1 Status: CPU: 6.62% Memory: 7.16 GB/15.67 GB
Service Health Status  Rate Name Service Type cpy Memory Usage Uptime
Ready 0 endpointloghybrid1 - Concentr...  Concentrator 1.8% 37540 MB 2 days 22 hours 20 minutes 7 seconds
Ready ] tloghybrid1 - Log Colle...  Log Collector 22% 134.69 MB 2 days 22 hours 20 minutes 7 seconds
Ready 0 ointloghybrid1 - Log Deco...  Log Decoder 13.9% 156.46 MB 2 days 22 hours 20 minutes 7 seconds
Ready endpointloghybrid1 - Endpoint ... Endpoint Server 0.4% 1.98 G8 1 day 16 hours 44 minutes 10 seconds
B endpointioghybrid2 Status: CPU:7.07% Memory: 12.59 GB/15.67 GB
Service Health Status  Rate Name Service Type Py Memory Usage Uptime
Ready 0 endpointloghybrid2 - Concentr...  Concentrator 1.9% 261.70 MB 2 days 22 hours 20 minutes 8 seconds

| Page 1 of1 |

I

»

Displaying 1-5 of 5

A list of services installed on the host is shown below the host. If you cannot see the services, click
to the left of a host to display the services.

The name, operating status, CPU usage, memory usage, and the time operating for each service is

displayed.
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Filter Hosts and Services in the Monitoring View

You can filter hosts and services in the monitoring view in one of the following ways:

Hosts belonging to a particular group

A specific host and its associated services

Hosts whose services are stopped

Hosts whose services have stopped processing or processing has been turned off
Hosts that have physical drive problems

Hosts that have logical drive problems

Hosts that have full file systems

For the related reference topic, see Monitoring View.

To filter hosts and services:

1.

QA
Go to (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.

Select the Monitoring tab.

3. Filter the hosts and services in one of the following ways:

o To view a list of hosts and their associated services belonging to a particular group, select the
group in the Groups panel.

All hosts and their associated services belonging to the specified group are displayed in the Hosts
panel.

Note: The grouping of hosts is derived from the groups created in the Admin Hosts view. All
groups created in the Admin Hosts view are displayed here.

For example, if you select the group LC_Group in the Groups panel, a list of all hosts that are
part of the group are displayed.

o To view a list of all services that have stopped processing, click Stopped Processing in the Hosts
panel.

A list of all the hosts that have at least one service with the status as stopped processing is
displayed.

Note: The buttons on the top display the system statistics for all of the hosts configured in
NetWitness and does not change with the application of filters on the groups.
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NETWITNESS

HOSTS

JCIEN Monitoring

Groups
Name

Sal

Investigate Users  Hosts  Files  Dashboard

Respond

Reports

URCES  HEALTH & WELLNESS  SYSTEM  SECURITY

Policies  System Stats Browser  Event Source Monitoring ~ Settings  New Health & Wellness

Hosts Filt
Count
Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
4 3 0 host(s) 0 host(s) 0 host(s)
] ybrid: Status: CPU:5.32% Memory: 6.92 GB/15.67 GB
Service Health Status  Rate Name Service Type ey Memory Usage Uptime
Ready o ipointiogt Concentrator 16% 259.08 MB 1 day 22 hours 59 minutes 8 seconds
Ready . pointiogh Log Collector 13% 133.09 M8 1 day 22 hours 59 minutes
Readly 0 pointlogt 13% 16005 MB 1 day 22 hours 59
Ready pointlogt d 0.4% 18968
B end ybrid Status: CPU:7.08% Memory: 6.85 GB/15.67 GB
Service Health Status  Rate Name Service Type Py Memory Usage Uptime
Ready 0 " t Concentrator 1.7% 375.41 MB 1 day 22 hours 59 minutes 7 seconds
Ready ° pointioghybrid - Log C Log Collector 27% 13367 M8 1 day 22 hours 59 minutes
Ready 0 : r g De Log Decoder 14% 15445 M8 1 day 22 hours 59 minutes
Ready " t Endpoint Server 0.4% 17168 17 hours 23 minutes 10 seconds
= status: Memory: 31.02 GB/31.42 GB
Service Health Status  Rate Name ey Memory Usage Uptime
Page 1 of1 | | C Displaying 1-3of 3

¢ In a similar way, you can filter the list of hosts and the associated services by choosing the
appropriate filter:

» Click Stopped Services to display a list of all stopped services.

* Click Physical Drive Problems to display a list of host with physical drive problems.

e Type the host name in the Filter box to display only the required host and the services running
on the host.
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Monitor Host Details

You can view the details of a host, its memory and CPU usage, system information, physical drive,
logical drive, and file system details to investigate potential problems with the host.

To view host details:

A
1. Goto (Admin) > Health & Wellness > Monitoring tab.
2. Click a host in the Hosts panel.

The Host Details view shows important system information about the selected host, such as memory
utilization and file system usage.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring. Policies System Stats Browser  Event Source Monitoring Settings NEWVASEENIGEARVAIGE adminserver @

HOST AND SERVICES

Host Details
| Host
System Info
Broker
Host adminserver Memory Utilization 84.54%
Reporting Engine
porting =ne cPU 434% Used Memory 53.19GB
Orchestration Server
Running Since 2022-Aug-08 08:35:24 Total Memory 6292GB
Security Server Current Time 2022-Sep-26 11:10:01 Cached Memory fo.81ce
Admin Server Uptime 7 weeks 2 hours 34 minutes 37 seconds Swap Utilization 0.09%
System Info Used Swap 351MB
i Linux 3.10.0-1160.71.1.¢17.x86_64 x86_64
Config server - - Total Swap 4.00 GB
Investigate Server
Respond Server Physical Drive | Logical Drive | File System Adapter Message Bus
Integration Server State Enclosure Slot Failure Count Raw Size Inquiry Data

Content Server

Source Server
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Monitor Service Details

You can view the details of a service, its memory and CPU usage, system information, and various
details depending on the service selected.

To view service details:

L.

2.

Go to Kl (Admin) > Health & Wellness > Monitoring tab.
The Hosts panel shows the services running on each host.
In the Hosts panel, click a service name link to get more information.

The service details view shows the health status of the selected service. The Decoder service details
include capture statistics and the Concentrator and Broker details include aggregation statistics.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NEWRSEEIGEAVAIGEES adminserver @

HOST AND SERVICES Broker Details
Host

Service

| Broker
. CPU 0.7% Used Memory 29220 MB
Reporting Engine
Running Since 2022-Aug-08 09:30:54 Max Process Memory 62.92 GB
Orchestration Server . .
Build Date 2022-Aug-04 05:31:48 Version Information 12.1.0.0
Security Server
Admin Server Details
Config Server Aggregation State started Meta Rate 0
Investigate Server Session Rate 0 Meta Rate Max 172058
Session Rate Max 5072

Respond Server
Integration Server
Content Server

Source Server

Many services, including the ESA Correlation service, have a Health Stats tab that provides
information about the health status of the service. The JVM tab shows the total memory used by the
selected service and the total memory capacity of the host. For more information, see Health Stats
Tab and JVM Tab.

For more information on the ESA Correlation service and ESA Rule memory usage, see the Alerting
with ESA Correlation Rules User Guide.
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NETWITNESS

Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring. Policies System Stats Browser  Event Source Monitoring Settings NEVCEEGRANEGEC esaaprimary @

HOSTANDSERVICES esaaprimary - ESA Correlation Details
Host

Service
Contexthub Server

| esa corretation cPu 0.8% Used Memory

Running Since 2022-Aug-08 09:49:48 Max Process Memory

Build Date 2022-Aug-03 05:53:54 Version Information

admin v

4.40GB
31.42GB

12.1.0.0

Health Stats Jwm

Configuration Update Status Healthy Process Modules Healthy
Process JVM Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy

The Malware Analysis service details view has Service information plus the Event,
that show additional statistics. The Events tab shows event processing statistics.

and JVM tabs

NETWITNESS

admin v

Monitoring Policies System Stats Browser  Event Source Monitori Settings New Health & Wellness  adminserver malware @

Service
Broker
cpu

0.2%

2021-Apr-30 13:07:44

Used Me

I Malware Analysis
Running Since

Max Process Memary 15.67GB
Build Date 2021-Apr-05 16:51:58 Version Information 11.6.0.0
Events M
Number Of Events For Past 24 Hours Average Processing Time 0 milliseconds
Number Of Files For Past 24 Hours ents In Queue 0
Number Of Events For Past 7 Days Events Processed 0
Number Of Files For Past 7 Days Events Per Second Throughput 0

Number nts Past Month Session Time Of Last Event

Number Of File: Past Month

Number Of Events For Past 3 Months

Number Of Files For Past 3 Months

The Reporting Engine service details view has Service information plus the Report and JVM tabs
that show additional statistics.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NEWRSEENGEATAIGES adminserver @

HOST AND SERVICES

Reporting Engine Details

Host
Service
Broker
(| eperiigsie cPu 0.7% Used Memory 22868
Running Since 2022-Aug-08 09:10:56 Max Process Memory 62.92 GB
Orchestration Server .
Build Date 2022-Aug-03 11:58:58 Version Information 12.1.00
Security Server
Admin Server Report VM
Config Server Number Of OAs Failed In Last Hour 0 Number Of Active Requests 0
Investigate Server Number Of Reports Failed In Last Hour 0 Average Time Taken For RE Requests 0 milliseconds
Respond Server Number Of Rules Failed In Last Hour 0 Number Of Enabled Alerts 0
Maximum Time Taken For RE Request 1030 milliseconds Number Of Alert Execution Failed In Last
Integration Server 10 Minutes o
Number Of Requests Completed 452
Content Server Max Number Of Rows Fetched For Max Rows Fetched For Alerts o
Charts 0 Number Of Requests Failed In Last 10
Source Server Mins o
Number Of Chart Executions Failed In 0
Last 10 Mins Number Of Requests Received 452
Number Of Enabled Charts 2 Number Of Requests Failed 0
Total Disk Space 28.00 GB Number Of Active Rule Executions 0
Used Disk Space 194.00 MB Total Number Of Failed Rule Executions 0
Max Rule Execution Time 0 milliseconds

You can also view the details of other services by clicking the services listed in the options panel on the
left.

Refer to Monitoring View for a detailed description of the Details view for each service.

50



System Maintenance Guide

Monitor Event Sources

A
Note: For NetWitness 11.4.1, this view has been deprecated. To manage Event Sources, use the
(Admin) > Event Sources view. For details, see "About Event Source Management" in theNetWitness
Event Source Management Guide.
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Monitor Alarms

You can set up alarms and monitor them in the Health and Wellness interface for the hosts and services
in your NetWitness domain. Alarms display in the view as Active when the statistical thresholds for
hosts and services have been crossed. Alarms are grayed out and change to the Cleared status when the
clearing threshold has been crossed.

You set up the parameters for alarms in Manage Policies. For the related reference topic, see Health and
Wellness View - Alarms View.

To monitor alarms:

1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.

NETWITNESS e spond Users Hosts Files Dashboard Reports admin v

HEALTH & WELLNESS ~ SYSTEM CURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness

Time State Severity Rule Name Service Hostname 1P Address Stat Value
2021-04-30 01:48:36 PM Active @ Critical  Lockbox Access Failure Warehouse Connector logdecoder 10.125.250.160 Lockbox/Lockbox Status NotFou, =
2021-04-30 01:43:04 PM Active @ Critical  Lockbox Access Failure Warehouse Connector decoder 10.125.250.155 Lockbox/Lockbox Status NotFou :?
2021-04-3001:42:37PM  Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder endpointloghybrid1 10.125.250.162 Pool/Packet Capture Queue 0 :’:
2021-04-3001:42:37PM  Active @ Critical  Log Decoder Capture Rate Zero Log Decoder endpointloghybrid1 10.125.250.162 Capture/Capture Packet Rate (current) 0
2021-04-30 01:42:37 PM Active @ Critical  Log Decoder Capture Not Started Log Decoder endpointloghybrid1 10.125.250.162 Capture/Capture Status stoppe¢
2021-04-30 01:42:24 PM Active @ Critical  Concentrator Meta Rate Zero Concentrator 1 10.125.250.162 Concentrator/Meta Rate (current) o
2021-04-3001:4224PM  Active @ Critical  Concentrator Aggregation Stopped Concentrator endpointioghybrid1 10.125.250.162 Concentrator/Status stoppec.
2021-04-3001:33:03PM  Active @ Critical  Decoder Capture Rate Zero Decoder decoder 10.125.250.155 Capture/Capture Packet Rate (current) 0
2021-04-3001:32:13PM  Active @ Critical  Decoder Capture Not Started Decoder decoder 10.125.250.155 Capture/Capture Status stopped |'
2021-04-30 01:32:13 PM Active ical  Decoder Packet Capture Pool Depleted Decoder decoder 10.125.250.155 Pool/Packet Capture Queue o
2021-04-3001:31:42PM  Active @ Critical  Log Decoder Capture Rate Zero Log Decoder logdecoder 10.125.250.160 Capture/Capture Packet Rate (current) 0
2021-04-3001:31:42PM  Active @ Critical  Log Decoder Capture Not Started Log Decoder logdecoder 10.125.250.160 Capture/Capture Status stoppec.
2021-04-3001:31:42PM  Active @ Critical  Log Decoder Log Capture Pool Depleted Log Decoder logdecoder 10.125.250.160 Pool/Packet Capture Queue 0
2021-04-3001:07:52PM  Active @ Critical  Broker Aggregation Stopped Broker adminserver 10.125.250.154 Broker/Status stoppec.
2021-05-06 07:33:37 PM Active [ ] High System Swap Utilization Host adminserver 10.125.250.154 Systeminfo/Swap Utilization 50.84%
2021-04-3001:07:56 PM  Active ° Respond Server in Unhealthy State Respond Server adminserver 10.125.250.154 Processinfo/Overall Processing Status Indicator PARTIAI
2021-04-30 01:07:52 PM Active [ ] Broker Session Rate Zero Broker adminserver 10.125.250.154 Broker/Session Rate (current) o v
>
Page 1  of1 C' ™ AutoRefresh Items 1-19 0f 19

2. Click on the alarm for which you want to display details in the Details Panel.
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3. Click </ (expand) to view the details for the alarm you selected.

lI' H .
Alarm Detalls
State

Severit

Service

Palicy

Rule Mame
nformational Text
Srat

Count

Cleared Value
Cleared Time
Matified Time
Suppression Start Time

025-1544-0001

2019-01-29 03:43:00 PM

ACTIVE

CRITICAL

dec

Host

Host Menitoring Policy

Critical Filesystem Usage on Rabbitmg Message Broker

The RabbitM{) service filesystem at
fvar/netwitness/rabbitmg (fvar/lib/rabbitmg for 10.6.x
systems) has exceeded 75% of capacity, which is a likely
indicator that messages generated by NetWitness services
are either not being sent over the bus or aren’t being sent
quickly enough.

The RabbitM{) service will stop transmitting messages
when it reaches 80% of its filesystem capacity, which will
cause Health & Wellness message, Event Source
Meonitoring messages, and Log Collector logs to stop
being delivered.

Possible Remediation Action:

The filesystem is soon likely to fill. Please open a case with
Customer Support as quickly as possible to avoid a
potental service outage.

FileSystemd/Mounted Filesystem Disk Usage Percent
Fvarflibfrabbitmg

7%
1
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Monitor Health and Wellness Using SNMP Alerts

You can monitor a NetWitness component to proactively send alerts, using Simple Network
Management Protocol (SNMP) that is based on thresholds or system failures.

You can monitor the following for NetWitness components:
e CPU utilization that reaches a defined threshold.
e Memory utilization that reaches a defined threshold.

e Disk utilization that reaches a defined threshold.

SNMP Configuration

NetWitness Servers can be configured to send out SNMPv3 threshold traps and monitor traps. Threshold
traps are sent in conjunction with node thresholds that are configured by the NetWitness Core
applications. Monitor traps are sent by the SNMP daemon for the items indicated in the SNMP
configuration file. You must set up the SNMP daemon on another service to receive SNMP traps from
NetWitness. You can set up SNMP on NetWitness in the configuration setting for the NetWitness
Server. For more information, see "Service Configuration Settings" in the NetWitness Host and Services
Getting Started Guide for a specific type of host.

Thresholds

Thresholds can be set on any service statistics that can accept the setLimit message. You can retrieve
current thresholds using the getLimit message. To set a limit, you can pass a low and high threshold
value.

When the value of a statistic crosses either the low or high threshold, an SNMP trap is triggered,
indicating that the threshold has been crossed. The trap is not triggered if the value is below the low and
above the high value, but another trap is triggered if it crosses back into the normal range (above the low
and below the high).

You must set the threshold for the service using the Service Explorer view or the REST API.
This example shows a sample threshold for monitoring CPU usage (below 10% or above 90%):
/sys/stats/cpu setLimit low=10 high=90

This example shows how the threshold is set using REST API:

http://<log decoder>:50102/sys/stats/cpu?msg=setLimit&low=10&high=90

If the CPU usage spikes to 90% or higher, an SNMP trap is generated:

23435333 2018-Dec-16 11:08:35 Threshold warning path=/sys/stats/cpu o0ld=77%
new=91

Configure SNMPv3 for a Host

4
1. Goto (Admin) > Services.
The Services view is displayed.

2. Select the service.

3. In the Actions column, select View > Explore.
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4. In the nodes list, expand the list and select a configuration folder. For example, logs > config

Set the SNMPv3 configuration.

NETWITNESS

HOSTS SERVICES

EVENT SOURCES

Investigate Respond Users Hosts

ENDPOINT SOURCES

& Change Service | I endpointloghybrid2 - Concentrator |  Explore &

= endpointloghybrid2 -...
B i endpointloghybrid2 - Concentrator (CONC.
&[T concentrator
[ connections
B[ database
[ deviceappliance
B[ Jindex
B2 logs
[ config
Ostats
[tasks
Jrest
B[ ]sdk
Jservices
& [ storedproc
COsys
B[ users

Jlogs/config
Log Color (log.color)

Log Database Directory (log.dir)

Log Levels (loglevels)

SNMP Trap Agent (log.snmp.agent)

SNMP Agent Trap Version (snmp.trap.version)

SNMPV3 Engine Boots (snmpv3.engine.boots)

SNMPV3 Engine ID (snmpv3.engine.id)

SNMPV3 Trap Auth Local Key (snmpv3.trap.auth.local.key)
SNMPV3 Trap Auth Protocol (snmpv3.trap.auth. protocol)
SNMPV3 Trap Privacy Local Key (snmpv3.trap.priv.local key)

SNMPV3 Trap Privacy Protocol (snmpv3.trap.priv.protocol)

[, SNMPV3 Trap Security Level (snmpv3.trap.security.level)

SNMPV3 Trap Security Name (snmpv3.trap.security.name)

Syslog Max Size (syslog.size.max)

Set the Threshold for a Service

Q
1. Goto (Admin) > Services.
The Services view is displayed.

Select the service.

A T

In the Actions column, select View > Explore.

Select a stat, for example, CPU, and right-click.

From the drop-down menu, select Properties.

HEALTH & WELLNESS

Dashboard Reports admin v

SYSTEM SECURITY

endpointloghybrid2 - Concentrator
off
Nvarflog/netwitness/concentrator=1024MB

info,audit warning failure

none

none

noAuthNoPriv

65536

In the nodes list, expand the list and select a stat folder.

The Properties panel is displayed. The Properties panel has a drop-down list of available messages

for the parameter.

| St

get
getLimit
help
info

setlimit

55



System Maintenance Guide

7. Select setLimit.
8. Specify the low and high values.

SNMP Traps for System Status

The threshold mechanism can also be used to monitor string-valued stats generated by Core services.
There are two ways to monitor string-valued stats:

1. Generate a trap whenever the status value is NOT an expected value. For example, if you want
monitor the stat /broker/stats/status and generate a trap whenever the value is not started,
set the high limit on the stat to the expected value. You would use the setLimit message on

/broker/stats/status as follows:
setLimit high=started

2. Generate a trap whenever the status value matches an expected value. This is accomplished by using
the 1ow limit on the stat. For example, if you wanted generate a trap when the stat
/sys/stats/service.status has the value "Initialization Failure", you would use the

setLimit message on /sys/stats/service.status as follows:
setLimit low="Initialization Failure"

In both of these scenarios, it is possible to check for multiple values by using a comma-separated list of
values to check for.
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Troubleshooting Health & Wellness

Issues Common to All Hosts and Services

You may see the wrong statistics in the Health & Wellness interface if:

¢ Some or all the hosts and services are not provisioned and enabled correctly.

* You have a mixed-version deployment (that is, hosts updated to different NetWitness versions).

Supporting services are not running.

Issues Identified by Messages in the Interface or Log Files

This section provides troubleshooting information for issues identified by messages NetWitness
displayed in the Health & Wellness Interface or included in the Health & Wellness log files.

User Interface: Cannot connect to System Management Service
System Management Service (SMS) logs:

Caught an exception during connection recovery!
java.io.IOException
at com.rabbitmg.client.impl.AMQChannel.wrap

(AMQChannel.java:106) at
com.rabbitmg.client.impl.AMQChannel .wrap

(AMQChannel.java:102) at
com.rabbitmg.client.impl.AMQConnection.start (

AMQConnection.java:346) at com.rabbitmg.client.impl.recovery.

RecoveryAwareAMQConnectionFactory.
newConnection

(RecoveryAwareAMQConnectionFactory.java:36)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.
recoverConnection (AutorecoveringConnection.java:388)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.beginAutomaticRecovery
(AutorecoveringConnection.java:360)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection.

access$000 (AutorecoveringConnection.java:48)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection$l.shutdownCompleted
(AutorecoveringConnection.java:345)
at com.rabbitmg.client.impl.ShutdownNotifierComponent.

notifyListeners (ShutdownNotifierComponent.java:75)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:572)

at java.lang.Thread.run (Thread.java:745)

Caused by: com.rabbitmg.client.ShutdownSignalException:
connection error at
com.rabbitmg.utility.ValueOrException.getValue
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(ValueOrException.java:67)
at com.rabbitmg.utility.BlockingValueOrException.

uninterruptibleGetValueBlockingValueOrException.java:33)
at
com.rabbitmg.client.impl.AMQChannel$BlockingRpcContinuation.

getReply

(AMQChannel.java:343)

at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:292)

8 more

Caused by: java.net.SocketException: Connection reset
at java.net.SocketInputStream.read
(SocketInputStream.java:189)

at java.net.SocketInputStream.read
(SocketInputStream.java:121)

at java.io.BufferedInputStream.fill
(BufferedInputStream.java:246)

at java.io.BufferedInputStream.read
(BufferedInputStream.java:265)

at java.io.DatalnputStream.readUnsignedByte
(DataInputStream.java:288)

at com.rabbitmg.client.impl.Frame.readFrom(Frame.java:95)
at com.rabbitmg.client.impl.SocketFrameHandler.readFrame
(SocketFrameHandler.java:139)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:532)

RabbitMQ service not running on the NetWitness Server.

Restart the RabbitMQ, SMS, and NetWitness services using the following
commands.

systemctl restart rabbitmg-server

systemctl restart rsa-sms

systemctl restart jetty

User Interface: Cannot connect to System Management Service

The System Management Service, RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services

are running.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).

[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
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[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3.3.4"},

User Interface: Cannot connect to System Management Service

/var/lib/rabbitmg partition usage is 70% or greater.

Contact Customer Care.

User Interface: Host migration failed.

One or more NetWitness services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness Server:
Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response Server,
IPDB Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting Engine,
Warehouse Connector, Workbench.

User Interface: Server Unavailable.

One or more NetWitness services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness Server:
Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response Server,
IPDB Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting Engine,
Warehouse Connector, Workbench.

User Interface: Server Unavailable
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System Management Service (SMS), RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services
are running.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3.3.4"},

Make sure /var/lib/rabbitmg partition is less than 75% full

Check NetWitness Server log files (var/1ib/netwitness/uax/logs/nw.log) for
any errors.

ContextHub stops and does not allow you to add or edit data sources and lists.

The storage is full by 95% or above.

Increase the storage by updating the YML file, located at /etc/netwitness/contexthub-
server/ contexthub-server.yml.
For example, to increase storage from 120 to 150 GB, enter a value (in bytes) by

editing the relevant parameter: rsa.contexthub.data.disk-size:
161061273600

Delete unwanted or unused large list.

Configure the TTL index for the list to automatically delete STIX and TAXI data and
to clean up storage space.

Context Hub runs on a fixed memory and 50% is reserved for cache. When cache is
100% full, the cache response stops. For all new lookups the response will be slow.
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The cache is full by 50% or above.

By default, Context Hub cleans the cache every 30 minutes. Reduce the cache
expiration time of data sources.

Disable cache for data sources.

Increase the RAM of the CH Java process by editing the -Xmx option available in the
/etc/netwitness/contexthub-server/contexthub-server.conf file. In JAVA OPTS, search
for the -Xmx option.

For example, edit the entry as follows:

-Xmx8G

where 8G represents 8GB space. Then restart the ContextHub service.

Note: The memory is less than the available system memory. Be aware that there
are many other services running on the host.

List Data Source displays an unhealthy stats or status.

Unable to:

e access the data source

e parse or read a CSV file

¢ schema mismatched CSV

Unable to authenticate when accessing the data source.

Make sure to save the csv file at correct location i.e/var/lib/netwitness/contexthub-
server/data/ and verify the required read permissions.

Make sure the csv file schema specified while configuring the data source matches. If
not, then either create a new data source with the new schema or edit the csv file to
match the schema. For example, if you configure a List Data Source with a schema
with columnl, column2, and column3. And next time you update the csv file where
the number of column increase or decrease or the order of the columns are changed.
In this case there is a schema mismatch and the configured list data source will show
“Unhealthy” in Health and Wellness stats.

Make sure the password is correct. To confirm edit the data source, enter the
password and click test connection.

For more information related the above solutions, see "Configure Lists as a Data
Source" topic in the Context Hub Configuration Guide.
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Issues Not Identified by the User Interface or Logs

This section provides troubleshooting information for issues that are not identified
by messages NetWitness displays in the Health & Wellness Interface or includes in the Health &
Wellness log files. For example, you may see incorrect statistical information in the Interface.

Incorrect statistics displayed in Health and Wellness interface.

SMS service is not running. SMS service must be running on the NetWitness Server,

Restart SMS service.

NetWitness does not show the version to which you upgraded until you restart jettysrv
(jeTTy server).

When NetWitness checks a connection, it polls a service every 30 seconds to see if
it is active. During that 30 seconds, if the service comes back up, it will not get the
new version.

1. Manually stop the service.
2. Wait until you see that it is it offline.

3. Restart the service.
NetWitness displays the correct version.

NetWitness Server does not display the Service Unavailable page.

After you upgrade to NetWitness version 10.5, JDK 1.8 is not default version and this
causes the jettysrv (jeTTy server) to fail to start. Without the jeTTy server, the
NetWitness server cannot display the Service Unavailable page.

Restart jettysrv.

The SMS service is stopped and the following error is displayed in the log file:
java.lang.OutOfMemoryError: Java heap space

You can use the following solution to increase the memory according to your needs.

1. Open /opt/rsa/sms/conf/wrapper.conf
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2. Replace wrapper.java.additional.l=-Xmx16g with
wrapper.java.additional.l=-Xmx20g

3. Restart the SMS service:
systemctl start rsa-sms
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Monitor New Health and Wellness

NetWitness New Health and Wellness is an advanced monitoring and alerting system that provides
insights on the operational state of the host and services in your deployment, and helps identify potential
issues. NetWitness Platform is prepackaged with a third-party tool that renders interactive dashboards
and visualizations.

New Health and Wellness provides:

e Dashboards with interactive visualization.

» FEasy-to-create customized content.

e Alerts on your data and customize alert conditions.

 Ability to add alert notifications (for example, Email and Syslog notifications).

» Ability to suppress alert notifications for a time period as required.

New Health and Wellness provides default content, such as dashboards, visualizations, and monitors, to
set up monitoring and alerting.

Please direct any New Health and Wellness feedback to nw.health.wellness.feedback@rsa.com.

Dashboard

The dashboard is a collection of intuitive visualizations for the administrator to monitor the health of the
host and services, identify trends, track performance, and drill down to specific details.

After installation of the New Health and Wellness service, the following default dashboards are available
to begin monitoring.

e Deployment Health Overview dashboard
* Hosts dashboard

* Logs dashboard

» Packets Overview dashboard

e Analysis dashboard

* Endpoint dashboard

¢ ESA Correlation Overview dashboard

For more information on the dashboards, see New Health and Wellness Dashboards .

Visualization

A visualization is a graphical representation of data in your deployment. You can create new
visualizations or use the existing visualizations to build dashboards. Depending on the visualization you
select the data is displayed in the dashboard.
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Monitors

A monitor is a job that runs on a defined schedule, which queries Elasticsearch to evaluate the system
health. You can define one or more triggers for a monitor and assign a severity level based on the
threshold. When one or more trigger conditions are met, New Health and Wellness generates an alerts.
You can create new monitors or customize the existing monitors based on your requirement.

Notifications

Notifications can be sent when health alerts are generated, for example, email and syslog notifications.

If you do not want to receive notifications, you can suppress them for a time period. For example, if you
want to suppress low-severity alerts during weekends, you can do so by specifying a suppression policy.

After the suppression time period, the notifications will be sent for the alerts triggered during the
suppression time.

Installing New Health and Wellness

You can deploy the New Health and Wellness feature on any one of the following, listed in the order of
preferred deployment method with most preferred first:

e Standalone virtual host (Most preferred recommendation to ensure no performance impact on any
other functionality of deployed nodes)

* Physical machine:
° Broker
°© Admin Server

° ESA

Installing New Health and Wellness enables all hosts and services in your deployment to start sending
metrics for monitoring. For more information on installing New Health and Wellness, see the
"Deployment Optional Setup Procedures" topic in the Deployment Guide.

Accessing New Health and Wellness Dashboards

After you deploy New Health and Wellness, you can access New Health and Wellness dashboards. By
default, only Administrator can access New Health and Wellness dashboards. Other roles do not have
permission to view New Health and Wellness dashboards.

To access New Health and Wellness dashboards:

1. Log in to NetWitness Platform.

Q
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
4. Click Pivot to Dashboard.

Note: To view dashboards, your browser must be configured to allow popups and redirects.
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Configuring Notifications

You can choose to receive notifications of alert, when an alert (monitor) is triggered. You can configure
the following types of notifications for the alerts.

e Email

e Syslog

To set up notifications, you must configure the following :

* Notification Server: This is the source of the notifications and must be configured to specify the
Email or Syslog server settings.

» Notifications Output: This is the notification type, namely Email or Syslog. When you set up a
notification, you must specify the notification output for an alert.

e Templates: The message format of an alert notification is defined using template. Default template is
available for New Health and Wellness notifications or you can create new templates.
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Adding Alert Notifications

To add notifications such as email or syslog, you must specify the notification details as follows:

e Output Type

e Recipient

¢ Notification Server

e Template

Note: You must ensure that the notification server and template is configured before you set up the
notifications. You can use an existing server if required. For detailed procedures, see the System
Configuration Guide.

To add a notification:

1.

5.

aQ
Go to (Admin) > Health & Wellness.
Click New Health & Wellness.

Click View Notifications Settings.

Specify the following:

¢ Output Type - Notification type such as Email or Syslog.

¢ Recipient - Select the recipient based on the output type selected.

¢ Notification Server - Select the server that will send the notification. If you want to add a new
notification server, see "Configure Notification Servers" in the System Configuration Guide.

¢ Template - Notification template such as Email or Syslog.

If you want to add another notification, click Add Condition and repeat step 4.

Note: You can specify a maximum of four conditions in the notification settings.

6.

Click Save.
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Suppressing Notifications

You can suppress notifications for a time period by specifying a suppression policy. For example, you do
not want to receive notifications of low-severity alerts during peak hours or weekends. This ensures that
notifications are not sent during the selected time period. The notifications triggered during this time
period will be sent after the suppression period.

A suppression policy consists of condition that defines the day and time range for suppressing a
notification.

Note: You can specify a maximum of seven conditions in the policy.

To suppress alert notification:

1. Goto (Admin) > Health & Wellness.

2. Click New Health & Wellness.

3. In the New Health & Wellness tab, do anyone of the following:
¢ Select the alert or alerts for which you want to apply a suppression policy.
¢ Select all to apply a suppression policy to all alerts.

¢ Filter alerts on suppression applied, monitor name, trigger name, and severity and apply the
suppression policy.

4. Click View Suppression Policy.
The policy suppression dialog is displayed.

5. Specify the days and time range during which you want to suppress the notification.

Note: Time range is based on the Time Zone configured in the User Preferences panel as described in
"Setting User Preferences" in the Getting Started Guide.

6. To add an additional suppression policy, click Add condition and repeat step 5.

Note: The maximum number of suppression policy supported for an alert is seven, after which the
Add Condition option is disabled.

7. Click Save.

68



System Maintenance Guide

Monitoring through Dashboards

For a thorough analysis of the health of NetWitness Platform hosts and services using the different
dashboards, you can pivot to dashboard without any additional authentication. By default, the last 6
hours of data is displayed in the dashboard. For more information on the default dashboards, see New
Health and Wellness Dashboards.

To monitor through the dashboard:

D
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.

3. Click Pivot to Dashboard.
The Deployment Health Overview dashboard is displayed.

4. Goto E > Dashboard to view all the available dashboards.

5. Select the dashboard you want to view.

6. Click the dashboard link. For example, Hosts.
Once the dashboard view is displayed you can look at the visualizations (charts, tables, and so on) to
view current disk usage of hosts, incoming and outgoing traffic of the host, active queries on a
service, and so on.

== Current Memory Usage vs Total Available Memory Disk Usage by Partitions

26.28GB

28.47GB

Sarvica(s) by Open File Descriptors
Current Disk Usage vs Total Available Disk

10.99GB

191.2GB

7. You can adjust the time range on the top right corner and apply filters to view the statistics.
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Creating a Custom Dashboard

You can create a new dashboard by adding one or more existing visualizations or a new visualization.

To create a new dashboard:

1. Log in to NetWitness Platform.

aQ
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
4. Click Pivot to Dashboard.

Go to H > Kibana > Dashboard.
In the Dashboards panel, click Create dashboard.

Click Create new.

o =N

Select a visualization that you want to add to the dashboard. For more information on Visualization,
see "Visualize" topic in the Kibana 7.10.0 guide.

9. Click Save.
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Monitoring through Alerts

You can monitor the health of NetWitness Platform hosts and services using the alerts.

To monitor using alerts:

D
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.

3. Goto E >Open Distro for Elasticsearch > Alerting.
The alerts view summarizes the alerts generated over the period of time along with the trigger,
severity (Critical, High, Medium or Low) and state of the alert.

4. To view the monitors and triggers associated with the alert, click the Monitor name link.

All severity levels All alerts

Alert start time .- Alert end time Monitor name Trigger name Severity State Time acknowledged
01/17/20 3:48 pm 01/17/20 4:18 pm ... Capture Not Started 1 Completed
01/17/20 3:49 pm 01/17/20 4:18 pm ... Capture Pool Depleted 2 Completed
01/17/20 3:01 pm 01/17/20 3:37 pm ..  Capture Mot Started Completed
01/17/20 3:01 pm 01/17/20 3:37 pm ... Capture Pool Depleted Completed
01/06/20 11:57 am 01/07/20 3:28 pm ... Capture Not Started Completed
01/06/20 11:57 am 01/07/20 3:28 pm ... Capture Pool Depleted Completed

01/06/20 11:57 am = ... Service in Bad State Active

01/06/20 11:57 am = ... Aggregation Stopped Active

01/06/20 11:57 am = ... MetaRateis0 Active

01/06/20 11:57 am = ... Service in Bad State Active

For example, if an alert is generated by the monitor name Broker Aggregation Stopped, you can view
more details by clicking on the Broker Aggregation Stopped monitor link.
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Broker Aggregation Stopped

Broker Aggregation Stopped

Overview

State Monitor definition type
Enabled Visual graph

Last updated Monitor ID
01/06/20 11:55 am IST 2LuHeWSBTACr!

Triggers
Name T Number of actions

Aggregation Stopped 0

Aggregation Stopped
History

Aggregation St
opped

Total active alerts Schedule
1 Every 2 minutes

Monitor version number
1

Severity

1

01/18/2020 12:00 AM = 01/20/2020 11:56 AM

J———u_——l———u———u_—-

Triggered I Error I Acknowledge No alerts

Alerts

Alert startti.. v Alert end time Monitor name

01/06/20 11:57
am

Rows per page: 20 ~

All severity levels ~ All alerts

Trigger name Severity Time acknowle...

Aggregation ... Active
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Creating Custom Monitors

You can create a new monitor for the host and services and define a trigger.

To create monitors:

1.

b

© =N W

10.

Log in to NetWitness Platform.

aQ
Go to (Admin) > Health & Wellness.
Click New Health & Wellness.
Click Pivot to Dashboard.

Go to H > Open Distro for Elasticsearch > Alerting.
In the Monitors tab, click Create monitors.

In the Create Monitors section, specify the required details.
Click Create.

After a monitor is created, you can add a trigger to this monitor.
In the Create Trigger view, provide the required details:
a. Trigger name - Specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the lowest
severity.

c. Trigger condition - Set the trigger condition with the value. The options are IS ABOVE, IS
BELOW, IS EQUAL. For example, IS ABOVE 200.

Click Create to save the trigger.

Note: After the specified duration, defined as FOR THE LAST in the Define monitor view, the
alert state will change if the trigger condition is met. For more information, refer https://nw-
corp.atlassian.net/browse/ASOCKB-65.

For more information on creating monitors, see "Alerting" in the Open Distro for Elasticsearch 1.12.0
guide.
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Adding Custom Trigger to an Existing Monitor
You can add one or more triggers to an existing monitor and assign severity level.
To add trigger to an existing monitor:

1. Log in to NetWitness Platform.

aQ
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
4. Click Pivot to Dashboard.

5. Goto E > Open Distro for Elasticsearch > Alerting.

Alerting

Home

Recently viewed

Alerting

6. In the Monitor section, click the monitor for which new trigger need be added.
7. In the Triggers section, select Create.
8. In the Create Trigger view, provide the required details:

a. Trigger name — specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the lowest
severity.
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c. Trigger condition — Set the trigger condition with the value. The options are IS ABOVE, IS
BELOW, IS EQUAL. For example, IS ABOVE 200.

9. Click Create to save the trigger.

Note: After the specified duration, defined as FOR THE LAST in the Define monitor view, the
alert state will change if the trigger condition is met. For more information, refer https://nw-
corp.atlassian.net/browse/ASOCKB-65.
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Managing Dashboards and Alerts

You can modify the dashboards and alerts to monitor details of interest.

Modify a Dashboard

You can modify the dashboard to edit the visualization, delete visualization, customize the panel title, or
change the positions of visualization. You can organize the visualization in the dashboard to display data
of greatest interest on the top.

Note: Any changes to the visualization in a dashboard modifies the visualization content.

To modify a dashboard:

D
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.
3. Click Pivot to Dashboard.

4. Goto E > Kibana > Dashboard.
5. Click the dashboard link you want to modify. For example, Hosts overview.

6. Click Edit and make the necessary changes to the dashboard. For example, you can edit or delete
visualization, customize panel.

7. Click Save and return.

Delete a Dashboard

Once the dashboard is deleted, you cannot monitor the details specific to the dashboard.

To delete a dashboard:

Q
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.
3. Click Pivot to Dashboard.

4. Goto H > Kibana > Dashboard.

5. Select the check box of the dashboard you want to delete and click Delete.

You can delete one or more dashboards at a time.
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Delete a Visualization

To delete a visualization:

1.

A
Go to (Admin) > Health & Wellness.
Click New Health & Wellness.
Click Pivot to Dashboard.

Go to E > Kibana > Visualize.
In the Visualizations view, select the visualizations you want to delete.
Click Delete visualization.

You can delete one or more visualization at a time.

Modify an Existing Trigger

To modify an existing trigger:

1.
2.

W

N »k

A
Go to (Admin) > Health & Wellness.
Click New Health & Wellness tab.
Click Pivot to Dashboard.

Go to H > Open Distro for Elasticsearch > Alerting.
In the Dashboard tab, select the monitor whose trigger is to be modified.
In the Triggers section, select the trigger you want to modify from list of Triggers and select Edit.

In the Edit Trigger view, make the necessary changes. You can change the Trigger name, severity
level, Trigger condition.

Click Update to save the changes.
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Managing Notifications

You can manage alert (monitor) notifications based on your requirement.

Modify a Notification

To modify a notification:

1. Log in to NetWitness Platform.

2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.

4. Click View Notifications Settings.

5

6

. Make the necessary changes.
. Click Save.

Modify a Notification Suppression Policy

When you modify a suppression policy, you can change the day or time ranges. If you select multiple
alerts to modify the policy, any changes would overwrite all the existing policies.

To modify suppression policy:
4
1. Goto (Admin) > Health & Wellness.
. Click New Health & Wellness.

2
3. Select one or multiple rows for which you to modify suppression policy.
4

. Click View Suppression Policy.

Note: If you have selected multiple alerts to modify the suppression policy,

- Only policies that are common are displayed. Policy suppression settings would be empty if there is
no common polices.

- If you edit the common policies, the changes would overwrite all the selected alert policies.

5. Make the necessary changes.
6. Click Save.

78



System Maintenance Guide

Advanced Configurations

Restore Default Content

This allows you to bring back all the default content such as dashboards, visualizations, monitors to its
original or default state. This overwrites any changes made to the default content. For example, if you
have deleted any dashboard or visualization and want to bring back the default content.

L.

=N

10.

11.

Log in to NetWitness Platform UI.

Click (Configure) > LIVE CONTENT.

In the Search Criteria panel, select the Resource Types as:
¢ Health and Wellness Dashboards

e Health and Wellness Monitors

Click Search.

In the Matching Resources view, select the checkbox to the left of the resources that you want to
deploy.

In the Matching Resources toolbar, click [E Deploy .

In the Deployment Wizard > Resources tab, click Next.
In the Services tab, select the Metrics Server service.
Click Next.

Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.

Click Close.

Enable Services

This is used to enable all the services to start sending metrics for monitoring. For example, if you have
disabled few services from sending metrics for monitoring and want to enable all those disabled services
to start sending again.

1.
2.

SSH to the Admin Server.

Enter the following command:
nw—-shell
The console window is displayed.
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Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Navigate to the enable option using the following command:
cd /rsa/metrics/elastic/enable-all

Execute the following command to enable all services:

invoke

Disable Services

This is used to disable all the services to send metrics for monitoring. Once disabled, none of the
services sends alerts to the Elasticsearch and the dashboards are not updated, and alerts will not be
triggered.

1.
2.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.
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3. Connect to metrics-server using the following command:
connect --service metrics-server
4. Enter the login command:
login
5. Enter the admin username and password.
6. Navigate to Elasticsearch using the following command:
cd /rsa/metrics/elastic/disable-all
7. Execute the following command to disable all services to stop writing to Elasticsearch:

invoke

Note: This disables all services to send metrics to Elasticsearch but does not stop metric beat to send
system level metrics to Elasticsearch. You need to manually stop metric beat on all hosts if you wish
to stop using Health and Wellness.

Update an Interval

You can update a common interval for all the services to send data for monitoring. For example, if all
the services are set to different intervals and you want to configure all the services to send data to elastic
search on the same interval.

The interval can be set in seconds, minutes and hours.
1. SSH to the Admin Server.

2. Enter the following command:
nw-shell
The console window is displayed.
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Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Navigate to the update-interval directory using the following command:
cd /rsa/metrics/elastic/update-interval

Execute the following command to set a common interval for all the services:
invoke <interval>

For example, invoke 30seconds

Update the Default Configuration

By default, New Health and Wellness configurations are applied after the New Health and Wellness is
enabled successfully. To change the configuration of a service, you need to update the existing
configuration. After the configuration is updated, the service is notified of the changes.

To update the configuration, perform the following:

1.
2.

SSH to the Admin Server.

Enter the following command:
nw—-shell
The console window is displayed.
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Connect to the metrics-server using the following command:

connect —--service metrics-server

Enter the login command:
login

Enter the admin username and password.

To get configuration of a service, execute following commands:

a. cd /rsa/metrics/elastic/get-config

b. invoke <service-id>

Note:
To get the service id for core services:

1) Go to (Admin) > Core service.

2) Click > View > Explore.

3) Expand the sys/stats node list.

4) In the UUID filed, copy the value.

To get the service id for launch services:

1) Go to (Admin) > Launch service.
2) Click > View > Explore.
3) Click the process node.
4) In the service-id field, copy the value.
To get the service id for Carlos services:
1) SSH to host in which the Carlos service is deployed.
2) Execute the following command:
For Reporting Engine:
cat /var/netwitness/re-server/rsa/soc/reporting-engine/service-id
For Legacy Web Server:

cat /var/netwitness/uax/service-id

83




System Maintenance Guide

Note: The core services are Archiver, Broker, Concentrator, Decoder, Log Decoder and; Carlos
services are Reporting Engine, Legacy Web Server. All the other services that are not included in
Core and Carlos services are part of launch services.

Copy the configuration and save it in a file.
a. Copy the configuration from step 6 and exit from nw-shell using command:
exit
b. Create a file under /root in admin server, copy the configurations to the file and save it.

For example, For the Reporting Engine service, create a file reporting-engine. json under
/root/ and copy the configurations obtained from step 6 and save.

To set configurations for a service:
a. cd /rsa/metrics/elastic/set-config
b. invoke --file <absolute path of the path>

For example, invoke —--file /root/reporting-engine.json

Configure the Data Retention Policy

You can configure the retention policy for monitors (alerts triggered) and metrics based on age and size.

By default, 90 days of data with 100 GB of size for monitors (alerts triggered ) and 30 days of data with
100 GB of size for metrics are retained.

To change the configure for monitor (alerts triggered) retention:

1.

SSH to the Admin Server.

2. Enter the following command:

nw—-shell
The console window is displayed.

3. Connect to metrics-server using the following command:

connect --service metrics-server
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4. Enter the login command:
login
5. Enter the admin username and password.
6. Go to alert-retention-threshold using command:
cd /rsa/metrics/elastic/data/retention/alert-retention-threshold
7. Set the value between 1day to 90days using command:
set <number of days>
For example, set 50days
8. Exit from nw-shell using the command:
exit
9. SSH to the host on which New Health and Wellness is installed.
10. Restart the metrics server on which New Health and Wellness is installed using the command:

service rsa-nw-metrics-server restart

To change the configuration for metrics time threshold:

1. SSH to the Admin Server.

2. Enter the following command:
nw-shell
The console window is displayed.

3. Connect to metrics-server using the following command:

connect —--service metrics-server

4. Enter the login command:
login

5. Enter the admin username and password.
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Go to time-threshold using command:

cd /rsa/metrics/elastic/data/retention/time-threshold

Set the value from 1day to 90days using command:

set <number of days>

For example, set 40days

Exit from nw-shell using the command:

exit

SSH to the host on which New Health and Wellness is installed.

Restart the metrics server on which the New Health and Wellness is installed using the command:

service rsa-nw-metrics-server restart

To change the size configuration:

1.
2.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.

Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Go to allocated-size using command:

cd /rsa/metrics/elastic/data/retention/allocated-size
Set the value using command:

set <size to be allocated>
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For example, set 200GB
8. Exit from nw-shell using the command:
exit
9. SSH to the host on which New Health and Wellness is installed.

10. Restart the metrics server on which the New Health and Wellness is installed using the command:

service rsa-nw-metrics-server restart

Note: Make sure the /var/netwitness partition on standalone New Health and Wellness has
enough disk space. After you review your datastore configuration, you may determine that you need to
add a new volume. For more information on adding a new volume, see “Add New Volume and Extend
Existing File Systems” topic in the Virtual Host Installation Guide.
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Backup and Restore New Health and Wellness

Perform the following steps in the order given:

1.

Back up the Admin Server. For more information on the instructions, see "Disaster Recovery (Back
Up and Restore)" topic in Recovery Tool User Guide.

At the root level, type the following command on the host on which New Health and Wellness is
installed :

nw-recovery-tool --export --dump-dir /var/netwitness/backup --category
Search

Note: Make sure that the Admin Server is restored, up and running successfully.

Restore the New Health and Wellness using the following command:

nw-recovery-tool —--import --dump-dir /var/netwitness/backup --category
Search

Note: Restore the search category (New Health and Wellness) on the same host on which New
Health and Wellness is installed.

Reboot the Host on which search category (New Health and Wellness) is restored.

Restore the default content using RSA Live:

a.

b.

Log in to NetWitness Platform UlI.

Click (Configure) > LIVE CONTENT.

In the Search Criteria panel, select the Resource Types as:
¢ Health and Wellness Dashboards

¢ Health and Wellness Monitors

Click Search.

In the Matching Resources view, select the checkbox to the left of the resources that you want to
deploy.

In the Matching Resources toolbar, click <= €210y

g. In the Deployment Wizard > Resources tab, click Next.

h. In the Services tab, select the Metrics Server service.

Click Next.

Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully
deployed the resources to the selected services.

Click Close.
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Troubleshooting New Health and Wellness

This topic describes how to troubleshoot New Health and Wellness issues.

An error ‘n of m shards failed’ or ‘unknown field in the index’ in the New Health and
Wellness dashboards.

Refresh the index patterns, perform the following:

1. Log in to NetWitness Platform.

aQ
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
4. Click Pivot to Dashboard.

5. Goto E > Stack Management > Index Patterns.
6. Click nw* index pattern.

7. Click Refresh to refresh the index pattern on top right corner.

Note: If the issue still persists, refresh other index patterns such as nw-metricbeat*
or nw-concentrator* and so on.

Unable to send data to elastic search once disk usage reaches 85%.

If the Elasticsearch disk usage reaches 85%,

the saved objects (index patterns, dashboards, visualizations etc) becomes read-only
mode.

And, services does not write new metrics to Elasticsearch or allow to edit any saved
objects.

To change the indexes to write mode, execute the following command on the host in
which Elasticsearch is installed:

curl -k —--cert /etc/pki/nw/elastic/elasticsearch-cert.pem —--key
/etc/pki/nw/elastic/elasticsearch-key.pem -X PUT -H "Content-
Type: application/json" -d '{"index.blocks.read only allow
delete": null }' https://localhost:9200/ all/ settings

Note: This command is supported only with certificates.

New Health and Wellness > Pivot to Dashboard fails due to time
synchronization issue.

Pivot to dashboard fails if there is no time synchronization between the
NetWitness Server and the host on which New Health and Wellness is
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installed.

You must synchronize the time and pivot to dashboard. To synchronize the
time do one of the following:

* Configure the NTP Server. For more information, see "Configure NTP
Servers" in the System Configuration Guide.

¢ Run the following commands on the host on which New Health and
Wellness is installed

1. SSH to NetWitness host.

2. Run the following commands.
o systemctl stop ntpd
°© ntpdate nw-node-zero

o systemctl start ntpd

NW Host High Swap Utilization monitor generates many false alerts.

By default the set threshold is > 50 %, which might generate many false
alerts on NW Host High Swap Utilization monitor for Linux hosts, which is
considered normal.

Note: On upgrade to 11.5.3.0 version or later, the monitor will be
automatically deleted on the New Health & Wellness monitors view.

On version 11.5.2.0 or lower, you can perform the following steps to delete
the monitor:

1. Log in to the NetWitness Platform.
2. Go to (missing or bad snippet)> Health & Wellness.

3. Click New Health & Wellness.

4. Click Pivot to Dashboard.
The Deployment Health Overview dashboard is displayed.

5. Goto E > Open Distro for Elasticsearch > Alerting.
The Dashboards tab is displayed by default.
6. Click Monitors tab.
7. Select the NW Host High Swap Utilization monitor and click -

> Delete.
The monitor is deleted.
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Appendices

This section is a collection of appendices for new health and wellness:
o New Health and Wellness Dashboards

¢ New Health and Wellness Monitors
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New Health and Wellness Dashboards

This topic provides the list of default New Health and Wellness dashboards and associated visualizations
and metrics.

Deployment Health Overview Dashboard

This dashboard provides the overall health of the NetWitness Platform hosts and services. The following
table provides the information on default visualizations available on this dashboard.

Note: The parameters and metrics listed below are the default values. You can customize the
parameters and metrics of any visualization based on your requirement. For example, you can
customize a visualization to view the CPU utilization for all the core services or any particular service.

. - Parameters - -
Visualization . Objective Description
and Metrics
Alarms Summary * Count of Provides the summary of active Displays the active alarms
active alert health alarms based on the grouped by severity
« Alert severity severity. (Critical, High, Medium,
Low).
Offline Services * Service name  Identifies the list of unavailable Displays the list of offline
o ot e services. services.
* Refresh time
15 minutes
Stopped Archiver * Count of Identifies the number of Archivers Disp]ays the number of
Aggregation archivers where = where aggregation is stopped. Archivers where
aggregation is aggregation is stopped.
stopped For more information, see
o IR (e Notifications.
15 minutes
Stopped Broker ¢ Count of Identifies the number of Brokers Displays the number of
Aggregation Brokers where  where aggregation is stopped. Brokers where
aggregation is aggregation is stopped.
stopped For more information, see
« Refresh time Notifications.
15 minutes
Stopped * Count of Identifies the number of Displays the number of
Concentrator Concentrators Concentrators where aggregation is Concentrators where
Aggregation where stopped. aggregation is stopped.
aggregation is For more information, see
stopped Notifications.
* Refresh time
15 minutes
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Visualization

Parameters

and Metrics

Objective

Description

Stopped
Decoder/Log
Decoder Capture

Total vs Offline
Services

Stopped State
Aggregation &
Capture

NetWitness
Services Version
Status

NetWitness
Services — Uptime
Summary

Memory
Utilization Trend

Current CPU
Usage

Current Disk
Usage

Capture Rate for
Log Decoders

* Count of
Decoders or Log
Decoders where
capture is
stopped

» Refresh time
15 minutes

» Total number
of services

* Count of
offline services

» Refresh time
15 minutes

* Services name
e Host name

* Service
version

* Service
version

 Service name
e Host name

* Running since

« Service name

* Memory usage

* Services name
» CPU usage

* Services name

* Disk usage

 Service name

* Capture rate

Identifies the number of Decoders
or Log Decoders where capture is
stopped.

Identifies the number of offline
services versus total number of
services.

Provides the list of services where
aggregation and capture are
stopped.

Provides the status of NetWitness
Platform service versions.

Provides an overview on the
uptime of the services in the
deployment.

Provides the memory utilization
trend to detect any high utilizations
and take necessary action.

Provides the CPU usage trend of
the hosts to identify any high
utilizations and take necessary
action.

Provides the disk utilization in the
real time to identify any high
utilizations and take necessary
action.

Provides the capture rate trend to
identify any high values and take
necessary action.

Displays the number of
Decoder or Log Decoder
where capture is stopped.
For more information, see
Notifications.

Displays the total number
of services and the
number of services that
are offline.

Displays the list of
services where
aggregation and capture
are stopped.

Displays the status of
NetWitness Platform
service versions.

Displays the list of
services and their uptime.

Displays the memory
utilization trend of the
hosts.

Displays the current CPU
usage of the services.

Displays the current disk
usage of the hosts.

Displays the trend of Log
Decoders capture rate.
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. - Parameters
Visualization .
and Metrics

Objective

Description

Capture Rate for ~ * Service name

Network .
Decoders Capture rate
Session * Service name
Aggregation Rate  , gagsion
and Trend for 2 :
ggregation rate
Concentrators
Retention * Service id
Summary * Service name
* Running on
host
* Oldest meta
file time
* Oldest packet
file time
* Oldest session
file time
Total CPU Usage * CPU usage

Trend for Services ., gervice name

Total Memory * Service name
Usage Summary

for Services

Hosts Dashboard

* Memory usage

Provides the capture rate trend to
identify any high values and take
necessary action.

Provides an overview on the
session rate of the Concentrators to
identify any high values and take
necessary action.

Provides a quick view on the
current retention of the Decoders,
Concentrators and Archivers to
check if the retention is lower than
the configured retention.

Provides the CPU usage trend of
the services to detect the high
utilization and take necessary
action.

Provides the memory usage
summary of NetWitness Platform
services to detect any high usage
and take necessary actions.

Displays the trend of
Network Decoders
capture rate.

Displays the session
aggregation rate and trend
of Concentrator.

Displays the oldest date
for meta, session, packet
present in decoders,
logdecoders and
concentrators

Displays the top 20
services where CPU
usage is high.

Displays the top services
that are utilizing the
resident memories.

This dashboard provides the resource utilization and health of NetWitness hosts in your deployment. The
following table provides information on default Visualizations available on this dashboard.

Disk Used * Disk usage Provides the current disk usage of the  Displays the current
hosts to detect the high utilization and  disk usage of the host.

take immediate action.
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Current Memory
Usage vs Total
Available

Current Disk Usage
vs Total Available
Disk

Disk Usage by
Partitions

Resident Memory
Usage by Services

Memory Usage

CPU Usage

CPU Usage by
Services

Interfaces by
Incoming Traffic

Interfaces by
Outgoing Traffic

Services by Open
File Descriptors

e Current
memory
usage

e Total
available
memory

* Current
disk usage

* Total
available
disk

e Disk
partition

* Disk usage

* Service
name

* Resident
memory
usage

Memory
usage

CPU usage

* Service
name

* CPU usage

Incoming
traffic on
interfaces

Outgoing
traffic on
interfaces

 Services

* Open file
descriptor

Provides the current memory usage
versus total available memory to
identify high usage and take necessary
action.

Provides the current disk usage versus
total available disk to identify high
usage and take necessary action.

Provides the disk usage by different
partitions to identify high usage and
take necessary action.

Provides the resident memory usage
per service to identify high usage and
take necessary action.

Provides the current memory usage
percentage of the hosts to identify
high memory usage and take
necessary action.

Provides the CPU usage percentage to
identify high usage and take necessary
action.

Provides the CPU Percentage per
service to detect high usage and take
necessary action.

Provides the trend on interfaces
incoming traffic to detect any
deviation on time.

Provides the trend on interfaces
outgoing traffic to detect any
deviation on time.

Provides the list of open file
descriptor associate with a service.

Displays the current
memory usage and total
available memory of the
host.

Displays the current
disk usage versus total
available disk.

List of partitions and
associated disk
percentage.

Displays the resident
memory usage of the
service.

Displays the memory
usage of the host.

Displays the CPU usage
of the host.

Displays the CPU usage
of the service.

Display the incoming
traffic interfaces.

Display the interfaces
outgoing traffic.

Displays the list of open
file descriptor
associated with a
service.
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TOP APPLIANCES  * Service Provides the list of top appliances by ~ Displays top appliances
BY DISK 10 READ name disk IO read and write to detect any based on disk 10 read
(Line) Vs WRITE « Disk 10 high usage and take necessary action.  and write usage.

(Bar) Read

* Disk IO
Write

Total Inbound * Count of  Provides the total inbound traffic to Displays the current

Traffic for All inbound detect any deviation on time. inbound traffic and total

Interfaces traffic on transferred traffic.
Interfaces

* Total
transferred
traffic

Total Outbound * Count of  Provides the total outbound traffic to ~ Display the current

Traffic for All outbound detect any deviation on time. outbound traffic and

Interfaces traffic on total transferred traffic.
Interfaces

» Total
transferred
traffic

Logs Dashboard

This dashboard provides information on various NetWitness Platform logs. The following table provides
information on default Visualizations available on this dashboard.

Log Decoders by ~ * Service name Provides the Displays the
Capture Rate capture rate of Log Decoders
Log Decoders by capture rate.
to detect high

capture rate on

time and take

necessary

action.

 Capture Rate
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Log Decoders by
Capture Packet
Rate

Log Decoders by
CPU Percentage

Log Decoders by
Resident Memory
Usage

SDK Active
Queries on
Concentrators

Concentrators
Status

 Service name

* Capture Packet Rate

* Service name
* CPU usage

 Service name

* Resident Memory Usage

 Service name

* Count of active queries

* Service running on host

* Service type

* Service version

» Aggregation status

* Average session rate

» Max session rate

* Active queries

Provides the
capture packet
rate of Log
Decoder to
detect high
capture packet
rate on time
and take
necessary
action.

Identifies the
Log Decoders
by CPU usage
to detect high
usage and take
necessary
action.

Identifies the
Log Decoders
by resident
memory usage
to detect high
usage and take
necessary
action.

Identifies the
concentrators
by SDK active
queries.

Provides the
concentrator
status.

Displays the
Log Decoders
by capture
packet rate.

Display the Log
Decoders by
CPU usage..

Display Log
decoder by
resident memory
usage.

Display
concentrators by
SDK active
queries.

Display the list
of concentrators
and its status.
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Concentrator * Service name Provides the Displays

Session o Yo o e trend of Concentrator

Aggregation Rate Concentrator session

[Trend] session aggregation rate.
aggregation

rates to detect
high session
rates and take

necessary
action.
SDK Active * Service name Identifies the  Lists Brokers by
Queries on « Count of Active Queries Brokers by SDK active
Brokers SDK active queries.
queries.
Brokers Status * Service running on host Provides the Displays the list

Broker status.  of Brokers and

* Service type .
typ their status.

* Service version

» Aggregation status

* Average session rate
* Max session rate

* Active queries

Packet Overview Dashboard

This dashboard provides information on NetWitness Platform network data. The following table provides
information on default Visualizations available on this dashboard.

Network * Service name Identifies the ~ Displays
Decoders by « Capture rate capture rate of Network
Capture Rate Network Decoders by
Decoder to capture rate.
detect high
value and take
necessary
action.
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Network
Decoders by
Capture Drop

Network
Decoders by CPU
Percentage

Network
Decoders by
Resident Memory
Usage

SDK Active
Queries on
Concentrators

Concentrators
Status

 Service name

* Capture drop percentage

* Service name
* CPU usage

 Service name

* Resident memory usage

 Service name

* Count of active queries

* Service running on host

* Service type

* Service version

» Aggregation status

* Average session rate

» Max session rate

* Active queries

Identifies the
capture drop
rate of
Network
Decoders to
detect drop
rate and take
necessary
action.

Identifies the
Network
Decoders by
CPU usage to
detect high
usage and take
necessary
action.

Identifies the
Network
Decoders by
resident
memory usage
to detect high
usage and take
necessary
action.

Identifies the
concentrators
by SDK active
queries.

Provides the
Concentrator
status.

Displays
Network
Decoders by
capture drop.

Displays
Network
Decoder by
CPU used.

Displays
Network
Decoder by
resident memory
usage.

Displays
Concentrators
by SDK active
queries.

Displays the list
of Concentrators
and their status.
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Concentrator * Service name Provides the Displays the
Session . o Yo o e trend of trend of
Aggregation Rate Concentrator concentrator
[Trend] session session
aggregation aggregation rate.
rate to detect
high value and
take necessary
action.
SDK Active * Service name Identifies the ~ Display the
Queries on « Count of active queries Brokers by quker by SDK
Brokers SDK active active queries.
queries.
Brokers Status * Service running on host Provides the Displays the list
« Service type Broker status.  of brokers and
] ) its status.
* Service version
» Aggregation status
» Average session rate
* Max session rate
* Active queries
Analysis Dashboard

This dashboard provides details about Reporting Engines on Primary UI or Analyst UI. The following
table provides the information on default Visualizations available on this dashboard.

Reporting Engine ¢ Hostname Provides the Displays the
Rule Query o Teled] il Greaiiied status of the queries executed
Executions ) queries by Reporting
* Cancelled rule execution executed by Engine.
* Active rule execution Reporting
. Engine to
* Total rule execution detect any
deviations on
time.
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Reporting Engine
Reports
Executions

Reporting Engine
Alerts Execution

Reporting Engine
Charts Executions

Reporting Engine
Disk Usage

Unassigned Open
Incidents

* Hostname

* Failed in last hour

* Running more than one hour
* Cancelled in last hour

* Output actions failed in last hour

* Enabled alerts

* Execution failed

* Execution skipped in las 10 minutes
* Running alerts

* Output actions failed in last 10 minutes

« Hostname
» Enabled charts
» Execution failed

» Execution cancelled in last 10 minutes

* Disk Used
* Total disk space

Count of unassigned open incidents

Provides the
status of the
reports
executed by
Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
alerts generated
by Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
charts executed
by Reporting
Engine to
detect
deviations on
time.

Provides the
disk usage by
Reporting
Engine to
detect any
deviations high
usage and take
necessary
action.

Identifies
unassigned
incidents to
assist
Administrator
to take
necessary
action.

Displays the
Reporting
Engine reports.

Displays the
Reporting
Engine alerts.

Displays
Reporting
Engine charts.

Displays the
disk used by
Reporting
Engine.

Displays the
unassigned
incidents.
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Incidents Sent to
Archer

Endpoint Dashboard

Count of incidents sent to archer

Provides

statistics on the
incidents sent

to Archer to
assist

Administrator

to take
necessary
action.

Displays the
incidents sent
Archers.

This dashboard provides information on NetWitness Endpoints and agents installed on Endpoints. The
following table provides information on default Visualizations available on this dashboard.

Endpoint Server
to Agent
Communication
Queued

Endpoint Server
to Agent
Communication
Rejected Count

Endpoint Agent
Overview

» Service name

* Count of
queued request
to Agent

e Service name

* Count of
rejected request
to agent

¢ Hostname

« Total active
agents

* Active
advanced

* Active insights
agents

* Active
advanced
windows agents

e Active
advanced linux
agents

e Active
advanced mac
agents

Provides an overview of the queued agent
communication to the Endpoint Server to
identify any issues around the queued
communication.

Provides an overview of rejected agent
communication to the Endpoint Server to
identify any issues related to the rejected
count.

Provides an overview of Endpoint Agents.

Displays the
queued request to
agent.

Displays the
rejected request
to agent.

Displays list of
agents and its
details.
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Relay Servers
Overview

Files Count by
File Status

Files Count by
Certificate Status

¢ Hosts

* Total relay
servers

» Agents
communicated
via relay server

e Agents
communicated
in last two days
via relay server

¢ Count of
blacklisted files

* Count of
graylisted files

¢ Count of
netural file

¢ Count of
whitelisted files

¢ Count of
blacklisted
certificates

* Count of gray
listed certificates

e Count of
neutral
certificates

e Count of
whitelisted
certificates

Provides an overview of the Relay Servers.

Provides an overview of file status by
count to assist an Administrator on the
overall statistics of Endpoint actions on
files.

Provides an overview on certificate status
to assist an Administrator to take necessary
action.

Displays the
Relay server
details.

Displays the file
count of file
statuses.

Displays the
count of
certificate
statuses.
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File Count by

Reputation Status

Endpoint Hosts
with Risk Score
Greater than 90

Endpoint Files
with Risk Score
Greater than 90

e Count of
unknown status

e Count of

suspicious status

¢ Count of

malicious status

e Count of
known good
status

* Count of
known status

e Count of
invalid status

Count of hosts
with risk score
greater than 90

Count of files
with risk score

Provides an overview on the reputation
status to assist an Administrator to take
necessary action.

Identifies the number of hosts with risk
score higher than 90 for immediate
attention.

Identifies the number of files with risk
score higher than 90 for immediate
attention.

Displays the
count of files
reputation status.

Displays the
count of hosts
with risk score
greater than 90.

Displays the
count of files
with risk score

greater than 90
greater than 90.

ESA Correlation Overview Dashboard

This dashboard provides health statistics and trends on the ESA deployment. The following table
provides the information on default Visualizations available on this dashboard.

You can choose the ESA host and Deployment name for the Dashboard view source using the filter.

Sessions Behind ~ Count of Provides the session behind trend for ~ Displays the count of

by Sources sessions behind the sources to take necessary actions sessions behind by
by sources. when the session behind goes higher. sources.

Sessions Rate by ~ Count of Provides the session rate trend for the  Displays the count of

Sources sessions rate by sources to take necessary actions when sessions rate by
sources. the session rate goes higher. sources.

Top Rules by Memory used ~ Provides the memory usage per rule to  Displays the top rules

Memory by rules. identify the rule with high memory based on memory

usage and take necessary action. usage.
Top Rules by CPU used by Provides the CPU usage per rule to Displays the top rules
CPU rules. identify the rule with high CPU usage  based on CPU usage.

and take necessary action.
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ESA Correlation  Resident Provides resident memory usage trend  Displays the trend of

Resident Memory memory usage. to be able to detect high usage and ESA correlation

Usage take necessary action. resident memory
usage.

ESA Correlation  CPU usage. Provides CPU usage trend to detect Displays the trend of

CPU Usage high usage and take necessary action.  ESA correlation CPU
usage.

ESA CR - Event  Event rate of Identify the event rate by each Displays the trend of

Rate by each ESA deployment under ESA Correlation to  ESA correlation event
Deployments correlation detect high usage and take necessary rate of each
deployment. action. deployment.

Logstash Input Plugin Dashboard

The Logstash Input Plugin dashboard provides insight on Logstash event source and the NetWitness
Input Plugin.

Prerequisites

e You must install the New Health and Wellness. For more information, see New Health and Wellness

e You must ensure to download the Logstash Input Plugin Dashboard from RSA Live. For more
information, see Advanced Configurations

The following table provides the information on default Visualizations available on this dashboard.

Logstash Inactive Pipelines e Inactive pipeline Provides the ~ Displays the
L summary of  total number of
e Total number of Pipeline - tive R
pipeline. pipeline.
Logstash Inactive Sources  Inactive sources Provides the  Displays the

Logstash Incoming Rate

Logstash Outgoing Rate

Total number of sources

Incoming rate of Logstash

event sources.

Outgoing rate of Logstash
event sources.

summary of
inactive
sources.

Provides the
trend of
incoming rate
for Logstash
event source.

Provides the
trend of
outgoing rate
for Logstash

event sources.

total number of
inactive sources.

Displays the
trend of
Logstash
incoming rate.

Displays the
trend of
Logstash
outgoing rate.
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Logstash Data Persistence

Count of persisted Logstash ~ Provides the  Displays the

Logstash Pipelines status

Sources by Input event rate

Sources by Sessions behind

Inactive pipelines

Active pieplines

Total number of pipelines

Input rate of sources

Logstash session behind

Events to consumer (Output Plugin) Output event rate

actions when
the persisted
data count
goes higher.

Provides the
status of
Logstash
pipeline.

Provides the
trend of
source input
rate to
identify any
high values
and take
necessary
action.

Provides the
trend of
Logstash
session
behind to
identify any
high values
and take
necessary
action..

Provides the
trend of
output event
rate to
identify any
high values
and take
necessary
action.

event source. trend of trend of
persisted Logstash
Logstash persisted data.
event source
to take
necessary

Displays the
status of
Logstash
pipeline.

Displays the
trend of source
input event rate.

Displays the
trend of
Logstash session
behind.

Displays the
trend of
Logstash output
event rate.
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Logstash Service Uptime

Source Status

Logstash Services by CPU Usage

Logstash Service by Resident
Memory Usage

License Usage Dashboard

Service start time
Host name

Service name

Stream status

Source host

Service type

Service version
Logstash host

Average input event rate

Average source session
rate

Average session behind

CPU usage

Service name

¢ Resident memory usage

¢ Service name

Provides the

time when the

service is
active.

Provides
overall status
of the
services. For
example,
stream status
of the
Decoder
connected
with the
Logstash.

Provides the
CPU usage
trend of the
Logstash
services to
identify any
high
utilizations
and take
necessary
action.

Provides the
resident
memory

usage trend of

the Logstash
services to
identify any
high
utilizations
and take
necessary
action.

Displays the
time when the
service is
running.

Displays the list
of all services
and its status.

Displays the
CPU utilization
trend of the
Logstash
services.

Displays the
resident memory
utilization trend
of the Logstash
services.

The License Usage Dashboard provides License usage statistics and trends on the Log Decoder, Packet
Decoder, Endpoint, UEBA, and Malware services and at aggregated levels under throughput license. It
provides an overview of the usage of all types of Throughput licenses in your deployment.

It helps you:
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o Track daily license usage for individual hosts

o Track daily usage of Throughput licenses for all the hosts in your deployment

o Download license usage reports

Prerequisites

¢ You must install the New Health and Wellness. For more information, see New Health and Wellness

¢ You must ensure to download the License Usage Dashboard from RSA Live. For more information,
see Advanced Configurations

IMPORTANT: The date shown in the user interface is set by the browser’s time zone. The user’s
browser may be different from the time zone of the Admin server host. To make a date shown in the
user interface to match the Admin server, change the time zone setting under Stack Management >
Advanced Settings. If you update the time zone under Advanced settings, it affects other DateTime
displays throughout the user interface.

The following table provides the information on default Visualizations available on this dashboard. You
can choose any host and Deployment name for the Dashboard view source using the filter.

Packets Analyzed

Packets on Disk

Logs Processed

Users Analyzed

o Usage in bytes
o Per day

Usage in bytes
e Per day

¢ Usage in bytes
e Per day

Users Analyzed
e Per day

Provides the
packet data
analyzed in
bytes for Packet
Decoder. Helps
to track daily
usage.

Provides the
amount of data
stored on the
disk daily in
bytes for the
Packet Decoder.

Helps to track
daily usage.

Provides the Log
data processed in
bytes for Log
Decoders. Helps
to track daily
usage.

Provides the
number of users
analyzed. Helps
to track daily
usage.

Displays the
packet data
analyzed daily in
bytes.

Displays the
amount of packet
data usage on the
disk daily in
bytes.

Displays the Log
data processed
daily in bytes.

Displays the
number of users
analyzed daily.
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Files Analyzed

Hosts Analyzed

Aggregate Usage -
Logs Processed

Aggregate Usage -
Packet Analyzed

¢ Usage in bytes
¢ Per day

Per day

Usage in bytes

Per day

e Usage in bytes
e Per day

Hosts Analyzed

Provides the
files analyzed in
bytes. Helps to
track daily
usage.

Provides the
number of hosts
analyzed. Helps
to track daily
usage.

Provides an
aggregated log
of data from all
the log services
under the
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Provides an
aggregated
packet of data
from all the
packet services
under the
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Displays the files
analyzed daily in
bytes.

Displays the
number of hosts
analyzed daily.

Displays an
aggregated log of
data from all the
log services daily.

Displays an
aggregated packet
of data from all
the packet
services daily.
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Aggregate Usage -
Packets on Disk

Aggregate Usage -
File Analyzed

Aggregate Usage -
Host Analyzed

e Usage in bytes
¢ Per day

* Usage in bytes
e Per day

¢ Hosts analyzed

e Per day

Provides an
aggregated
packet data
stored on the
disk from all the
packet services
under the
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Provides an
aggregated file
usage in bytes
from all the
Malware
services under
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Provides an
aggregated list
of hosts from all
the endpoint
servers under the
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Displays an
aggregated packet
data stored on the
disk from all the
packet services
daily.

Displays an
aggregated file
usage in bytes
from all the
Malware services
daily.

Displays an
aggregated list of
hosts from all the
hosts daily.
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Aggregate Usage -
User Analyzed

e Users analyzed

e Per day

Provides an
aggregated users
from all the
UEBA servers
under the
throughput
license. Helps to
track daily
usage, detect
high value, and
take necessary
action.

Displays an
aggregated users
from all the
UEBA servers
daily.
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New Health and Wellness Monitors

This topic lists the default New Health and Wellness monitors.

1. Respond Server Risk Scoring Unprocessed Alerts High Count
2. Respond Server Risk Scoring Unprocessed Alert Older Than 24 Hours
3. Respond Server Risk Scoring Transient Alerts Ignored High Count
4. Reporting Engine Shared Task Critical Utilization

5. Reporting Engine Schedule Task Pool Critical Utilization

6. Reporting Engine Rule(s) Execution Failed

7. Reporting Engine Report(s) Running > 1 hour

8. Reporting Engine Report(s) Executions Failed

9. Reporting Engine Chart(s) Execution Failed

10. Reporting Engine Available Disk < 5%

11. Reporting Engine Available Disk < 20%

12. Reporting Engine Available Disk < 2%

13. Reporting Engine Available Disk < 10%

14. NW Offline Service

15. NW Host High Swap Utilization

16. NW Host Filesystem Disk Full

17. NW Host Critical Memory Usage

18. NW Host Critical Disk Usage

19. NW Host Critical CPU Usage

20. Log Decoder Service in Bad State

21. Log Decoder Log Capture Pool Depleted

22. Log Decoder Invalid Rules Detected

23. Log Decoder Dropping > 5% of Logs

24. Log Decoder Dropping > 10% of Logs

25. Log Decoder Dropping > 1% of Logs

26. Log Decoder Database(s) Not Open
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27.
28.
29.
30.
31.
32.
33.
34,
35.
36.
37.
38.
39.
40.
41.
42.
43.
44,
45.
46.
47.
48.
49.
50.
51.
52.
53.
54.
55.

Log Decoder Capture Rate Zero

Log Decoder Capture Not Started

Endpoint Server to Agent - Incoming UDP Packets Requested
Endpoint Server to Agent - Incoming UDP Packets Rejected
Endpoint Server to Agent - Incoming UDP Packets Queued
Endpoint Server to Agent - Incoming UDP Packets Dropped
Endpoint Server to Agent - Incoming UDP Packets Delayed
Endpoint Server - Machine Persistence Failed

Endpoint Server - Inactive Machine Retention Failed

ESA Correlation - Sessions Behind on Datasources

ESA Correlation - ESA Rule High Memory Usage

ESA Correlation - ESA Rule High CPU Usage

ESA Correlation - ESA Rule Critical Memory Usage

ESA Correlation - ESA Rule Critical CPU Usage

Decoder Service in Bad State

Decoder Packet Capture Pool Depleted

Decoder Invalid Rules Detected

Decoder Dropping > 5% of Packets

Decoder Dropping > 10% of Packets

Decoder Dropping > 1% of Packets

Decoder Database(s) Not Open

Decoder Capture Rate Zero

Decoder Capture Not Started

Contexthub Server Query Response Cache Usage > 80%
Contexthub Server High Query Response Cache Usage
Contexthub Server Database High Disk Usage

Contexthub Server Database Critical Disk Usage

Contexthub Server Critical Query Response Cache Usage

Concentrator Service in Bad State
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56.
57.

58.
59.

60.
61.

62.
63.

64.
65.

66.
67.

68.

Concentrator Meta Rate Zero

Concentrator Individual Rule(s) Detected

Concentrator Database(s) Not Open
Concentrator Aggregation Stopped

Concentrator > 5 Pending Queries

Broker Session Rate Zero

Broker Service in Bad State

Broker Aggregation Stopped

Broker > 5 Pending Queries

Archiver Service in Bad State

Archiver Aggregation Stopped
Logstash offline

Logstash Persisting data
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Uninstall New Health and Wellness

To uninstall New Health and Wellness, perform the following:

1.

Take a backup of NetWitness Server host. For more information, see “Disaster Recovery (Back Up
and Restore)” topic in the NetWitness Recovery Tool User Guide.

nw-recovery-tool --export --dump-dir /some/folder --category AdminServer --
category Search

Note: If New Health and Wellness is not installed on NetWitness Server, you must take a backup
of the host on which New Health and Wellness is installed.

Make sure that the installation or upgrades are not in progress and stop the orchestration server on
NetWitness Server host:

systemctl stop rsa-nw-orchestration-server

3. Remove the New Health and Wellness service category (“Search") from the host:

a.

b.

C.

SSH to Admin server

Fetch host details where New Health and Wellness is installed using the following command:
mongo localhost/orchestration-server -u deploy admin -p <deploy admin-
password> --authenticationDatabase admin --eval 'db.host.find ({
"installedServices": /.*Search.*/i })'

Sample output

{ " id" : "56f2a90b-1£03-d09%a-fb71-42c2a93958a8", "hostname"
"10.10.10.11", "ipv4"™ : "10.10.10.11", "ipv4Public" : "", "displayName"
"adminserver", "version" : { "major" : 11, "minor" : 5, "servicePack"
0, "patch" : 0, "snapshot" : false, "rawVersion" : "11.5.2.0" 1},
"lastFailedRefreshAttempt" : NumberLong(0), "refreshAttemptDelayFactor"
0, "thirdParty" : false, "installedSerwvices" : [ "Search",
"AdminServer" ], "meta" : { "node-zero" : true }, " class"

"com.rsa.asoc.orchestration.host.HostEntity" }

Remove the "Search" from the installedServices.

IMPORTANT: Do not remove any other category names.

d.

Replace <LIST-OF-CATEGORIES-EXCEPT-SEARCH> with a comma-delimited AND double-

quoted list of all the existing installed services found earlier EXCEPT "Search":
mongo localhost/orchestration-server -u deploy admin -p <deploy admin-

password> --authenticationDatabase admin --eval 'db.host.update({ " _id"
"<hw-node-uuid>" }, {$set: {"installedServices" : [ <LIST-OF-

CATEGORIES-EXCEPT-SEARCH> ]1}})"

Example

mongo localhost/orchestration-server -u deploy admin -p netwitness --

authenticationDatabase admin --eval 'db.host.update({ " id" : "56f2a90b-

1£f03-d09%a-fb71-42c2a93958a8" }, {$set: {"installedServices" : [
"AdminServer" ]1}})"

Sample output
MongoDB shell version v4.0.19

115




System Maintenance Guide

5.

connecting to: mongodb://localhost:27017/orchestration-
server?authSource=admin&gssapiServiceName=mongodb

Implicit session: session { "id" : UUID("04e32380-347e-4b7d-a63e-
a094536d7242") }

MongoDB server version: 4.0.19

WriteResult ({ "nMatched" : 1, "nUpserted" : 0, "nModified" : 1 })

e. Make sure that the "Search" category is removed in the updated host record in the
installedServices

mongo localhost/orchestration-server -u deploy admin -p <deploy admin-
password> --authenticationDatabase admin --eval 'db.host.find({ " _id"
"<hw-node-uuid>" })"'

Example

mongo localhost/orchestration-server -u deploy admin -p netwitness --
authenticationDatabase admin --eval 'db.host.find({ " _id" : "56f2a90b-
1f03-d09%a-fb71-42c2a93958a8" })'

Note: Any inconsistencies can result in unrecoverable errors.

Sample output

{ " id" : "56£f2a90b-1£03-d0%a-£fb71-42c2a93958a8", "hostname"
"10.10.10.11", "ipv4"™ : "10.10.10.11", "ipv4Public" : "", "displayName"
"adminserver", "version" : { "major" : 11, "minor" : 5, "servicePack" : O,
"patch" : 0, "snapshot" : false, "rawVersion" : "11.5.2.0" },
"lastFailedRefreshAttempt" : NumberLong(0), "refreshAttemptDelayFactor"

0, "thirdParty" : false, "installedServices" : [ "AdminServer" ], "meta"

{ "node-zero" : true }, " class"

"com.rsa.asoc.orchestration.host.HostEntity" }

Stop the New Health and Wellness services:

systemctl stop rsa-nw-metrics-server elasticsearch opendistro-performance-
analyzer kibana

Disable the New Health and Wellness services:

systemctl disable rsa-nw-metrics-server elasticsearch opendistro-performance-
analyzer kibana

6.

Uninstall the New Health and Wellness packages using the command:

yum erase -y rsa-nw-metrics-server opendistroforelasticsearch
opendistroforelasticsearch-kibana

Note: rsa-nw-shell (installed with metrics server) is a shared package and should not be
removed.

Remove the configuration folders or files:

e /etc/netwitness/metrics-server

e /etc/netwitness/platform/elasticsearch

e /etc/netwitness/platform/nodeinfo/metrics-server

e /etc/netwitness/platform/nodeinfo/elasticsearch-open-distro
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/etc/netwitness/platform/nodeinfo/kibana-open-distro

/etc/systemd/system/rsa-nw-metrics—-server.service.d

/etc/systemd/system/elasticsearch.service.d
/etc/pki/nw/service/bootstrap/metrics-server.completed

/etc/pki/nw/service/rsa-nw-metrics—-server-cert.pem

/etc/pki/nw/service/rsa-nw-metrics—-server.chain

/etc/pki/nw/elastic

/etc/pki/nw/kibana

/var/log/netwitness/metrics-server

/var/log/kibana

/etc/collectd.d/rsa-metrics-server.conf

/etc/logrotate.d/kibana

/etc/elasticsearch

/etc/kibana

/var/lib/elasticsearch

/var/lib/kibana

/var/netwitness/elasticsearch

Start the orchestration Server on NetWitness Server:
systemctl start rsa-nw-orchestration-server

Unregister the New Health and Wellness from the installedService:

a.

b.

Find the service IDs for metrics-server, elasticsearch-open-distro, and kibana-open-distro

Note: Make sure you look for service IDs for the correct host; do not unregister elastic or
kibana on an UEBA host.

orchestration-cli-client --list-services | grep <hw-node-IP-address>

Sample output

ID=50082d04-320c-4ce2-8379-00£38ae2d1df, NAME=metrics-server,
HOST=192.168.1.2:7018, TLS=true

ID=530ff46a-8793-4e8e-be9c-742193d1705a, NAME=elasticsearch-open-distro,
HOST=192.168.1.2:9200, TLS=true

ID=4bad6ea8-e3a4-46ab-a342-34356beat65bb, NAME=kibana-open-distro,
HOST=192.168.1.2:5601, TLS=true

(other services)

Remove the service IDs returned above for metrics-server, elasticsearch-open-distro, and kibana-
open-distro (associated with New Health new Wellness host):

orchestration-cli-client --remove-service --id <metrics-server-service-
id>
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orchestration-cli-client --remove-service --id <elasticsearch-open-
distro-service-id>

orchestration-cli-client --remove-service --id <kibana-open-distro-
service-id>

c. Verify if the services are removed:

orchestration-cli-client --list-services | grep <hw-node-IP-address>

10. On all hosts, except for UEBA, stop and disable metricbeat:

1.

12.

13.

systemctl stop metricbeat

systemctl disable metricbeat

Note: For NetWitness Platform without UEBA, you can stop and disable metricbeat on all hosts
through salt:

salt '"*' cmd.run 'systemctl stop metricbeat && systemctl disable
metricbeat'

(Optional) - If you are not reinstalling New Health and Wellness (on same or other hosts), you can
also remove metricbeat package and configuration:

a. Package to uninstall;
metricbeat

b. Service configurations to uninstall:

o /etc/metricbeat
o /var/log/metricbeat
© mongo account

o systemd configuration

Refresh the New Health and Wellness host:

nw-manage --refresh-host --host-key <node-ip>

Make sure that the New Health and Wellness service is not installed or running and metricbeat
service is not active on the New Health and Wellness host.

If you are not reinstalling New Health and Wellness on another host, you must refresh UI hosts
(NetWitness Server host and Analyst UI) to update NGNIX:

nw-manage --refresh-host --host-key <node-ip>

Note: After uninstalling New Health and Wellness, if you want to install New Health and Wellness
again, see "New Health and Wellness" in the Deployment Guide.
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NetWitness issues NetWitness software version updates on a regular basis as it strives to continually
improve the product. A software version update consists of a release, service pack, or patch (including
security patch) and ancillary software on which the release, service pack, or patch depends. User guides
are provided for each software version update release, which include detailed steps for installing the
update. It is important that you download the update guide for the release from NetWitness Community
(https://community.netwitness.com/) and follow the steps described there. Additional information is
available in the "Apply Version Updates to a Host" topic in the Hosts and Services Getting Started
Guide and in System Updates Panel - Settings Tab.
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Reissue Certificates

Introduction

For a secure deployment, NetWitness has installed internal NetWitness-issued certificates such as CA
Certificate and Service certificates .

The validity for NetWitness certificates are as follows:

o CA root certificate for 11.x deployment is valid for 10 years
o CA root certificate for 10.6.x deployment is valid for 5 years

o Service certificates are valid for 1000 days

Note: The certificate expiration warning is triggered 30 days prior to expiration.

When these certificates are about to expire or have expired, you must renew and reissue the certificates
as soon as possible to avoid any issues with your NetWitness deployment.

Note: You can view the expiration details, by executing the ca-expire-test-sh script on the
NetWitness Server. For more information, see Reissue root CA security certificates on NetWitness
Platform 11.x and download the script.

CA Certificate Reissue

To renew the CA certificates, do the following:

» Before you upgrade from 10.6.x to 11.x, check the expiry and reissue those certificates. For more
information, see the Reissue root CA security certificates on NetWitness Platform 11.x.

e Ifyou are on 10.6.x , check the expiry and reissue all the certificates. For more information, see the
Reissuing security certificates on NetWitness Platform 10.6.x.

Note: If you have Windows Legacy Collectors (WLC) in your deployment, renew the CA certificate
of the WLC after renewing the CA certificate of the NetWitness Admin Server.

Service Certificate Reissue

To renew the Service certificates, do the following:

e [f your hosts are on NetWitness Platform 11.3 or later, you must use the cert-reissue script. For
more information, see the Reissuing Service Certificate .

o If your hosts are on 11.1.x or 11.2.x, you must upgrade the NetWitness Platform to 11.3 or later and
run the cert-reissue script.
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Note: If you have a host that is decommissioned or plan to remove, do not renew the certificate for
that host.

Reissuing Service Certificate

You can reissue service certificates in the following two ways.
e All at once
Reboot NW Server host after the cert-reissue --host-all command completes.
e One at a time
Reissue the NW Server host certificates first, restart the host, then reissue each component host.

IMPORTANT: If you are reissuing certificates for each host individually (one at a time), you must
reissue the certificate for the NW Server host before you can reissue certificates for any other host.
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When to Use the --host-all Argument

Use the cert-reissue --host-all command string if you have a large number of hosts. Make sure
that:

e All your hosts are running 11.3.0.0 or later.
* All your hosts are online.

e The NW Server host run time services are running,.

cert-reissue Arguments and Options for All Hosts

The following tables lists the argument you can use to reissue certificates for all hosts at one time. See
Troubleshooting Cert-Reissue Command for additional options you can use with Customer Support to
troubleshoot errors.

pgmens Joescipuen

--host-all Reissues certificates for all hosts at one time applying system health checks and
restarts services.

Note: If even one host is not online, this command fails. If you have numerous
hosts in your deployment, make sure that all hosts are up and running.

Caution: Make sure you do not run this argument on a node or host that you plan to remove or
decommission.
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When to Use the Individual Host Argument (--nost-xey <1p, 15,

hostname or display name of host>)

The cert-reissue --host-key <ID, IP, hostname or display name of host> command
reissues a certificate for an individual host. You may want to reissue certificates for an individual host if
you have a small number of hosts.

Make sure that:

e FEach host is running 11.3.0.0 or later.

* Each host is online.

e The NW Server host run time services are running

¢ You reissue certificates for the NW Server host first.

Note: You must run the command for the NW Server host first and reboot that host before you run the
command for each component host.
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Reissuing Certificates for All Hosts Except Windows Legacy
Collection (WLC) host

Use the cert-reissue command to reissue certificates for all hosts except the WLC host with the
following procedures.
Running the Cert-Reissue Command for All Hosts

1. SSH to the NW Server host.

2. Submit the appropriate command string.
cert-reissue --host-all

Running the Cert-Reissue Command for an Individual Host

1. SSH to the NW Server host.

2. Submit the appropriate command string:
cert-reissue --host-key <ID, IP, hostname or display name of host>

Reissuing Certificates for a WLC Host

You must use the wlc-cli-client utility to reissue certificates for a WLC host (you cannot use the
cert-reissue command). You also need to specify a number of WLC identification parameters with
this utility.

Note: The certificates for a Windows Legacy Server host are stored in the following directories on the
host.

C:\ProgramData\netwitness\ng\logcollector cert.pem
C:\ProgramData\netwitness\ng\logcollector dh2048.pem

Th validity period of WLC certificates can range from 2 to 20 years. If you rename or remove the files
and restart NwLogCollector Service, NetWitness regenerates them.
/ssl/truststore.pem - is no longer used in 11.x

Every reissue of a certificate on the Windows Legacy server creates a new private key.

Reissue Certificates 124



System Maintenance Guide

To reissue certificates on a WLC host.

1. SSH to the NW Server host.

2. Submit the following command string.
wlc-cli-client --cert-renew --host 10.129.43.13 --port 50101 --use-ssl
false --username <nwadmin service account> --password <'nwadmin service
account password'> --ss-username <deploy admin> --ss-password <'deploy

admin password'>

Note: nwadmin service account is the WLC rest UI User and 'nwadmin service account
password' is the WLC rest Ul password.

Successful Reissue Summary Report

When you run cert-reissue --host-all ,the following summary report will be displayed if all
hosts are online, all run time services are running, and all hosts on version 11.4.0.0 or higher.

Unsuccessful Reissue Summary Reports

You must contact Customer Support (https://community.netwitness.com/t5/support-information/how-to-
contact-netwitness-support/ta-p/563897) to troubleshoot problems. You know there is a problem if any
<host-id> does not return a SuccessStatus. Success indicates that certificates were reissued for a

host. The following examples illustrate unsuccessful reissues.

Reissue Failed for Host and Aborted Command

The following three examples illustrate the failure of certificate reissuing for any hosts.
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e e e e e +
| Host | Status | Me=sage

4 4 4 4

I<host-id>| <IP-address> |IFailed! |version <version-earlier-than-11.3.0.0> not supported|
|<host-id>| <IP-address> |IFailed! |version <version-earlier-than-11.3.0.0> not supported|
I<host-id>| <IP-address> IN/A I[ Skipped... ]

|<host-id>| <IP-address> IN/A I[ Skipped... ] |
I<host-id>| <IP-address> IN/A I[ Skipped... ]

4 4 4 4 4

Reissue Certificate Partially Executed

The NW Server Host certificates were reissued but failed to properly distribute the reissued certificates
to one or more component hosts.

4 + :

| | Host

+ + +

| <host-id>| <IP-address>

| <host-id>| <JIP-address>

e o +

$-——————- e e e ettt +
| | Host | Status | Message |
et e st pommmm o |
| <host-id>| <IP-address> |Partial |Reissue completed, triggers failed |
| <host-id>| <IP-address> IN/5 I[ Skipped.. ] |
|<host-id>| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A ] |
|<host-id>| <JIP-address> IM/A | |
+ + + + +

Reissue Certificates
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Display System and Service Logs

NetWitness provides views into system logs and service logs. When you view service logs, you can

select messages for the service or host.

View System Logs

1. Goto
2. In the options panel, select System Logging.

(Admin) > System.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

5o System Logging
Updates )
Realtime Historical Settings
Licensing
ALL v | Keywords Search
Email

Timestamp Level Message
Global Notifications
2023-10-16T12:07:08.000  INFO Checking for CMS Cache Updates Started at [ 2023-10-16 12:07:08 UTC]

Legacy Notifications

2023-10-16T12:35:52.092  INFO  Initiating import of live rules!
I System Logging 2023-10-16T12:35:52.094  INFO Initiating import of live rules!
Global Auditing 2023-10-16T12:
Jobs 2023-10-16T12:35:52.161  ERROR  Unable to deserialize rule /var urce-server/resources/.
) ‘ 2023-10-16T12:50:34.108  INFO  Imported meta types and meta entities from endpoint: ¢
Live Services
2023-10-16T12:50:34.346  INFO  Imported meta types and meta entities from endpoint
YR iEgrEien 2023-10-16T12:50:34.538  INFO  Imported meta types and meta entities from endpoint:
Context Menu Actions 2023-10-16T12:50:34.692  INFO Imported meta types and meta entities from endpoint:
Investigation 2023-10-16T12:51:54.233  INFO  LicensingMiscConfiguration changed by admin

HTTP Proxy Settings
NTP Settings

Dashboard Settings

Display Service Logs
To display NetWitness service logs:

QA
1. Goto (Admin) > Services.

2. In the Services list, select a service.

admin v

:52.161 ERROR  Failed to save rule to mongo - User added to admin group then SIGHUP detected: java.lang.lllegalArgumentException: Rule with name 'User added to admin group then...

176.esaa and import into ESA: com.rsa.smc...
tloghybrid1 - Concentrator
hybrid - Concentrator
atloghybrid1 - Log Decoder

»ackethybrid - Decoder
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3. In the Actions column, select View > Logs.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

% Change Service | I endpointloghybrid1 - Concentrator | Logs @

System Logging

Realtime Historical

ALL v Keywords Concentrator v Search
Timestamp Level Message
2023-10-16T12:55:08.000  DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:55:34.000  DEBUG has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:56:08.000  DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:56:34.000  DEBUG ! has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:57:08.000  DEBUG has received a ping command, a reply of & bytes was sent
2023-10-16T12:57:34.000  DEBUG has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:58:08.000  DEBUG has received a ping command, a reply of & bytes was sent
2023-10-16T12:58:21.000  INFO Accepting connection from trusted peer with subject name C = US, ST = VA, L = Reston, O = RSA, OU = NetWitness, CN = rs¢

2023-10-16T12:58:21.000  DEBUG  Trusted user admin has been granted QT: 60 ST: 0 QP: QPri: 20

2023-10-16T12:58:21.000  AUDIT  User admin (session 3eoe_s, 10 1) has logged in

Filter Log Entries

To filter the results shown in the Realtime tab:

1. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

2. (Optional) For service logs, select the Service: host or service.
Click Filter.

The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Realtime tab Log list provides the summary information of a log entry. To view
complete details:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and Message,
is displayed.
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Log Message

Timestamp 2019-02-01T21:46:30.000
Logger Mame Ping

Thread

Level DEBUG

Message has received a ping command, a reply of 51 bytes was sent

2. After viewing, click Close.
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Access Reporting Engine Log File

All Log Files

The Reporting Engine stores the following logs in the rsasoc/rsa/soc/reporting-engine/log
directory:

e Current logs in the reporting-engine. log file.
e Backup copies of previous logs in the reporting-engine.log. * file.
» All UNIX script logs in the files that have the following syntax: reporting-engine.sh

timestamp.log (for example, reporting-engine.sh 20120921.109).

The Reporting Engine rarely writes command line error messages to the rsasoc/nohup. out file.

Upstart Logs

The Reporting Engine appends the log messages and output written by upstart daemon and the
commands used to start the reporting-engine to the /var/log/secure directory.

An upstart log file is a system log file, which means that only the root user can read it. The Reporting
Engine generates log files, retains backup copies of previous log files, stores UNIX script log files, and
appends upstart log files to another directory.
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Search and Export Historical Logs

NetWitness provides a searchable view of the NetWitness log or the service log in a paged format. When
initially loaded, the grid shows the last page of the log entries for the system or the service. You can
export logs from the current view.

Display the Historical System Log
To display the historical log for the system:
A
1. Goto (Admin) > System.
2. In the options panel, select System Logging.
The System Logging panel is opened to the Realtime tab by default.

3. Click the Historical tab.
A list of historical logs for the system is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

[i® System Logging
Updates )
Realtime Historical Settings
Licensing
ALL v | Keywords Search
Email

Timestamp Level Message v
Global Notifications

2023-10-16T12:07:08.000  INFO Checking for CMS Cache Updates Started at [ 2023-10-16 12:07:08 UTC]
Legacy Notifications

2023-10-16T12:35:52.092  INFO  Initiating import of live rules!
I System Logging 2023-10-16T12:35:52.094  INFO Initiating import of live rules!
Global Auditing 2023-10-16T12:35:52.161  ERROR  Failed to save rule to mongo - User added to admin group then SIGHUP detected: java.lang.lllegalArgumentException: Rule with name 'User added to admin group then...
Jobs 2023-10-16T12:35:52.161  ERROR  Unable to deserialize rule /var/lib/netwitness/source-server/resources/. 176.esaa and import into ESA: com.rsa.smc.
. 2023-10-16T12:50:34.108  INFO  Imported meta types and meta entities from endpoint: ¢ tloghybrid1 - Concentrator
Live Services
2023-10-16T12:50:34.346  INFO  Imported meta types and meta entities from endpoint: hybrid - Concentrator
URL Integration .
2023-10-16T12:50:34.538  INFO  Imported meta types and meta entities from endpoint: Atloghybrid1 - Log Decoder
Context Menu Actions 2023-10-16T12:50:34.692  INFO Imported meta types and meta entities from endpoint: ackethybrid - Decoder
Investigation 2023-10-16T12:51:54.233  INFO  LicensingMiscConfiguration changed by admin

HTTP Proxy Settings
NTP Settings

Dashboard Settings

Display a Historical Service Log
To display the historical log for services:

Q
1. Select (Admin) > Services.

2. Select a service.

3. In the Actions column, select View > Logs.
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The service logs view is displayed with the Realtime tab open.
4. Click the Historical tab.
A list of historical logs for the selected service is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

& Change Service | B3 adminserver - Broker | Logs

System Logging

Realtime Historical

Start Date {# End Date [ ALL v | Keywords Broker v Search 7 Export
Timestamp Level Message
2023-10-16T12:45:22.000 DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:46:12.000  DEBUG ) has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:46:22.000 DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:47:12.000  DEBUG ) has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:47:22.000  DEBUG ) has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:48:12.000  DEBUG has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:48:22.000  DEBUG - =7 has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:49:12.000  DEBUG i has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:49:22.000  DEBUG | has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:50:12.000  DEBUG ) has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:50:22.000  DEBUG ) has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:51:12.000  DEBUG ) has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:51:23.000 DEBUG ' has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:52:13.000  DEBUG ) has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:52:23.000 DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:53:13.000  DEBUG has received a ping command, a reply of 51 bytes was sent
2023-10-16T12:53:23.000  DEBUG has received a ping command, a reply of 6 bytes was sent
2023-10-16T12:54:13.000  DEBUG has received a ping command, a reply of 51 bytes was sent had
(| page 200 of200 C Displaying 9951 - 10000 of 10000

Search Log Entries

To search the results shown in the Historical tab:
1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.

2. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

3. (Optional) For service logs, select the Service: host or service.

4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To display all
the details for a log message:
1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and Message,
is displayed.
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Log Message

Timestamp 2019-02-01T21:46:30.000
Logger Mame Ping

Thread

Level DEBUG

Message has received a ping command, a reply of 51 bytes was sent

2. After viewing, click Close.

Page Through Log Entries

To peruse the different pages of the list, use the paging controls on the bottom of the grid as follows:
e Use the navigation buttons

e Manually type the page number you want to view, and press ENTER.

Export a Log File

To export the logs in the current view:

Click Export, and select one of the drop-down options: CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example,
a NetWitness system log exported with comma-separated values is named UAP log export CSV.txt,
and a host log exported with tab-separated values is named APPLIANCE log export TAB.txt.

133



Maintain Queries Using URL Integration

A URL integration provides a way to represent the bread crumbs, or query path, you take when actively
investigating a service in the Navigate view. You do not need to display and edit these objects often.

A URL integration maps a unique ID that is automatically created each time you click on a navigation
link in the Navigation view to drill into data. When the drill-down completes, the URL reflects the query
IDs for the current drill point. The Display Name is displayed in the bread crumb in the Navigate view.

The URL Integration panel provides a list of queries and allows users who have the proper permissions
to modify this underlying source of data and analyze the query patterns of other users of the NetWitness
system. Within the panel, you can:

e Refresh the list.
e Edit a query.
e Delete a query.

¢ Clear all queries in the list.

Caution: After a query has been removed from the system, any Investigation URLSs that included the
ID of that query will no longer function.

Edit a Query

Q
1. Goto (Admin) > System.

2. In the options panel, select URL Integration.

URL Integration

= 4 | Orefresh . Clear

D Display Name

o nwappliance11639

4 gwu.edu
10.100.33.1

6 ip.src="127.0.0.1
rep.srcport = ‘54004
8 nwappliance23512
9 gwu.edu

10 COTHER

Ooooooooogooolg

1 rest dam

Page |1 of1 |

1 threat.category = 'spe...

3 Content = 'SpeCrum.a..

Query

did = 'nwappliance 11639
threat.category = 'spectrum
content = 'spectrum,consume’
conent = 'specrum.analyze’
domain.dst ="gwu.edu’
ip.sre=10.100.33.1
ip.sre=127.0.0.1

rep.sroport = 54004

did = 'nwappliance23912’
domain.src = gwu.edu’
service =0

alerr = 'test dom’

Ic

Username
admin
admin
admin
admin
admin
admin
admin
admin
admin
admin
admin

admin

3. Select the row in the grid and either double-click the row or click =—I.

The Edit Query Dialog is displayed.

When Created ~
Tue Jul 11 2017 06:40:09 +00:00 (UTC)

Tue Jul 11 2017 08:

35:33 +00:00 (UTC)
33 +00:00 (UTQ)

Tue Jul 11 2017 08:46:00 +00:00 (UTC)

Tue Jul 11 201 :28 +00:00 (UTC)

Wed Jul 12 2017 08:48:56 +00:00 (UTC)
Wed Jul 12 2017 09:33:24 +00:00 (UTC)

Wed Jul 12 2017 08:37:44 +00:00 (UTC)

Wed Jul 12 2017 11:09:05 +00

Thu Jul 13 2017 13:58:52 +00:00 (UTC)
Fri Jul 14 2017 04:56:50 +00:00 (UTC)

Fri Jul 14 2017 09:5%:43 +00:00 (UTC)

00 (UTC)

Displaying 1-120f 12

Maintain Queries Using URL Integration
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Display Name

Query

content = 'spectrum.consume’

content = 'spectrum.consume’

Cancel

Save

4. Edit the Display Name and the Query, but do not leave either field blank.

5. To save the changes, click Save.

Delete a Query

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

To remove a query from NetWitness entirely:

1. Select the query.
2. Click =

A dialog requests confirmation that you want to delete the query.

3. Click Yes.

Clear All Queries

To clear all queries from the list:

* Click & Clear

The entire list is cleared.

Use a Query in a URI

URL integration facilitates integrations with third-party products by allowing a search against the
NetWitness architecture. By using a query in a URI, you can pivot directly from any product that allows
custom links, into a specific drill point in the Investigation view in NetWitness.

The format for entering a URI using a URL-encoded query is:

http://<nw host:port>/investigation/<serviceld>/navigate/query/<encoded
query>/date/<start date>/<enddate>

where
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e <nw host: port> is the IP address or DNS, with or without a port, as appropriate (ssl or
not). This designation is only needed if access is configured over a non-standard port through a
proxy.

* <serviceId> is the internal Service ID in the NetWitness instance for the service to query
against. The service ID can be represented only as an integer. You can see the relevant service
ID from the url when accessing the investigation view within NetWitness. This value will
change based on the service being connected to for analysis.

* <encoded query> is the URL-encoded NetWitness query. The length of query is limited by
the HTML URL limitations.

* <start date> and <end date> define the date range for the query. The format is <yyyy-
mm-dd>T<hh :mm>. The start and end dates are required. Relative ranges (for example, Last
Hour) are not supported in this version. All times are run as UTC.

For example:
http://localhost:9191/investigation/12/navigate/query/alias%20exists/dat
e/2018-09-01T00:00/2018-10-31T00:00

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the servicelD is identified as
2.

All activity on 03/12/2018 between 5:00 and 6:00 AM with a hostname registered

e Custom Pivot: alias.host exists

e https://192.168.1.10/investigation/2...13-03-12T06:00

All activity on 3/12/2018 between 5:00 and 5:10 PM with http traffic to and from IP address 10.10.10.3
e Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)

* Encoded Pivot Dissected:
e service=80 => service&3D80
e ip.src=10.10.10.3 => ip%2Esrc%$3D10%2E10%2E10%2E3
e ip.dst=10.10.10.3 => ip%2Esrc%$3D10%2E10%2E10%2E3

e https://192.168.1.10/investigation/2...13-03-12T17:10

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP source
(src) and destination (dst) is used for this integration point. If leveraging a third-party application for
integration of this feature, it is possible to reference those without encoding applied.
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Manage the deploy _admin Account

The depploy admin account is used on every NetWitness host, and must be kept in sync between all
hosts. Prior to 11.4.1, the process to change the deploy admin account required administrators to log
into every NetWitness host and run the /opt/rsa/saTools/bin/set-deploy-admin-password
script on each system. Starting with 11.4.1, the deploy admin password is centrally managed with the
nw-manage script on the NW Server. nw-manage script execution updates the password on all
NetWitness component hosts that use the deploy admin account. The nw-manage script output
displays the password update results for each host. If a NetWitness component host is down or
unreachable for any reason, the nw-manage script provides an additional option to synchronize the
deploy admin password on the previously unresponsive host with the NW Server when that host
becomes available again.

The following procedures describe how to change the deploy admin password for all hosts in your
environment, for hosts in a mixed version environment, and for hosts that are unavailable during the first
attempt to change the deploy admin password.

Change the deploy_admin Account Password

1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --update-deploy-admin-pw
A prompt for the new password is displayed.

3. Enter the new password.

Change the deploy_admin Account Password in a Mixed

Version Environment

If you are operating in a mixed version environment (for example, NW Server is on a newer version
(greater than or equal to 11.4.1) and the NW component hosts are still on an older version of NetWitness
(less than 11.4.1), the nw-manage script prompts you to run the /opt/rsa/saTools/bin/set-
deploy-admin-password script on those older component hosts first. After the hosts on the older
versions are updated, you rerun the nw-manage script on the NW Server with the --skip-version-
checks argument.

1. On each component host that is on an older version, reset the deploy admin password by running
the following command:
/opt/rsa/saTools/bin/set-deploy-admin-password
This resets the deploy admin password on all the component hosts with the older versions.

2. Log in to the NW Server host using SSH or the NwConsole and run the following command:
nw-manage --update-deploy-admin-pw --skip-version-checks
A prompt for the new password is displayed.

3. Enter the new password.
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Change the deploy_admin Account Password for a

Component Host that is Unavailable

If a component host is down or otherwise unreachable the first time you run the nw-manage script, it is
identified as skipped in the nw-manage --update-deploy-admin-pw output. When the host is back
online, its deploy admin password must be synchronized with the NW Server.

To synchronize the previously unreachable host with the NW Server:
1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --sync-deploy-admin-pw --host-key <ID, IP, hostname or display

name of host>
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NW Server Host Secondary IP Configuration

Management

Starting with 11.5, the NW Server has a new attribute, secondary IP that facilitates automated
failover and IP address change management.

Note: For clarification, this attribute is simply another metadata host attribute that is specific to the
NW Server; it does NOT describe, nor is it related to, a secondary network interface on the NW
Server.

In the failover use case, the active NW Server has a secondary IP value that matches the standby
server IP address. This secondary IP value is known to the other NetWitness hosts, and when the
primary NW Server fails to respond in a timely fashion due to an IP address change of the active NW
Server, or when there is a scheduled failover to the NW standby server, the other NetWitness hosts and
services are configured to automatically attempt to connect to the secondary IP address, which in this
case is the NW standby server.

The secondary IP attribute is also used for NW Server IP address change and for the NW standby
server. The NW Server IP address change procedures automatically populate the secondary IP address of
the NW Server to the new IP address and propagate that information to the other NetWitness hosts and
services. Then, similar to the failover use case when NW Server’s original IP address is no longer valid
and the new IP address is active, the NetWitness hosts and services automatically switch to the new
secondary [P address, which becomes the new NW Server IP address. If the NW standby server’s IP
address is changed, the secondary IP attribute on the NW Server needs to be updated with the new
NW standby server IP address.

The secondary IP attribute is managed primarily with automated processes, but there are use cases
that require manual management of the NW Server host secondary IP attribute, such as an IP address
change of the NW standby server or a one-time registration during an NW standby server upgrade.

The secondary IP is managed using the nw-manage script on the NW Server:

e To add a secondary IP address to the NW Server host, run the following command:
nw-manage --add-nws-secondary-ip --ipv4 <secondary ip address>

o To remove a secondary IP address from the NW Server host, run the following command:
nw-manage --remove-nws-secondary-ip --ipv4 <secondary ip address>

e To view secondary IP addresses assigned to the NW Server host, run the following command:
nw-manage --get-nws-secondary-ip

For information about changing IP addresses, see Change Host Network Configuration.

For information about failover procedures, see "Warm Standby NW Server Host" in the Deployment
Guide for NetWitness Platform.
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Change Host Network Configuration

This topic describes how to change the network configuration for NW Server and component hosts in
your environment. The instructions in this section assume that all the hosts in your environment are
on version 11.7 or later

Note: If your NW Server is referenced by other NW hosts that use a Network Address Translation
(NAT) IP address, and you want to change the NAT IP address, you must remove the old NAT IP
address and add the new NAT IP address using the instructions provided in NW Server Host
Secondary IP Configuration Management.

This section contains the following procedures:

¢ Change Host Network Configuration

¢ Change Network Configuration for Warm Standby (Secondary) Server

¢ Reconnecting Component Hosts with NW Server Hosts

Note: Changing [Pv6 addresses is not supported in version 11.7 and later.

Change Host Network Configuration

Use this procedure to update the network configuration for any host type in your environment for version
11.7 or later.
To change the network configuration of a host:

1. From the console, log in to the host for which you wish to change the network configuration.

Note: If you are updating the IP address of your NW Server and you are using DHCP, run the
following command before you go to step 2:

nw-manage --add-nws-secondary-ip --ipv4 <new DHCP allocated ip address of
NW Server>

2. Run the following command:
nwsetup-tui
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The nwsetup-tui license dialog is displayed.

By clicking "Accept”™, vou (the "Customer”) hereby agree, on behalf of your
company or organization, to be bound by the terms and conditions of the
End User License Lgreement (the “EULA™) located at
https://www.rsa.com/content/dam/rsa/PDF/shrinkwrap-license—combined.pdf
with R5a Security LLC (“R5A", or appropriate affiliate entity in the
relevant jurisdiction). In addition, Customer hereby agrees and
acknowledges that, if Customer chooses to host its data with any third
party or in a public cloud environment, RS5SA has no responsibility for the
sStorage or protection of any Customer data or for any associated security
breach notifications. The terms herein and in the EULA shall supersede any
relevant terms in any other agreement between the Customer and RSA. For
customers of the RSA NetWitness® products, all data analyzed in connection
herewith shall be at a cost to Customer based on R5A"s then current

[¥s]
(R ]
o

3. Click Accept. The NetWitness Platform Update Configuration dialog is displayed:

HetWitness Platform 11.6 Update Configuration -
A previous NetWitness configuration has been
detected on this node. You may re-run the
installation or =select a specific
configuration area to update.

1 Reinstall
! Update Network Confi

Static IP Comfiguratio
Use DHCP
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5. Select option 1, Static IP Configuration, and click OK.
The NetWitness Platform Network Configuration Static IP configuration dialog is displayed.

NetWitness Platform Network Configuration
Static IP configuration

IP Address '
Subnet Mask I
Default Gateway s
Primary DNS server [
Secondary DNS Server [N
Local Domain Name I

< OK > < Exit >

6. Enter the new network and DNS configuration and click OK.
The new network and DNS configuration is applied to the host.

Note: While changing the IP address, the user interface may become temporarily unavailable while
the update is in process. The user interface will come back up shortly.

Note: After upgrading the NW Server host or a component host to 11.7 or later version, review the
contents of the /etc/hosts.user file for any obsolete host entries. The /etc/hosts.user file
contains system and user-generated entries that are not managed by NetWitness Platform. However,
entries from /etc/hosts.user are merged with NetWitness Platform-generated host mappings to
create and update /etc/hosts. To avoid conflicts with NetWitness Platform-generated mappings, and
to avoid generating connectivity errors resulting from an IP address change, NetWitness recommends
that you remove any entries in /etc/hosts.user that include a non-loopback IP address of a
NetWitness Platform host. After updating /etc/hosts.user, you must refresh the system by
running the following command:

nw-manage --refresh-host --host-key <ID, IP, hostname or display name of
host>

Note: While changing a host's IP address or during failover, component hosts can become
disconnected from NW Server hosts. Follow these steps to reconnect a host system to its NW Server
system.

1. Log in to the component host using SSH or the console.

2. Run the command nw-manage --override-nws-ip --ipv4 <current IP address of
the NW Server.

When this command completes, the component host is reconnected to the NW Server at the specified
IP address.

Follow the steps in the sections that apply to your environment.
* SSO

e Reporting Engine

* UCE

* PAM
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e ECAT
¢ RSA NetWitness Orchestrator (By Demisto)

* Audit Logging
e Health and Wellness

e Malware Analysis

e Windows Legacy Collection

SSO

Update Configuration for Single Sign-On

Note: You must disable SSO configurations ONLY when NW Server IP is changed.

When the host network is configured with a new IP address, the SSO configurations also must be
updated.

To do this:

1. Disable the SSO configuration using nw-shell after failover from new IP.
To resolve this issue you must disable SSO manually, using the following commands:

a. SSH to admin server node.
b. Connect to nw-shell.
c. Connect to admin server service using the connect --service admin-server command.
d. Log in to admin server using the 1ogin command.
e. Enter the admin username and password.
f. Execute the following commands:
e cd /rsa/security/authentication/web/saml/sso-enabled
e set false
e logout

e exit
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e systemctl restart rsa-nw-admin-server

2. Change the host IP address to the new IP.

3. Generate the new metadata and reupload it in ADFS. For more information, see the "Configure
SAML 2.0 provider settings for portals" topic in the Microsoft documentation.

For more information, see the "Troubleshooting" topic in the System Security and User Management
Guide.

Reporting Engine

Update Configuration for Reporting Engine

Note: You must update the Reporting Engine configurations ONLY when NW Server IP is changed.

When the host network is configured with a new IP address, you must update and verify the Reporting
Engin configurations. The hostname for NetWitness configurations under the Output Actions must be
updated with the new IP.

To manually configure the new IP, perform the following steps:

1. Log in to NetWitness Platform.

: :
2. Navigate to K&l (Admin) > Services > Reporting Engine > View > Config.
3. Click the Output Actions tab.
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4. Add the new IP address in the Hostname field.
5. Click Apply.

UCF

To enable UCF to communicate with NetWitness Platform:

1. On the UCF server, execute the runConnectionManager.bat file (the same file that is used for
adding connection details).

2. Select Option #2, Edit endpoints.
3. Select the NW Server connection from the options that are displayed.

4. When you are prompted for Host Address (the old IP address is shown in parentheses) enter the new
IP address.

Note: Do not change any other setting.

PAM

If you have PAM configured, after the failover, you must configure the system again using the
instructions in the "Configure PAM Login Capability" topic in the System Security and User
Management Guide. Go to the NetWitness All Versions Documents page and find NetWitness Platform
guides to troubleshoot issues.

ECAT

Update the following services:

e Incident Message Broker

e NetWitness Suite

e Syslog Server Settings

Incident Message Broker

1. Log in to the NetWitness Endpoint user interface and go to Configure > Monitoring and External
Components Configuration > Incident Message Broker.
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Update the server Hostname and IP Address to the current active server and test the settings.

. - o x
..
=
= a Incident Message Broker
) [saone - API SE:T:;;;%?!:::\‘nmg‘ % @ @ Version Info  Last Scan User N
4400 6/17/2019 2:56:12 ... V, Vigy
NetWitness Suite Connection 4400 6/27/201912:18:19...
Server Hostname/IP : e
Port : 5671
Test Settings Edit
* 2 items total 4 »
Downloads (UTE:0800] Pacific Time (US. Canada) |
UserName=WINDOWS2012-001\Administrator, Host=, Instance=, Database=ECATSPRIMARY, Build=1400014, Version=4.4.0, Schema=33, Number of Servers=1 |

RSA NetWitness Endpoint: Version 4.4.0.0

NetWitness Suite
1. Log in to the NetWitness Endpoint user interface and go to Configure > Monitoring and External

Components Configuration > Netwitness Suite.
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2. Update the server Hostname and IP address to the current active server and test settings.

Configure Tools | View About

Main Menu a

[ ;
» NetWitness Suite
.' CD | -
Dashboard
F NetWitness Suite Connection
D’:I Server Hostname/IP 8 L
Machines
Configure NetWitness Suite
6." l Servers Time Zone | (UTC-11:00) Coordinated Universal Time-11
Device Identifier 18
Modules
URI https://* % #lvinvestigation/18/
m
' Query Optimization
| Do Not Perform Query Older Than 0 days *Set 0 fo query ail.
IP List
1
Query Time Range
C) 1
.‘ Minimum: (] minutes
Certificates ! Maximum: | 30 .| minutes
‘
InstantiOCs
a Test Settings
* 2 items total 4
Downloads

RSA NetWitness Endpoint: Version 4.4.0.0 UserName=WINDOWS:

Syslog Server Settings

Port: 443

Configure RSA NetWitness Endpoint Feeds for NetWitness Suite

| Enable RSA NetWitness Endpoint Feed

URL | https://Windows2012-001:9443/api/v2/feed/machines.csv

* Al SQL Users with valid permissions have access to above URL

Feed Publishing Interval

Time Interval: 0 Hrs 30 min

Enable URL access to below user to
Username:

Password: @

2-001\Administrator, Host=, Instance=, Database=ECATSPRIMARY, Build=1400014, Version=4.4.0, Schema=33, Number of Servers=1 ‘

BO®

Edit

t Scan
7/2019 2:56:12 ...

/2019 1219:19...

(UTC08:00] Pacific Time (US. Canada) |

User B

v, Vig

If you are forwarding syslog messages to a NetWitness Platform Log Decoder, update the syslog server
settings to point to the new IP address of the Log Decoder host.

1. Log in to the NetWitness Endpoint user interface and go to Configure > Syslog Server.

Configure Tools | View About

.‘ % SYSL0G Server
4 ) | togdecoder

Sysiog Connection
Server Hostname/IP :

Port

= Transport Protocol :

Modules
a
1P List

@®

an

Certificates

A

InstantioCs

@ Test Settings

Downloads

—-N OO0

2. Select logdecoder, and in Server Hostname/IP, enter the new IP address of the Log Decoder host.
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RSA NetWitness Orchestrator (By Demisto)

Update the Current Active NW Server to Fetch Respond Incidents and Alerts
1. Log in to Orchestrator and go to Settings > server&services.

2. Edit the RSA NetWitness V11.1 instance by updating the server URL to the current active NW
Server to fetch respond incidents and alerts.

Settings

USERS AND ROLES ADVANCED ABOUT

Classification & Mapping Pre-Process Rules Engines Agent Tools Credentials

Show: Type: Ca y Ef

RSA NetWitness v11.1

Home
Incidents

admin
Jobs
Indicators
et Case Management (1)
Playbo
Automation

£ Seitings

@

Update Component Hosts Acting as Data Sources

If you change the IP address of a component host, for example, a Concentrator, Network or Log
Decoder, or Broker, that is acting as data source to the Orchestrator, update the following settings to
point to the new IP address of the host.

1. Log in to Orchestrator and go to Settings > server&services and select the component host.

Settings

Analytics & SIEM (3)

T —
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2. Enter the new IP address of the component host in Server URL and click Done.

Settings

Analytics & SIEM (3)

RSA NetWitness Packetsand ... 8 x

Audit Logging

If you have changed the IP address of the NW Server, you must reconfigure audit logging. For
instructions, see "Configure Global Audit Logging" in the System Configuration Guide.

Health and Wellness

If you have any Health and Wellness rules that contain IP addresses that have been changed, you must
update those rules with the new IP addresses. For information about managing Health and Wellness
rules, see "Monitor Health and Wellness using NetWitness Platform UI" in the System Maintenance
Guide.

Malware Analysis

Source host IP address changes are not updated in the NetWitness user interface for Malware Analysis
continuous scan configurations. You must manually update this configuration in the Malware Analysis
Config view > General > Continuous Scan Configuration and update the source host IP address to the
new host IP address.
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% Change Service

General

| @ Malware - Malware Analytics

Indicators of Compromise

Continuous Scan Configuration

Config

Modules Configuration

Directary Path
File Sharing Protocol

Retention (in days)

Miscellaneous

Name

Maximum File Size (MB)

Name Config Value Name
Enabled O = Static
Query select * where content="spectrum.consume’ | | .. Enabled
Query Expiry 3600 Bypass PDF
Query Interval 5 Bypass Office
Meta Limit 25000 Bypass Executable
Time Boundary 24 Walidate Windows PE Authenticate Settings ...
Source Host " 172.16.0.0 = Community
Source Part (NwPort) 0 Enabled
Username admin Bypass PDF
User Password FEREEEEE Bypass Office
ss5L O Bypass Executable
Denial of Service (DOS) Prevention 1 T = Sandbox
Repository Configuration Enabled

Bypass PDF
MName Config Value

Bypass Office

Jvar/netwitness/malware-analytics-server/spectr...
Bypass Executable

None

0 Preserve Original File Name when Performi...
GFl Sandbox (Local)
Enabled

Config Value Server Name

5a Server Part

10C Summary Auditing Hash AV Proxy ThreatGRID  Integration

Config Value

«

Ooooano

[RERTRRTURE]

Q" O

oo

]

localhost

20

Windows Legacy Collection

On occasion, you may need to change the IP address of your Windows Legacy Collector. You may also
need to edit any Destination Groups that you have configured.

Change WLC IP Address

The following procedure describes how to change the IP address for your system.

1. Log onto the Windows Legacy Collector system and manually change the IP address on the system.

2. In the Ul confirm that the Log Collector service corresponding to the WLC system shows up in error
(Red). It might take some time for it to reflect the changed status.

3. On the NetWitness Server, use the nw-manage utility to view the host information for the WLC

using the following command:

nw-manage --list-hosts

Sample output from running the command is shown here:

{

"id" : "£db8150c-e040-459e-8cc5-3c60ec2c65ae",

"displayName"

"WLC-HOST-104",

"hostname" : "10.101.216.102",
"ipv4™ : "10.101.216.102",

"ipv4Public" :

b

null

You use the value of "id" from your output in the following step.
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4. Use the nw-manage utility to change the IP address of the WLC. For the host-id argument, use the
value for the "id" that you noted from step 3. For the ipv4 value, use the new IP Address to which
you are changing.

nw-manage --update-host --host-id "£db8150c-e040-459e-8cc5-3c60ec2c65ae" --
ipv4 10.101.216.105

5. After you see the message that the previous command ran successfully, go to the NetWitness Server
Ul and verify that the WLC service is running without any errors.

Edit Destination Groups For Log Collectors and VLCs

The Windows Legacy Collector is often configured with Destination Groups to forward events to Log
Collectors or Virtual Log Collectors. If the IP address of any such Destination LC or VLC is changed,
the Windows Legacy Collector can no longer forward events. To remediate this, you must edit the
Destination groups for the WLC, making sure to select the new LC or VLC IP Address.

Change Network Configuration for Warm Standby

(Secondary) Server
You can change the network configuration of a warm standby (secondary server) by following these
steps:

1. Follow the steps described in Change Host Network Configuration to change the IP address on the
secondary server.

2. Log in to the active NW Server and remove the previous secondary server IP address by running the
following command:
nw-manage --remove-nws-secondary-ip --ipv4 <previous standby server ip

address>

3. On the active NW Server, add the new standby server secondary IP address value by running the

following command:
nw-manage --add-nws-secondary-ip --ipv4 <new standby server ip address>

4. Schedule the backup of the primary NW Server and the copying of backed-up data to the secondary
NW Server. See step 18 in "Setup Secondary NW Server in Standby Role" in the Deployment Guide
for NetWitness Platform.

For information about configuring warm standby servers, see "Warm Standby NW Server Host" in the

Deployment Guide for NetWitness Platform and NW Server Host Secondary IP Configuration

Management.

Reconnecting Component Hosts with NW Server Hosts

While changing a host's IP address or during failover, component hosts can become disconnected from
NW Server hosts. Follow these steps to reconnect a host system to its NW Server system.

1. Log in to the component host using SSH or the console.

2. Run the following command:
nw-manage --override-nws-ip --ipv4 <current IP address of the NW Server>
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When this command completes, the component host is reconnected to the NW Server at the specified
IP address.
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Manage Custom Host Entries

If you have hosts in your environment that use custom entries, or if you want to use NAT [Pv4 addresses
for your hosts, this topic provides instructions for configuring these settings.

Manage Custom Host Entries in /etc/hosts

If you identify hosts in your environment that need custom entries, you can add custom entries for your
hosts in the /etc/hosts.user file.

To add custom host entries:
1. From the console, log in to the host on which to define custom entries.

2. Add the custom entry to the /etc/hosts.user file.

To update or refresh a custom entry in /etc/hosts:

Run the following command:

nw-manage --refresh-host --host-key <ID, IP, hostname or display name of
host>

Manage Public or NAT IPv4 Addresses for Hosts

To add or update public or Network Address Translation (NAT) IPv4 addresses for NW Hosts, run the

following command:
nw-manage --update-host --host-id <NW Server Host UUID> --ipv4d-public <IP
address>

Manage Custom Jetty Configuration

If you want to have custom jetty configurations or additional JAVA OPTIONS that persist during the
upgrade, this topic provides the instructions for configuring custom jetty settings.

To add custom jetty configuration

1. From SSH prompt, create a copy of jetty configuration as jetty.user using the below command.
$ cp /etc/default/jetty /etc/default/jetty.user

2. Editthe /etc/default/jetty.user and remove all lines EXCEPT one of the JAVA OPTIONS
additional settings lines.
For example, JAVA OPTIONS="${JAVA OPTIONS} -Drsa.primary.host=true "

3. Edit the line with the option (in this example increasing the max memory option from 8G to 24G):
JAVA OPTIONS="${JAVA OPTIONS} -Xmx24G "

4. Make sure to use the JAVA OPTIONS="${JAVA OPTIONS} " formatto EXTEND the Java
OPTIONS.
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5. REMOVE the [ -f /etc/default/jetty.user ] && source /etc/default/jetty.user
file.

6. Save the file.

7. Restart the jetty service.
systemctl restart jetty

Note: When you overwrite the jetty.user custom config file, ensure that all the jetty configurations
(JAVA_OPTIONS) present in /etc/default/jetty are available in this file. If any jetty configuration

(JAVA_OPTIONS) is not available in the jetty.user file, you must copy it to the file and then
restart the jetty service.
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Configure FIPS Support

NetWitness 11.x ships with FIPS-validated 140-2 Cryptographic Modules that support all cryptographic
operations within NetWitness. NetWitness leverages two modules that support a level three design
assurance:

« RSA BSAFE Crypto-J
« RSA OwB

Both modules have been certified with an operational environment comparable to the standard
NetWitness configuration.

By default, the cryptographic modules enforce the usage of FIPS-certified cipher suites wherever
possible. For exceptions, refer to the information below and to the release notes. For additional
information about the FIPS modules, see https://csrc.nist.gov/publications/detail/fips/140/2/final.

The RSA BSAFE Crypto-J FIPS Certificate number is 3172, and OwB uses the CCME FIPS Module in
FIPS-approved mode.

In 11.x, FIPS is enabled on all services except Log Collector. This includes Log Decoder and Decoder if
they were FIPS-enabled in 10.6.x or any previous version. FIPS cannot be disabled on any services
except for Log Collector, Log Decoder and Decoder.

Note: For a fresh installation of 11.x, by default, all core services will be FIPS enforced except Log
Collector and Log Decoder. FIPS cannot be disabled on any services except for Log Collector, Log
Decoder and Network Decoder.

Note: For upgrades to 11.x from previous versions, the following conditions apply for the Log
Collector, Log Decoder and Decoder services:

- Log Collector is not FIPS enabled after upgrading to 11.x, even if FIPS was enabled in a previous
version. You must enable FIPS support after upgrading to 11.x. See the instructions in FIPS support
for Log Collectors.

- If FIPS was enabled for the Log Decoder and Network Decoder services in a prevous version, FIPS
will also be enabled in 11.x. However, if Log Decoder and Network Decoder were NOT FIPS enabled
in a previous version, they will not be enabled in 11.x, and you can manually enable FIPS for these
services if required. See the instructions in FIPS support for Log Decoders and Decoders.
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FIPS support for Log Collectors

To enable FIPS for Log Collectors:

1.
2.

Stop the Log Collector service.

Open the /etc/systemd/system/nwlogcollector.service.d/nwlogcollector-opts-—
managed. conf file.

Change the value of the following variable to off as described here:
Environment="OWB ALLOW NON FIPS=on"

to

Environment="OWB ALLOW NON FIPS=off"

Reload the system daemon by running the following command:
systemctl daemon-reload

Restart the Log Collector service.

Set the FIPS mode for the Log Collector service in the Ul:

Note: This step is not required if you are upgrading from 10.6.x to 11.x and FIPS was enabled in
10.6.x.

A
a. Goto (Admin) > Services.
b. Select the Log Collector service and go to View > Config.

c. In SSL FIPS Mode, select the checkbox under Config Value and click Apply.

FIPS support for Log Decoders and Decoders

To enable FIPS for Log Decoders and Decoders that did not have FIPS enabled in 10.6.x:

1.
2.

QA
Go to (Admin) > Services and select a Log Decoder or Network Decoder service.

Select View > Config, and in System Configuration, enable SSL FIPS Mode by selecting the
check box in the Config Value column.

Configure FIPS Support 156




System Maintenance Guide

NETWITNESS

SERVICES EVENT SOU

 Change Service

General Files.
System Configuration
Name

Compression

Port

ndpointioghybrid1 - Log Decode

Data Retention Scheduler

Investigate Respond Users

ENDPOINT SOURCES

Config ©

App Rules

Config Value
0
50002

SSLFIPS Mode

SsL Port
Stat Update Interval

Threads

Log Decoder Configuration
Name
= Adapter
Berkeley Packet Filter
Capture Interface Selected
= Cache
Cache Directory
Cache Size
= Capture Settings
Assembler Maximum Size
Assembler Minimum Size

Assembler Session Flush

3. Restart the service.

4. Click Apply.

56002

1000

Config Value

log_events,Log Events

var/netwitness/logdecoder/cache

HEALTH & WELLNESS

Correlation Rules

Hosts Files Dashboard Reports admin v

SYSTEM CURITY

Feeds Parsers

Parser Mappings

Data Privacy ~ Data Export  Appliance Service Configuration

Parsers Configuration Enable Al Disable Al

Specify if relevant meta data is generated to disk (Enabled), generated only in memory for other Decoder content use
(Transient), or not generated at all (Disabled).

Name Config Value
& ALERTS Enabled
5 DOMAINSCAN Enabled
5 EMAILSCAN Enabled
4 FeedParser Enabled
# GeolP2 Enabled
# INTERNETTIMESTAMPSCAN Enabled

Service Parsers Configuration
This service is managed by Policy-based Centralized Content Management. Click here to manage this service.
Name

Config Value
cef 4
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DISA STIG

Note: 11.3.1 feature - DISA STIG (Defense Information Systems Agency Security Technical
Implementation Guide) support was introduced in NetWitness Platform 11.3.1. Versions 11.0.0.0 to
11.3.0.0 do not support DISA STIG.

NetWitness Platform version 12.4 supports all Audit Rules in the DISA STIG Control Group. The
supported version for DISA STIG is Red Hat Enterprise Linux 8 VIR11. NetWitness will expand its
support of STIG rules in future NetWitness Platform versions.

This section includes the following topics.

How STIG Limits Account Access

NetWitness Passwords

Generate the OpenSCAP Report

Manage STIG Controls Script (manage-stig-controls)
Rules List

Exceptions to STIG Compliance

IMPORTANT: All rules are enabled by default except for control goup 1-ssh-prevent-root an
control group 3-fips-kernel. You can enable or disable rules by control group using the manage-
stig-controls script.

How STIG Limits Account Access

The STIG hardening RPM helps to lock down information, systems, and software, which might
otherwise be vulnerable to a malicious computer attack by limiting account access to a system. For
example, the STIG script:

» Ensures that the account password has a length, complexity, expiration period, and lockout period that
are in accordance with DISA best practices.

* Applies auditing and logging of user actions on the host.

NetWitness Passwords

NetWitness Platform requires passwords that are STIG compliant.

Generate the OpenSCAP Report

Security Content Automation Protocol (SCAP) is a line of standards or rules managed by the National
Institute of Standards and Technology (NIST). It was created to provide a standardized approach to
maintaining the security of enterprise systems, such as automatically verifying the presence of patches,
checking system security configuration settings, and examining systems for signs of compromise.
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The OpenSCAP report evaluates your environment against the SCAP rules. The results are sent to the
HOSTNAME-ssg-results. (XML | HTML) depending on the output format you select.

Install OpenSCAP

You must
1. SSH to the host

2. Execute the following commands.

yum install scap-security-guide

Sample Report

The following report is a sample section from an OpenSCAP report.

_______________________________________________________________ Inmtroduction .
Test Result
Start time End time Benchmark Benchmark version
xccdf org.open-scap testresult stig-rhel6-server-upstream stig-rhelf-server-upstream 2015-06-26 04:58 2015-06-26 04:59 embedded 09
Target info
Targets Addresses

« NWAPPLIANCE20809

Score

system

um=xcedfscormg:default 79.95 100.00 79.95%

Results overview

not selected not checked not applicable informational unknown
153 0 49 0 173 19 0 0 2 396

Ensure ‘tmp Located On Separate Partition pass
Ensure 'var Located On Separate Partition pass
Ensure varlog Located On Separate Partition pass
Ensure varlog/audit Located On Separate Partition fail
Ensure 'heme Located On Separate Partition pass
Encrypt Partitions notchecked
Ensure Red Hat GPG Key Installed fail
Ensure gpgcheck Enabled In Mam Yum Configuration pass
Ensure gpgcheck Enabled For All Yum Package Reposttories fail
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Report Fields

I N

Result ID The Extensible Configuration Checklist Description Format
(XCCDF) identifier of the report results.
Profile XCCDF profile under which the report results are categorized.
Jrtees e e Start time When the report started.
Ll Gl End time When the report ended.
Benchmark XCCDF benchmark
Benchmark Version number of the benchmark.
version
Introduction - system XCCDF scoring method.
Score
score Score attained after running the report.
max Highest score attainable.
% Score attained after running the report as a percentage.
bar Not Applicable.
Results pass Passed rule check.
overview - Rule ) ) )
Results fixed Rule check that failed previously is now fixed.
Summary fail Failed rule check.
error Could not perform rule check.
not selected This check was not applicable to your NetWitness Platform
deployment.
not checked Rule could not be checked. There are several reasons why a rule
cannot be checked. For example, the rule check requires a check
engine not supported by the OpenSCAP report.
not applicable  Rule check does not apply to your NetWitness Platform
deployment.
informational ~ Rule checks for informational purposes only (no action required
for fail),
unknown Report was able to check the rule. Run steps manually as
described in the report to check the rule.
total Total number of rules checked.
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i s o

Exceptions Title Name of rule being checked.

Result Valid values are pass, fixed, fail error, not selected, not
checked, not applicable, informational, or unknown.

Note: Results values are defined the Results overview - Rule
Results Summary.

Create the OpenSCAP Report

The following tasks show you how to create the OpenSCAP Report:
1. SSH to the host.
2. Submit the following commands to make a directory:

a. mkdir -p /opt/rsa/openscap

b. cd /opt/rsa/openscap

3. Install the SCAP-security-guide packages:
yum install scap-security-guide

4. Generate report using the “profile stig™:

oscap xccdf eval --profile stig —--results /opt/rsa/openscap/ hostname’ -ssg-
results.xml --report /opt/rsa/openscap/ hostname -ssg-results.html --cpe
/usr/share/xml/scap/ssg/content/ssg-almalinux8-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-almalinux8-xccdf.xml

Note: This will create reports in both xml and html format.

5. Report will be available under following location:
/opt/rsa/openscap/

Manage STIG Controls Script (manage-stig-controls)

You can use the manage-stig-controls script and its arguments to enable or disable STIG Control
groups for which you want to apply STIG configuration. You can specify all hosts or individual hosts as
arguments and you can enable or disable all control groups or individual control groups. This script is
available in /usr/bin/ directory.

To manage STIG controls for a host:

1. SSH to the NW Server host or use the Console from the NetWitness Platform User Interface.

2. Submit the manage-stig-controls script with the commands, control groups, and other
arguments you want to apply.

3. Reboot the host.
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Commands

—-—-enable-all-controls
—--disable-all-controls

-—-enable-default-controls

—--enable-control-groups
<IDs>

--disable-control-groups
<IDs>

Control Groups

Enables all STIG controls. For example:

manage-stig-controls --enable-all-controls

Disables all STIG controls. For example:
manage-stig-controls --disable-all-controls

Enables all STIG Controls except ssh-prevent-root and fips-kernel.
For example:

manage-stig-controls --enable-default-controls

Enables (comma delimited) list of STIG Control GroupIDs. For

example:
manage-stig-controls --enable-control-groups '1,

2, 3"
Disables (comma delimited) list of STIG Control Group IDs For
example:

manage-stig-controls --disable-control-groups '1l,
2, 3!

You use the ID as an argument for the control group or groups.

Specified
Description
by Default
1 ssh-prevent-root Prevent root login through SSH. no
2 ssh SSH STIG configuration. yes
3  fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6  packages RPM Package STIG configuration yes
7  services Services STIG configuration yes
8 mount Mount STIG configuration yes
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Other Arguments

poment_Desrton

--host-all  Apply STIG configuration to all hosts. For example:
manage-stig-controls --host-all
--skip- Disable health checks for all hosts (not recommended). For example:
health- manage-stig-controls --skip-health-checks
checks
--host-id Apply STIG configuration for the host identified by <id> (host identification code).
<1d> For example:
manage-stig-controls --host-id <id>
-—host- Apply STIG configuration for host identified by <display-name>. display-name
name
<display- is the value shown under Name in the K&l (Admin) > Hosts View in the
name> NetWitness Platform Interface. For example:
manage-stig-controls --host-name <display-name>
-—host-addr  Apply STIG configuration for the host identified by the value shown under
<Hostname-
in UI> Hostname in the Kzl (Admin) > Hosts > Edit dialog in the NetWitness Platform
or Interface. This value can be an ip-addres (default) or a user-specified name. For
--host-addr example:
<hostname> .
manage-stig-controls --host-addr <hostname>
Edit Host
112Cere
<ip-address>
Cancel
You can change the
default <ip-address>to a
Edit Host user—spec'rﬁc name.
Name 112Core
Hostname | r\'.'.'Ser-.-e'I
Cancel
v, -= Enable verbose output. For example:
verbose .
manage-stig-controls -v
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Rules List

The following table lists all the STIG rules with their:

¢ Control Group - you can use the Control Group ID as an argument in the manage-stig-controls script
to expand on reduce the scope of rules checked. (1= ssh-prevent-root, 2 = ssh, 3 = fips-kernel, 4 =
auth, 5 = audit, 6 = packages, 7 = services)

e Default Status - tells you if the rule is enabled or disabled by default.

¢ Passed or Exception status - tells you if the rule passed (that is, complies with STIG) or is an
exception.

CCE Control Default Passed/

CCE- Enable Dracut FIPS Module fips-kernel disabled  Exception
82155-3

CCE- Enable FIPS Mode fips-kernel disabled  Exception
80942-6

CCE- Set kernel parameter 'crypto.fips_enabled' to  fips-kernel disabled  Exception
84027-2 1

CCE- Configure BIND to use System Crypto Policy N/A N/A Passed
80934-3

CCE- Configure System Cryptography Policy fips-kernel disabled  Exception
80935-0

CCE- Configure Kerberos to use System Crypto N/A N/A Exception
80936-8 Policy

CCE- Configure Libreswan to use System Crypto N/A N/A Passed
80937-6 Policy

CCE- Configure SSH Client to Use FIPS 140-2 N/A enabled Passed
85902-5 Validated Ciphers: openssh.config

CCE- The Installed Operating System Is Vendor N/A enabled Passed
80947-5 Supported

CCE- Encrypt Partitions N/A N/A Exception
80789-1

CCE- Disable GDM Automatic Login N/A N/A N/A
80823-8

CCE- Disable Ctrl-Alt-Del Reboot Key Sequence in  N/A N/A N/A
84028-0 GNOME3

CCE- Ensure AlmaLinux GPG Key Installed N/A enabled Passed
80795-8
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CCE Control Default Passedl

CCE- Ensure gpgcheck Enabled In Main yum enabled Passed
80790-9 Configuration

CCE- Ensure gpgcheck Enabled for Local Packages packages  enabled Passed
80791-7

CCE- Ensure gpgcheck Enabled for All yum N/A enabled Passed
80792-5 Package Repositories

CCE- Disable Ctrl-Alt-Del Burst Action services enabled Passed
80784-2

CCE- Disable Ctrl-Alt-Del Reboot Activation services enabled Passed
80785-9

CCE- Prevent Login to Accounts With Empty ssh enabled Passed
80841-0 Password

CCE- Verify Only Root Has UID 0 N/A enabled Passed
80649-7

CCE- Set the Boot Loader Admin Username to a fips-kernel disabled  Exception
83561-1 Non-Default Value

CCE- Set Boot Loader Password in grub2 fips-kernel disabled  Exception
80828-7

CCE- Set the UEFI Boot Loader Password N/A N/A N/A
80829-5

CCE- Ensure SELinux State is Enforcing N/A enabled Exception
80869-1

CCE- Uninstall vsftpd Package N/A enabled Passed
82414-4

CCE- Uninstall rsh-server Package N/A enabled Passed
82184-3

CCE- Remove Host-Based Authentication Files N/A enabled Passed
84055-3

CCE- Remove User Host-Based Authentication N/A enabled Passed
84056-1 Files

CCE- Uninstall telnet-server Package N/A enabled Passed
82182-7

CCE- Uninstall tftp-server Package N/A enabled Passed
82436-7

CCE- Disable SSH Access via Empty Passwords ssh enabled Passed
80896-4
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CCE Control Default Passedl

CCE- Install AIDE Exception
80844-4

CCE- Build and Test AIDE Database N/A N/A Exception
80675-2

CCE- Configure AIDE to Verify the Audit Tools N/A N/A Exception
85964-5

CCE- Configure Notification of Post-AIDE Scan N/A N/A Exception
82891-3 Details

CCE- Audit Tools Must Be Group-owned by Root ~ N/A enabled Passed
86239-1

CCE- Audit Tools Must Be Owned by Root N/A enabled Passed
86259-9

CCE- Audit Tools Must Have a Mode of 0755 or N/A enabled Passed
86227-6 Less Permissive

CCE- Configure GnuTLS library to use DoD- ssh enabled Passed
84254-2 approved TLS Encryption

CCE- Configure OpenSSL library to use System N/A enabled Passed
80938-4 Crypto Policy

CCE- Configure OpenSSL library to use TLS N/A enabled Passed
84255-9 Encryption

CCE- Configure SSH to use System Crypto Policy  N/A enabled Passed
80939-2

CCE- Configure SSH Server to Use FIPS 140-2 N/A enabled Passed
85897-7 Validated Ciphers: opensshserver.config

CCE- Configure SSH Client to Use FIPS 140-2 N/A enabled Passed
85870-4 Validated MACs: openssh.config

CCE- Configure SSH Server to Use FIPS 140-2 N/A enabled Passed
85899-3 Validated MACs: opensshserver.config

CCE- Install McAfee Endpoint Security for Linux ~ N/A N/A Exception
86260-7 (ENSL)

CCE- Ensure McAfee Endpoint Security for Linux ~ N/A N/A Exception
86261-5 (ENSL) is running

CCE- Ensure /var/tmp Located On Separate N/A N/A Exception
82730-3 Partition

CCE- Disable the GNOME3 Login User List N/A N/A N/A
86195-5

166 DISA STIG



System Maintenance Guide

CCE Control Default Passedl

CCE- Enable the GNOME3 Screen Locking On
83910-0 Smartcard Removal

CCE- Set GNOME3 Screensaver Inactivity Timeout N/A N/A N/A
80775-0
CCE- Set GNOME3 Screensaver Lock Delay After N/A N/A N/A

80776-8 Activation Period

CCE- Enable GNOME3 Screensaver Lock After N/A N/A N/A
80777-6 Idle Period

CCE- Ensure Users Cannot Change GNOME3 N/A N/A N/A
80780-0 Screensaver Settings

CCE- Ensure Users Cannot Change GNOME3 N/A N/A N/A
80781-8 Session Idle Settings

CCE- Ensure Users Re-Authenticate for Privilege N/A enabled Passed
82202-3 Escalation - sudo !authenticate

CCE- Ensure Users Re-Authenticate for Privilege N/A disabled  Exception
82197-5 Escalation - sudo NOPASSWD

N/A The operating system must require Re- N/A disabled  Exception
Authentication when using the sudo
command. Ensure sudo timestamp_timeout is
appropriate - sudo timestamp_timeout

CCE- The operating system must restrict privilege =~ N/A enabled Passed
83425-9 elevation to authorized personnel

CCE- Ensure sudo only includes the default N/A enabled Passed
86377-9 configuration directory

CCE- Ensure invoking users password for privilege N/A N/A Exception
83422-6 escalation when using sudo

CCE- Uninstall gssproxy Package N/A N/A Exception
82943-2

CCE- Uninstall iprutils Package N/A N/A Exception
82946-5

CCE- Uninstall krb5-workstation Package N/A N/A N/A
82931-7

CCE- Uninstall tuned Package N/A N/A Exception
82904-4

CCE- Ensure Software Patches Installed N/A enabled Passed
80865-9
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CCE Control Default Passedl

CCE- Enable GNOME3 Login Warning Banner
80768-5
CCE- Set the GNOME3 Login Warning Banner N/A N/A N/A
80770-1 Text
CCE- Modify the System Login Banner ssh enabled EXCEPTION
80763-6
CCE- An SELinux Context must be configured for  auth enabled Passed
86248-2 the pam_faillock.so records directory
CCE- Limit Password Reuse: password-auth N/A N/A Exception
83478-8
CCE- Limit Password Reuse: system-auth N/A N/A Exception
83480-4
CCE- Account Lockouts Must Be Logged N/A N/A Exception
86099-9
CCE- Lock Accounts After Failed Password N/A N/A Exception
80667-9 Attempts
CCE- Configure the root Account for Failed N/A N/A Exception
80668-7 Password Attempts
CCE- Lock Accounts Must Persist N/A N/A Exception
86067-6
CCE- Set Interval For Counting Failed Password N/A N/A Exception
80669-5 Attempts
CCE- Do Not Show System Messages When N/A enabled Passed
87096-4 Unsuccessful Logon Attempts Occur
CCE- Set Lockout Time for Failed Password N/A N/A Exception
80670-3 Attempts
CCE- Ensure PAM Enforces Password auth enabled Passed
80653-9 Requirements - Minimum Digit Characters
CCE- Ensure PAM Enforces Password N/A N/A fail
86233-4 Requirements - Prevent the Use of Dictionary

Words
CCE- Ensure PAM Enforces Password auth enabled Passed
80654-7 Requirements - Minimum Different

Characters
CCE- Ensure PAM Enforces Password auth enabled Passed
80655-4 Requirements - Minimum Lowercase

Characters
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CCE Control Default Passed/

CCE- Ensure PAM Enforces Password auth enabled Passed
81034-1 Requirements - Maximum Consecutive

Repeating Characters from Same Character

Class
CCE- Set Password Maximum Consecutive auth enabled Passed

82066-2 Repeating Characters

CCE- Ensure PAM Enforces Password auth enabled Passed
82046-4 Requirements - Minimum Different

Categories
CCE- Ensure PAM Enforces Password auth enabled Passed
80656-2 Requirements - Minimum Length
CCE- Ensure PAM Enforces Password auth enabled Passed
80663-8 Requirements - Minimum Special Characters
CCE- Ensure PAM password complexity module is  auth enabled Passed

85877-9 enabled in password-auth

CCE- Ensure PAM password complexity module is  auth enabled Passed
85872-0 enabled in system-auth

CCE- Ensure PAM Enforces Password auth enabled Passed
80664-6 Requirements - Authentication Retry Prompts
Permitted Per-Session

CCE- Ensure PAM Enforces Password auth enabled Passed
80665-3 Requirements - Minimum Uppercase

Characters
CCE- Set Password Hashing Algorithm in N/A enabled Passed
80892-3 /etc/login.defs
CCE- Set PAM"s Password Hashing Algorithm - auth enabled Passed
85945-4 password-auth
CCE- Set PAM"s Password Hashing Algorithm auth enabled Passed
80893-1
CCE- Set Password Hashing Rounds in N/A enabled Passed
89707-4 /etc/login.defs
CCE- Install the tmux Package N/A disabled  Exception
80644-8
CCE- Support session locking with tmux (not N/A N/A N/A

90782-4 enforcing)

CCE- Configure tmux to lock session after N/A disabled  Exception
82199-1 inactivity
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CCE Control Default Passedl

CCE- Configure the tmux Lock Command disabled  Exception
80940-0

CCE- Install the opensc Package For Multifactor N/A disabled  Exception
80846-9 Authentication

CCE- Install Smart Card Packages For Multifactor ~ N/A disabled  Exception
84029-8 Authentication

CCE- Disable debug-shell SystemD Service N/A enabled Passed
80876-6

CCE- Require Authentication for Emergency N/A enabled Passed
82186-8 Systemd Target

CCE- Require Authentication for Single User Mode N/A enabled Passed
80855-0

CCE- Set Account Expiration Following Inactivity ~— N/A enabled Passed
80954-1

CCE- Assign Expiration Date to Emergency N/A disabled  Exception
85910-8 Accounts

CCE- Assign Expiration Date to Temporary N/A disabled  Exception
82474-8 Accounts

CCE- Set Password Maximum Age auth enabled Passed
80647-1

CCE- Set Password Minimum Age auth enabled Passed
80648-9

CCE- Set Existing Passwords Maximum Age N/A disabled  Exception
82473-0

CCE- Set Existing Passwords Minimum Age N/A disabled  Exception
82472-2

CCE- Verify All Account Password Hashes are N/A disabled  Exception

83484-6 Shadowed with SHAS512

CCE- Ensure All Accounts on the System Have N/A enabled Passed
89903-9 Unique User IDs

CCE- Only Authorized Local User Accounts Exist ~ N/A disabled  Exception
85987-6 on Operating System

CCE- Ensure the Default Bash Umask is Set N/A disabled  Exception
81036-6 Correctly

CCE- Ensure the Default C Shell Umask is Set N/A disabled  Exception
81037-4 Correctly
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CCE Control Default Passed/

CCE- Ensure the Default Umask is Set Correctly in = N/A enabled Passed
82888-9 login.defs

CCE- Ensure the Default Umask is Set Correctly in ~ N/A disabled  Exception
81035-8 /etc/profile
CCE- Ensure the Default Umask is Set Correctly N/A enabled Passed
84044-7 For Interactive Users
CCE- Ensure Home Directories are Created for N/A enabled Passed
83789-8 New Users
CCE- Ensure the Logon Failure Delay is Set N/A enabled Passed
84037-1 Correctly in login.defs
CCE- User Initialization Files Must Not Run N/A enabled Passed
84039-7 World-Writable Programs
CCE- Ensure that Users Path Contains Only Local =~ N/A N/A Exception
84040-5 Directories
CCE- All Interactive Users Must Have A Home N/A enabled Passed
84036-3 Directory Defined
CCE- All Interactive Users Home Directories Must ~ N/A disabled  Exception
83424-2 Exist
N/A All User Files and Directories In The Home  N/A enabled Passed
Directory Must Be Group-Owned By The
Primary User
CCE- All User Files and Directories In The Home  N/A disabled  Exception
85888-6 Directory Must Have Mode 0750 Or Less
Permissive
N/A All Interactive User Home Directories Must ~ N/A enabled Passed
Be Group-Owned By The Primary User
CCE- Ensure All User Initialization Files Have N/A N/A Exception
84043-9 Mode 0740 Or Less Permissive
CCE- All Interactive User Home Directories Must ~ N/A N/A Exception
84038-9 Have mode 0750 Or Less Permissive
CCE- Enable authselect N/A N/A Exception
88248-0
CCE- Record Events that Modify the System's audit default Passed

80685-1 Discretionary Access Controls - chmod

CCE- Record Events that Modify the System's audit default Passed
80686-9 Discretionary Access Controls - chown
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CCE Control Default Passed/

CCE- Record Events that Modify the System's audit default Passed
80687-7 Discretionary Access Controls - fchmod

CCE- Record Events that Modify the System's audit default Passed
80688-5 Discretionary Access Controls - fchmodat

CCE- Record Events that Modify the System's audit default Passed
80689-3 Discretionary Access Controls - fchown

CCE- Record Events that Modify the System's audit default Passed
80690-1 Discretionary Access Controls - fchownat

CCE- Record Events that Modify the System's audit default Passed
80691-9 Discretionary Access Controls - fremovexattr

CCE- Record Events that Modify the System's audit default Passed
80692-7 Discretionary Access Controls - fsetxattr

CCE- Record Events that Modify the System's audit default Passed
80693-5 Discretionary Access Controls - Ichown

CCE- Record Events that Modify the System's audit default Passed
80694-3 Discretionary Access Controls - lremovexattr

CCE- Record Events that Modify the System's audit default Passed
80695-0 Discretionary Access Controls - Isetxattr

CCE- Record Events that Modify the System's audit default Passed
80696-8 Discretionary Access Controls - removexattr

CCE- Record Events that Modify the System's audit default Passed
80697-6 Discretionary Access Controls - setxattr

CCE- Record Any Attempts to Run chacl audit disabled  Exception
89446-9

CCE- Record Any Attempts to Run setfacl audit disabled  Exception
88437-9

CCE- Record Any Attempts to Run chcon audit default Passed
80698-4

CCE- Record Any Attempts to Run semanage audit default Passed
80700-8

CCE- Record Any Attempts to Run setfiles audit default Passed
82280-9

CCE- Record Any Attempts to Run setsebool audit default Passed
80701-6

CCE- Ensure auditd Collects File Deletion Events audit default Passed

80703-2 by User - rename
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CCE Control Default Passed/

CCE- Ensure auditd Collects File Deletion Events audit default Passed
80704-0 by User - renameat

CCE- Ensure auditd Collects File Deletion Events audit default Passed
80705-7 by User - rmdir

CCE- Ensure auditd Collects File Deletion Events audit default Passed
80706-5 by User - unlink

CCE- Ensure auditd Collects File Deletion Events audit default Passed
80707-3 by User - unlinkat

CCE- Record Unsuccessful Access Attempts to audit default Passed
80751-1 Files - creat

CCE- Record Unsuccessful Access Attempts to audit default Passed
80752-9 Files - ftruncate

CCE- Record Unsuccessful Access Attempts to audit default Passed
80753-7 Files - open

CCE- Record Unsuccessful Access Attempts to audit default Passed
80755-2 Files - open by handle at

CCE- Record Unsuccessful Access Attempts to audit default Passed
80754-5 Files - openat

CCE- Record Unsuccessful Access Attempts to audit default Passed
80756-0 Files - truncate

CCE- Ensure auditd Collects Information on Kernel audit default Passed
80711-5 Module Unloading - delete_module

CCE- Ensure auditd Collects Information on Kernel audit default Passed
80712-3 Module Loading and Unloading - finit

module
CCE- Ensure auditd Collects Information on Kernel audit default Passed

80713-1 Module Loading - init_module

CCE- Record Attempts to Alter Logon and Logout  audit default Passed
80719-8 Events - lastlog

CCE- Ensure auditd Collects Information on the audit enabled Passed
80725-5 Use of Privileged Commands - chage

CCE- Ensure auditd Collects Information on the audit enabled Passed
80726-3 Use of Privileged Commands - chsh

CCE- Ensure auditd Collects Information on the audit enabled Passed
80727-1 Use of Privileged Commands - crontab
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CCE Control Default Passed/

CCE- Ensure auditd Collects Information on the audit enabled Passed
80728-9 Use of Privileged Commands - gpasswd

CCE- Ensure auditd Collects Information on the audit enabled Passed
89455-0 Use of Privileged Commands - kmod

CCE- Ensure auditd Collects Information on the audit enabled Passed
80989-7 Use of Privileged Commands - mount

CCE- Ensure auditd Collects Information on the audit enabled Passed
80729-7 Use of Privileged Commands - newgrp

CCE- Ensure auditd Collects Information on the audit enabled Passed
80730-5 Use of Privileged Commands - pam _
timestamp_check

CCE- Ensure auditd Collects Information on the audit enabled Passed
80731-3 Use of Privileged Commands - passwd

CCE- Ensure auditd Collects Information on the audit enabled Passed
80732-1 Use of Privileged Commands - postdrop

CCE- Ensure auditd Collects Information on the audit enabled Passed
80733-9 Use of Privileged Commands - postqueue

CCE- Record Any Attempts to Run ssh-agent audit enabled Passed
85944-7
CCE- Ensure auditd Collects Information on the audit enabled Passed

80735-4 Use of Privileged Commands - ssh-keysign

CCE- Ensure auditd Collects Information on the audit enabled Passed
80736-2 Use of Privileged Commands - su

CCE- Ensure auditd Collects Information on the audit enabled Passed
80737-0 Use of Privileged Commands - sudo

CCE- Ensure auditd Collects Information on the audit enabled Passed
80739-6 Use of Privileged Commands - umount

CCE- Ensure auditd Collects Information on the audit enabled Passed
80740-4 Use of Privileged Commands - unix_chkpwd

CCE- Ensure auditd Collects Information on the audit enabled Passed
89480-8 Use of Privileged Commands - unix_update

CCE- Ensure auditd Collects Information on the audit enabled Passed
80741-2 Use of Privileged Commands - userhelper

CCE- Ensure auditd Collects Information on the audit enabled Passed
86027-0 Use of Privileged Commands - usermod
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CCE Control Default Passed/

CCE- Make the auditd Configuration Immutable audit disabled  Exception
80708-1

CCE- Configure immutable Audit login UIDs audit enabled Passed
90783-2

CCE- Ensure auditd Collects Information on audit enabled Passed

80722-2 Exporting to Media (successful)

CCE- Ensure auditd Collects System Administrator — audit enabled Passed
90175-1 Actions - /etc/sudoers

CCE- Ensure auditd Collects System Administrator audit enabled Passed
89497-2 Actions - /etc/sudoers.d/

CCE- Record Events When Privileged Executables  audit enabled Passed
83556-1 Are Run

CCE- Record Events that Modify User/Group audit enabled Passed
80758-6 Information - /etc/group

CCE- Record Events that Modify User/Group audit enabled Passed
80759-4 Information - /etc/gshadow

CCE- Record Events that Modify User/Group audit enabled Passed
80760-2 Information - /etc/security/opasswd

CCE- Record Events that Modify User/Group audit enabled Passed
80761-0 Information - /etc/passwd

CCE- Record Events that Modify User/Group audit enabled Passed
80762-8 Information - /etc/shadow

CCE- System Audit Directories Must Be Group N/A enabled Passed
88225-8 Owned By Root

CCE- System Audit Directories Must Be Owned By N/A enabled Passed
88226-6 Root

CCE- System Audit Logs Must Have Mode 0750 or N/A enabled Passed
84048-8 Less Permissive

CCE- System Audit Logs Must Be Group Owned N/A enabled Passed
88227-4 By Root

CCE- System Audit Logs Must Be Owned By Root N/A enabled Passed
88228-2

CCE- System Audit Logs Must Have Mode 0640 or N/A enabled Passed

80819-6 Less Permissive

CCE- Configure a Sufficiently Large Partition for N/A N/A Exception
84005-8 Audit Logs
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CCE Control Default Passed/

CCE- Configure auditd Disk Error Action on Disk  audit enabled Passed
84046-2 Error

CCE- Configure auditd Disk Full Action when Disk audit enabled Passed
84045-4 Space Is Full

CCE- Configure auditd mail acct Action on Low audit enabled Passed
80678-6 Disk Space

CCE- Configure auditd space left Action on Low audit enabled Passed
80684-4 Disk Space

CCE- Configure auditd space_left on Low Disk audit enabled Passed
86055-1 Space

CCE- Include Local Events in Audit Logs N/A enabled Passed
82233-8

CCE- Set hostname as computer node name in audit audit enabled Passed

82897-0 logs

CCE- Appropriate Action Must be Setup When the  audit enabled Passed
85889-4 Internal Audit Event Queue is Full

CCE- Ensure the audit Subsystem is Installed N/A enabled Passed
81043-2

CCE- Enable auditd Service N/A enabled Passed
80872-5

CCE- Set the UEFI Boot Loader Admin Username  N/A N/A N/A
83542-1 to a Non-Default Value

CCE- Disable vsyscalls N/A N/A Exception
80946-7

CCE- Ensure cron Is Logging To Rsyslog N/A enabled Passed
80859-2

CCE- Ensure Rsyslog Authenticates Off-Loaded N/A disabled  Exception

86339-9 Audit Records

CCE- Ensure Rsyslog Encrypts Off-Loaded Audit ~ N/A disabled  Exception
85992-6 Records

CCE- Ensure Rsyslog Encrypts Off-Loaded Audit ~ N/A disabled  Exception
86098-1 Records

CCE- Ensure remote access methods are monitored N/A disabled  Exception
83426-7 in Rsyslog

CCE- Ensure Logs Sent To Remote Host N/A disabled  Exception
80863-4
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CCE Control Default Passedl

CCE- Ensure rsyslog-gnutls is installed disabled  Exception
82859-0
CCE- Ensure rsyslog is Installed N/A enabled Passed
80847-7
CCE- Enable rsyslog Service N/A enabled Passed
80886-5
CCE- Install firewalld Package N/A enabled Passed
82998-6
CCE- Verity firewalld Enabled N/A disabled  Exception
80877-4
CCE- Configure the Firewalld Ports N/A disabled  Exception
84300-3
CCE- Configure Accepting Router Advertisements ~ N/A disabled  Exception
81006-9 on All IPv6 Interfaces
CCE- Disable Accepting ICMP Redirects for All N/A disabled  Exception
81009-3 IPv6 Interfaces
CCE- Disable Kernel Parameter for Accepting N/A disabled  Exception
81013-5 Source-Routed Packets on all IPv6 Interfaces
CCE- Disable Kernel Parameter for IPv6 N/A disabled  Exception
82863-2 Forwarding
CCE- Disable Accepting Router Advertisements on  N/A disabled  Exception
81007-7 all IPv6 Interfaces by Default
CCE- Disable Kernel Parameter for Accepting N/A disabled  Exception
81010-1 ICMP Redirects by Default on [Pv6

Interfaces
CCE- Disable Kernel Parameter for Accepting N/A disabled  Exception
81015-0 Source-Routed Packets on IPv6 Interfaces by

Default
CCE- Disable Accepting ICMP Redirects for All N/A enabled Passed

80917-8 IPv4 Interfaces

CCE- Disable Kernel Parameter for Accepting N/A enabled Passed
81011-9 Source-Routed Packets on all IPv4 Interfaces

CCE- Disable Kernel Parameter for [Pv4 N/A disabled  Exception
86220-1 Forwarding on all IPv4 Interfaces

CCE- Enable Kernel Parameter to Use Reverse Path N/A enabled Passed
81021-8 Filtering on all IPv4 Interfaces
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CCE Control Default Passedl

CCE- Disable Kernel Parameter for Accepting enabled Passed
80919-4 ICMP Redirects by Default on [Pv4

Interfaces
CCE- Disable Kernel Parameter for Accepting N/A disabled  Exception
80920-2 Source-Routed Packets on IPv4 Interfaces by

Default
CCE- Enable Kernel Parameter to Ignore ICMP N/A enabled Passed
80922-8 Broadcast Echo Requests on IPv4 Interfaces
CCE- Disable Kernel Parameter for Sending ICMP  N/A enabled Passed
80918-6 Redirects on all IPv4 Interfaces
CCE- Disable Kernel Parameter for Sending ICMP  N/A enabled Passed
80921-0 Redirects on all IPv4 Interfaces by Default
CCE- Disable ATM Support services enabled Passed
82028-2
CCE- Disable CAN Support services enabled Passed
82059-7
CCE- Disable SCTP Support services enabled Passed
80834-5
CCE- Disable Bluetooth Kernel Module services enabled Passed
80832-9
CCE- Deactivate Wireless Network Interfaces N/A N/A N/A
83501-7
CCE- Configure Multiple DNS Servers in N/A enabled Passed
84049-6 /etc/resolv.conf
CCE- Ensure System is Not Acting as a Network N/A enabled Passed
82283-3 Sniffer
CCE- Verify Group Who Owns /var/log Directory ~ N/A enabled Passed
83659-3
CCE- Verify Group Who Owns /var/log/messages N/A enabled Passed
83660-1 File
CCE- Verify User Who Owns /var/log Directory N/A enabled Passed
83661-9
CCE- Verify User Who Owns /var/log/messages N/A enabled Passed
83662-7 File
CCE- Verify Permissions on /var/log Directory N/A enabled Passed
83663-5
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CCE Control Default Passed/

CCE- Verify Permissions on /var/log/messages File N/A disabled  Exception
83665-0

CCE- Verify that Shared Library Directories Have  N/A enabled Passed
85894-4 Root Group Ownership

CCE- Verify that Shared Library Directories Have =~ N/A enabled Passed
89021-0 Root Ownership

CCE- Verify that Shared Library Directories Have ~ N/A disabled  fail
88692-9 Restrictive Permissions

CCE- Verify that system commands files are group  N/A disabled  fail
86519-6 owned by root or a system account

CCE- Verify that System Executables Have Root N/A disabled  fail
80806-3 Ownership

CCE- Verify that Shared Library Files Have Root N/A enabled Passed
80807-1 Ownership

CCE- Verify that System Executables Have N/A enabled Passed
80809-7 Restrictive Permissions

CCE- Verify that Shared Library Files Have N/A enabled Passed
80815-4 Restrictive Permissions

CCE- Verify the system-wide library files in N/A enabled Passed

86523-8 directories "/lib", "/1ib64", "/ust/lib/" and
"/usr/lib64" are group-owned by root.

CCE- Ensure All World-Writable Directories Are N/A disabled  fail
83375-6 Owned by root user

CCE- Verify that All World-Writable Directories N/A disabled  fail
80783-4 Have Sticky Bits Set

CCE- Ensure All World-Writable Directories Are N/A disabled  fail
85886-0 Group Owned by a System Account

CCE- Verify Permissions on /etc/audit/auditd.conf  audit enabled Passed
85871-2

CCE- Verify Permissions on audit enabled Passed
85875-3 /etc/audit/rules.d/*.rules

CCE- Ensure All Files Are Owned by a Group N/A enabled Passed
83497-8

CCE- Ensure All Files Are Owned by a User N/A enabled Passed
83499-4
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CCE Control Default Passed/

CCE- Enable Kernel Parameter to Enforce DAC on  N/A enabled Passed
81027-5 Hardlinks

CCE- Enable Kernel Parameter to Enforce DAC on  N/A enabled Passed
81030-9 Symlinks

CCE- Disable the Automounter N/A enabled Passed
80873-3

CCE- Disable Modprobe Loading of USB Storage  N/A enabled Passed
80835-2 Driver

CCE- Add nosuid Option to /boot/efi N/A disabled  Exception
86038-7

CCE- Add nosuid Option to /boot mount enabled Passed
81033-3

CCE- Add nodev Option to /dev/shm mount enabled Passed
80837-8

CCE- Add noexec Option to /dev/shm mount enabled Passed
80838-6

CCE- Add nosuid Option to /dev/shm mount enabled Passed
80839-4

CCE- Add noexec Option to /home mount disabled  Exception
83328-5

CCE- Add nosuid Option to /home mount default Passed
81050-7

CCE- Add nodev Option to Non-Root Local N/A enabled Passed
82069-6 Partitions

CCE- Add nodev Option to Removable Media N/A enabled Passed
82742-8 Partitions

CCE- Add noexec Option to Removable Media N/A enabled Passed
82746-9 Partitions

CCE- Add nosuid Option to Removable Media N/A enabled Passed
82744-4 Partitions

CCE- Add nodev Option to /tmp N/A disabled  Exception
82623-0

CCE- Add noexec Option to /tmp N/A disabled  Exception
82139-7

CCE- Add nosuid Option to /tmp N/A disabled  Exception
82140-5
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CCE Control Default Passedl

CCE- Add nodev Option to /var/log/audit disabled  Exception
82080-3

CCE- Add noexec Option to /var/log/audit N/A disabled  Exception
82975-4

CCE- Add nosuid Option to /var/log/audit N/A disabled  Exception
82921-8

CCE- Add nodev Option to /var/log mount enabled Passed
82077-9

CCE- Add noexec Option to /var/log mount enabled Passed
82008-4

CCE- Add nosuid Option to /var/log mount enabled Passed
82065-4

CCE- Add nodev Option to /var/tmp N/A disabled  Exception
82068-8

CCE- Add noexec Option to /var/tmp N/A disabled  Exception
82151-2

CCE- Add nosuid Option to /var/tmp N/A disabled  Exception
82154-6

CCE- Disable acquiring, saving, and processing N/A disabled  Exception
82881-4 core dumps

CCE- Disable core dump backtraces N/A disabled  Exception
82251-0

CCE- Disable storing core dump N/A disabled  Exception
82252-8

CCE- Disable Core Dumps for All Users N/A disabled  Exception
81038-2

CCE- Restrict Exposed Kernel Pointer Addresses N/A enabled Passed
80915-2 Access

CCE- Enable Randomized Layout of Virtual N/A disabled  Exception
80916-0 Address Space

CCE- Enable NX or XD Support in the BIOS N/A enabled Passed
83918-3

CCE- Enable page allocator poisoning N/A disabled  Exception
80944-2

CCE- Enable SLUB/SLAB allocator poisoning N/A disabled  Exception
80945-9
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CCE Control Default Passedl

CCE- Disable storing core dumps disabled  Exception
82215-5

CCE- Disable Kernel Image Loading N/A disabled  Exception
80952-5

CCE- Disable Access to Network bpf() Syscall N/A disabled  Exception
82974-7 From Unprivileged Processes

CCE- Restrict usage of ptrace to descendant N/A disabled  Exception
80953-3 processes

CCE- Harden the operation of the BPF just-in-time  N/A disabled  Exception
82934-1 compiler

CCE- Disable the use of user namespaces N/A disabled  Exception
82211-4

CCE- Configure SELinux Policy N/A enabled Passed
80868-3

CCE- Map System Users To The Appropriate N/A disabled  Exception
86353-0 SELinux Role

CCE- Uninstall Automatic Bug Reporting Tool N/A enabled Passed
80948-3 (abrt)

CCE- Disable KDump Kernel Crash Analyzer N/A enabled Passed
80878-2 (kdump)

CCE- Install fapolicyd Package N/A disabled  Exception
82191-8

CCE- Enable the File Access Policy Service N/A disabled  Exception
82249-4

CCE- Configure Fapolicy Module to Employ a N/A disabled  Exception

86478-5 Deny-all, Permit-by-exception Policy to
Allow the Execution of Authorized Software

Programs.
CCE- Remove the Kerberos Server Package N/A N/A N/A
85887-8
CCE- Disable Kerberos by removing host keytab N/A N/A N/A
82175-1
CCE- Configure System to Forward All Mail From N/A enabled Passed
89063-2 Postmaster to The Root Account
CCE- Prevent Unrestricted Mail Relaying N/A N/A N/A
84054-6
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CCE Control Default Passedl

CCE-
85983-5

CCE-
81039-0

CCE-
84052-0

CCE-
84050-4

CCE-
84053-8

CCE-
84059-5

CCE-
86077-5

CCE-
82434-2

CCE-
80907-9

CCE-
80897-2

CCE-
80898-0

CCE-
80901-2

CCE-
80902-0

CCE-
83360-8

CCE-
80903-8

CCE-
80904-6

CCE-
80905-3

CCE-
82281-7

The Postfix package is installed
Uninstall Sendmail Package

Mount Remote Filesystems with nodev
Mount Remote Filesystems with noexec
Mount Remote Filesystems with nosuid
Configure Time Service Maxpoll Interval
Ensure Chrony is only configured with the
server directive

Ensure tftp Daemon Uses Secure Mode
Set SSH Client Alive Count Max
Disable GSSAPI Authentication

Disable Kerberos Authentication

Disable SSH Root Login

Disable SSH Support for User Known Hosts

Disable X11 Forwarding

Do Not Allow SSH Environment Options

Enable Use of Strict Mode Checking

Enable SSH Warning Banner

Enable SSH Print Last Log

N/A

N/A

N/A

N/A

N/A

N/A

N/A

ssh

ssh

ssh

ssh

ssh

ssh

ssh

N/A

ssh

N/A

disabled

enabled

enabled

enabled

enabled

enabled

disabled

disabled

disabled

enabled

enabled

disabled

enabled

enabled

enabled

disabled

enabled

enabled

Exception

Passed

Passed

Passed

Passed

Passed

Exception

N/A

Exception

Passed

Passed

Exception

Passed

Passed

Passed

Exception

Passed

Passed
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CCE Control Default Passedl

CCE- Force frequent session key renegotiation disabled  Exception
82177-7

CCE- Prevent remote hosts from connecting to the =~ N/A disabled  Exception
84058-7 proxy display

CCE- Install the OpenSSH Server Package N/A enabled Passed
83303-8

CCE- Enable the OpenSSH Service N/A enabled Passed
82426-8

CCE- Verify Permissions on SSH Server Private ¥ N/A enabled Passed
82424-3 key Key Files

CCE- Verify Permissions on SSH Server Public N/A enabled Passed
82428-4 * pub Key Files

CCE- Certificate status checking in SSSD N/A N/A Exception
86120-3

CCE- Enable Certmap in SSSD N/A N/A Exception
86060-1

CCE- Enable Smartcards in SSSD N/A N/A Exception
80909-5

CCE- Configure SSSD to Expire Offline N/A N/A Exception
82460-7 Credentials

CCE- Install usbguard Package N/A N/A Exception
82959-8

CCE- Enable the USBGuard Service N/A N/A Exception
82853-3

CCE- Generate USBGuard Policy N/A N/A Exception
83774-0

CCE- Disable graphical user interface N/A enabled Passed
83411-9

CCE- Disable X Windows Startup By Setting N/A enabled Passed
83380-6 Default Target

CCE- Configure AIDE to Verify Access Control N/A disabled  Exception
84220-3 Lists (ACLs)

CCE- Configure AIDE to Verify Extended N/A disabled  Exception
83733-6 Attributes

CCE- Ensure /home Located On Separate Partition =~ N/A enabled Passed
81044-0
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CCE Control Default Passedl

CCE-
80851-9

CCE-
80852-7

CCE-
80853-5

CCE-
80854-3

CCE-
82968-9

CCE-
82919-2

CCE-
82926-7

CCE-
82907-7

CCE-
82910-1

CCE-
89201-8

CCE-
88955-0

CCE-
86084-1

CCE-
82476-3

CCE-
80788-3

CCE-
86135-1

CCE-
82361-7

CCE-
80955-8

CCE-
82201-5

Ensure /tmp Located On Separate Partition
Ensure /var Located On Separate Partition
Ensure /var/log Located On Separate Partition
Ensure /var/log/audit Located On Separate
Partition

Install rng-tools Package

Uninstall abrt-addon-ccpp Package

Uninstall abrt-addon-kerneloops Package
Uninstall abrt-cli Package

Uninstall abrt-plugin-sosreport Package
Uninstall libreport-plugin-logger Package
Uninstall libreport-plugin-rhtsupport Package
Uninstall python3-abrt-addon Package
Ensure yum Removes Previous Package

Versions

Ensure PAM Displays Last Logon/Access
Notification

Configure the tmux lock session key binding

Prevent user from disabling the screen lock

Limit the Number of Concurrent Login
Sessions Allowed Per User

Resolve information before writing to audit
logs

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

auth

auth

N/A

N/A

N/A

disabled

disabled

enabled

disabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

disabled

disabled

enabled

enabled

enabled

Exception

Exception

Passed

Exception

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Exception

Exception

Passed

Passed

Passed
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CCE Control Default Passedl

CCE- Enable Auditing for Processes Which Start disabled  Exception
80825-3 Prior to the Audit Daemon

CCE- Extend Audit Backlog Limit for the Audit N/A disabled  Exception
80943-4 Daemon

CCE- Enable Kernel Page-Table Isolation (KPTI) N/A disabled  Exception
82194-2

CCE- Disable IEEE 1394 (FireWire) Support services enabled Passed
82005-0

CCE- Disable TIPC Support services enabled Passed
82297-3

CCE- Disable Mounting of cramfs services enabled Passed
81031-7

CCE- Restrict Access to Kernel Message Buffer N/A disabled  Exception
80913-7

CCE- Disallow kernel profiling by unprivileged N/A disabled  Exception
81054-9 users

CCE- Install policycoreutils Package N/A enabled Passed
82976-2

CCE- Disable chrony daemon from acting as server N/A disabled  Exception
82988-7

CCE- Disable network management of chrony N/A enabled Passed
82840-0 daemon

CCE- SSH server uses strong entropy to seed N/A disabled  Exception
82462-3

CCE- Log USBGuard daemon audit events using N/A disabled  Exception

82168-6 Linux Audit
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Exceptions to STIG Compliance

This topic contains:
e Rule exceptions that are the responsibility of the customer to resolve.

o Rule exceptions that are "Not a Finding" which means that they do not apply to NetWitness Platform.
NetWitness has verified that the system meets these requirements.

* Rules to be supported in future release.

Key to Elements in Exception Descriptions

CCE Number

The Common Configuration Enumeration (CCE), assigns unique entries (also called CCE numbers) to
configuration guidance statements and configuration controls to improve workflow by facilitating fast
and accurate correlation of configuration issues present in disparate domains. In this way, it is similar to
other comparable data standards such as the Common Vulnerability and Exposure (CVE®) List
(http://cve.mitre.org/cve), which assigns identifiers to publicly known system vulnerabilities. The
OpenSCAP report lists exceptions by CCE number.

This sections lists the exceptions you can receive when you run the OpenSCAP report. The ID or
Common Configuration Enumeration (CCE) number in the table is the identification number for the
exception from the OpenSCAP report.

Control Group ID

Number that identifies the control group you specify in the manage-stig-controls script to enable or
disable the rule.

Specified
Description
by Default
1 ssh-prevent-root Prevent root login through SSH.  no
2 ssh SSH STIG configuration. yes
3  fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6  packages RPM Package STIG configuration yes
7  services Services STIG configuration yes
8  mount Mount STIG configuration yes
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Check

Describes what the rule checks to identify exceptions to DISA STIG compliance.

Comments

Provides insight on why you would receive this exception. This section includes one of the following
comments that describes the exception:

e Customer Responsibility - You are responsible to make sure the system meets this requirement.

* Not a Finding - Exception does not apply to NetWitness Platform. NetWitness has verified that the
system meets this requirement.

* Future Feature - NetWitness Platform does not meet this requirement. NetWitness plans to fix this in
a future release of NetWitness Platform.

Customer Responsibility Exceptions

CCE-80844-4 Install AIDE (Control Group = n/a)

Install the AIDE package with the following command:
Check . .
$ sudo yum install aide

Customer Responsibility. NetWitness Platform does not provide AIDE because it has
Comments a negative impact on performance. If you must install it, run as infrequently as possible
to adhere to your security policy.

CCE-80869-1 Ensure SELinux State is Enforcing

Check Ensure SELinux State is Enforcing

SELinux state is default it is set to 'permissive' by default for all the NetWitness

oMt Platform hosts instead of 'Enforcing' due to performance impact.

CCE-80901-2 Disable SSH Root Login (Control Group = ssh-prevent-root)

Check The root user should never be allowed to login to a system directly over a network.

Customer Responsibility.Disable root login through SSH by adding or editing the

omments g o ¥
e following line in the /etc/ssh/sshd config file: PermitRootLoginNetWitness.

CCE-86260-7 Virus Scanning Software Definitions Are Updated (ENSL) (Control
Group = n/a)

Check Make sure that virus definition files are no older than 7 days or their last release.

Comments Customer Responsibility. NetWitness does not provide this software.
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CCE-80942-6 Enable FIPS Mode (Control Group = fips-kernel)
To ensure FIPS mode is enabled, install the dracut-fips package and rebuild
initramfs by running the following commands:
$ yum install dracut-fips dracut
After the packages has been installed, enable fips mode with below command.
fips-mode-setup --enable

After the fips-mode-setup command has been run, add the fips=1 argument to
the default GRUB 2 command line for the Linux operating system in the
Check /etc/default/grub file as shown in the following example:

GRUB_CMDLINE LINUX='crashkernel=auto rd.lvm.lv=VolGroup/LogVol06
rd.lvm.lv=VolGroup/lv_swap rhgb quiet rd.shell=0 fips=1'

Finally, rebuild the grub.cfg file by using the grub2-mkconfig -o command as
follows ( On BIOS-based machines, issue the following command as root):

~]# grub2-mkconfig -o /boot/grub2/grub.cfg
On UEFI-based machines, issue the following command as root:
~]# grub2-mkconfig -o /boot/efi/EF1/redhat/grub.cfg

Comments Customer Responsibility. NetWitness Platform does not enable it by default.

CCE-82891-3 Configure Notification of Post-AIDE Scan Details (Control Group =
n/a)

AIDE should notify appropriate personnel of the details of a scan after the scan has
been run. If AIDE has already been configured for periodic execution in the
/etc/crontab file, append the following line to the existing AIDE line:

| /bin/mail -s '$ (hostname) - AIDE Integrity Check'
Check root@localhost

Otherwise, add the following line to the /etc/crontab file:

05 4 * * * root /usr/sbin/aide --check | /bin/mail -s
'S (hostname) - AIDE Integrity Check' root@localhost

AIDE can be executed periodically through other means. This is just one example.
Customer Responsibility. NetWitness Platform does not provide AIDE because it

Comments has a negative impact on performance. If you must install it, run as infrequently
possible to adhere to your security policy.
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CCE-84220-3 Configure AIDE to Verify Access Control Lists (Control Group = n/a)

Check

Comments

By default, the acl option is added to the FIPSR ruleset in AIDE. If using a custom
ruleset or the acl option is missing, add ac1 to the appropriate ruleset. For example,
add ac1 to the following line in the /etc/aide.conf file:

FIPSR = pti+nt+utgts+mt+ctacl+selinux+xattrs+sha256

AIDE rules can be configured in multiple ways; this is merely one example that is
already configured by default.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has
a negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-83733-6 Configure AIDE to Verify Extended Attributes (Control Group = n/a)

Check

Comments

By default, the xattrs option is added to the FIPSR ruleset in AIDE. If using a
custom ruleset or the xattrs option is missing, add xattrs to the appropriate ruleset.
For example, add xattrs to the following line in the /etc/aide.conf file:

FIPSR = pti+nt+utgts+mt+ctacl+selinux+xattrs+sha256

AIDE rules can be configured in multiple ways. This is just one example that is already
configured by default.

Customer Responsibility. NetWitness does not provide AIDE because it has a
negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-84029-8 Install Smart Card Packages For Multi-Factor Authentication
(Control Group = n/a)

Check

Comments

Configure the operating system to implement multifactor authentication by installing
the required packages with the following command:

$ sudo sudo yum install openssl-pkcsll
Customer Responsibility. The NetWitness Platform supports username/certificate for

authentication to shell. If you want to configure a smart card log in, you must do this
outside of NetWitness.
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CCE-27309-4 Set Boot Loader Password in grub2 (Control Group = fips-kernel)

The grub2 boot loader should have a superuser account and password protection
enabled to protect boot-time settings. To do so, select a superuser account name and
password and modify the /etc/grub.d/01 users configuration file with the new
account name. Because plain text passwords are a security risk, generate a hash for
the password by running the following command:

$ grub2-setpassword
When prompted, enter the password that was selected.

NOTE: It is recommended not to use common administrator account names like root,
Check admin, or administrator for the grub2 superuser account. Change the superuser to a
different username (The default is 'root').

$ sed -1 s/root/bootuser/g /etc/grub.d/01 users

To meet FISMA Moderate, the bootloader superuser account and password MUST
differ from the root account and password. Once the superuser account and password
have been added, update the grub. cfg file by running:

grub2-mkconfig -o /boot/grub2/grub.cfg

NOTE: Do NOT manually add the superuser account and password to the grub.cfg
file as the grub2-mkconfig command overwrites this file.

Customer Responsibility. Netwitness ships with root as the default super user for

Comments . . .
fips-control. Customer is expected to select a different superuser with the above steps.

Exceptions That Are Not a Finding

The following exceptions do not apply to NetWitness Platform. NetWitness has verified that the system
meets these requirements.

CCE-80852-7 Ensure /var Located On Separate Partition (Control Group = n/a)

The /var directory is used by daemons and other system services to store frequently-
Check changing data. Ensure that /var has its own partition or logical volume at installation
time, or migrate it using LVM.

Not a Finding.NetWitness software is installed in /var/netwitness by default and

Comments » ,
has a separate partition on /var/netwitness.

CCE-80775-0 Set GNOME3 Screensaver Inactivity Timeout (Control Group = n/a)

Check Verify that the GNOME Login Inactivity Timeout is set on the host (The graphical
desktop environment must set the idle timeout to no more than 15 minutes.).
Not a Finding. NetWitness Platform does not use Gnome Graphical User Interface

Comments (GUI) Desktop.
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CCE-80670-3 Set Lockout Time For Failed Password Attempts (Control Group =

auth)

Check

Comments

To configure the system to lock out accounts after a number of incorrect login
attempts and require an administrator to unlock the account using pam
faillock.so, modify the content of both /etc/pam.d/system-auth and
/etc/pam.d/password-auth by adding the following line immediately before the

pam_unix.so statement in the AUTH section:
auth required pam faillock.so preauth silent deny= unlock time=

fail interval=
Add the following line immediately after the pam unix.so statement in the AUTH

section:
auth [default=die] pam faillock.so authfail deny= unlock time=

fail interval=
Add the following line immediately before the pam unix.so statement in the

ACCOUNT section:
account required pam faillock.s

Not a Finding. root unlock time is setto 600 seconds.

CCE-80854-3 Ensure /var/log/audit Located On Separate Partition (Control Group

= audit)

Check

Comments

Audit logs are stored in the /var/log/audit directory. Ensure that it has its own
partition or logical volume at installation time, or migrate it later using LVM. Make

absolutely certain that it is large enough to store all audit logs that will be created by
the auditing daemon.

Not a Finding.NetWitness Platform has the /var/log directory as a separate
partition.

CCE-80916-0 Enable Randomized Layout of Virtual Address Space (Control Group

= n/a)

Check

Comments

To set the runtime status of the kernel.randomize va space kernel parameter,
run the following command:

$ sudo sysctl -w kernel.randomize va space=2

If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
kernel.randomize va space = 2

Not a Finding. Value of /proc/sys/kernel/randomize_va_space is already 2.
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CCE-80763-6 (Control ID = 2) Modify the System Login Banner (Control Group =

ssh)

Check

Comments

To configure the system login banner edit the /etc/issue file. Replace the default
text with a message compliant with the local site policy or a legal disclaimer. The
DoD required text is either:

" You are accessing a U.S. Government (USG) Information System (IS) that is
provided for USG-authorized use only. By using this IS (which includes any device
attached to this IS), you consent to the following conditions:

The USG routinely intercepts and monitors communications on this IS for
purposes including, but not limited to, penetration testing, COMSEC monitoring,
network operations and defense, personnel misconduct (PM), law enforcement
(LE), and counterintelligence (CI) investigations.

At any time, the USG may inspect and seize data stored on this IS.

* Communications using, or data stored on, this IS are not private, are subject to

routine monitoring, interception, and search, and may be disclosed or used for any
USG-authorized purpose.

This IS includes security measures (e.g., authentication and access controls) to
protect USG interests -- not for your personal benefit or privacy. -Notwithstanding
the above, using this IS does not constitute consent to PM, LE or CI investigative
searching or monitoring of the content of privileged communications, or work
product, related to personal representation or services by attorneys,
psychotherapists, or clergy, and their assistants. Such communications and work
product are private and confidential. See User Agreement for details."

or

" I've read & consent to terms in IS user agreem't."

Not a Finding. The login banner is displayed but does not hyphenate "agreem't"

CCE-80905-3 Enable SSH Warning Banner (Control Group = na)

To set the default banner SSH banner, customers are required to go into

Check /etc/ssh/sshd_config and add their banner path under the # no default
banner path tag. They can then add their Banner content in this file.
Comments Nota Finding. The required configuration exists in the /etc/ssh/sshd_config
file.
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CCE-80156-3 Disable Kernel Parameter for Sending ICMP Redirects for All

Interfaces (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.all.send redirects kernel
parameter, run the following command:

Check S sgdp sysctl -w net.ipv4.conf.all.sendTreQirects=O
If this is not the system default value, add the following line to the
/etc/sysctl.conf file:
t.ipv4.conf.all.send redirects = 0

Not a Finding. NetWitness Platform does not accept incoming Internet Control

Comments Message Protocol (ICMP) traffic.

CCE-80157-1 Disable Kernel Parameter for IP Forwarding (Control Group = n/a)

To set the runtime status of the t.ipv4.ip forward kernel parameter, run the
following command:

Check S sgdp sysctl -w net.ipv4.ip forward=0 ‘ .
If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipv4.ip forward = 0

Not a Finding. NetWitness Platform only uses FIPS certified MACs (for example,

Comments MACs hmac-shal, hmac-sha2-25¢, hmac—sha2—512),

CCE-80158-9 Configure Kernel Parameter for Accepting ICMP Redirects for All

Interfaces (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.all.accept redirects kernel
parameter, run the following command:

Check $ sgdp sysctl -w net.ipv4.conf.all.accept_;edirects=0
If this is not the system default value, add the following line to the
/etc/sysctl.conf file:
t.ipv4d.conf.all.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control

Comments Message Protocol (ICMP) traffic.

CCE-80163-9 Configure Kernel Parameter for Accepting ICMP Redirects By
Default (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.default.accept redirects kernel
parameter, run the following command:

Check $ sgdp sysctl -w net.ipv4.conf.default.gccgpt_redirects=0
If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipvéd.conf.default.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control

Comments Message Protocol (ICMP) traffic.
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CCE-80165-4 Configure Kernel Parameter to Ignore ICMP Broadcast Echo

Requests (Control Group = n/a)

Rule Name

Check

Comments

To set the runtime status of the t.ipv4.icmp echo ignore broadcasts kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv4.icmp echo ignore broadcasts=1

If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipvé4.icmp echo ignore broadcasts = 1

Not a FindingNetWitness Platform does not accept incoming Internet Control Message
Protocol (ICMP) traffic.

CCE-80438-5 Configure Multiple DNS Servers in /etc/resolv.conf (Control Group

= n/a)

Check

Comments

Multiple Domain Name System (DNS) Servers should be configured in the
/etc/resolv.conf file. This provides redundant name resolution services in the
event that a domain server crashes. To configure the system to contain as least 2 DNS
servers, add a corresponding nameserver entry in ip_address
/etc/resolv.conf file for each DNS server where ip address is the IP address

of a valid DNS server. For example:
search example.com nameserver 192.168.0.1 nameserver 192.168.0.2

Not a Finding. NetWitness Platform orchestrates and configures an internal DNS
server that all NetWitness hosts use for name resolution. You can configure external
DNS servers, but it is dependent on your environment.

CCE-80447-6 Configure the Firewalld Ports (Control Group = n/a)

Check

Comments

Configure the firewalld ports to allow approved services to have access to the

system. To configure firewalld to open ports, run the following command:
$ sudo firewall-cmd --permanent --add-port= or port number/tcp $
sudo firewall-cmd --permanent --add-port=

Run the command list above for each of the ports listed below: <ports>

To configure service nam firewalld to allow access, run the following
command(s):

firewall-cmd --permanent --add-service=ssh

Not a Finding. NetWitness Platform firewalld service is disabled because it uses
IP Tables, not FirewallD.
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CCE-80877-4 Verify firewalld Enabled

Check

Comments

Verify the operating system enabled an application firewall. Check to see if "firewalld"
is installed with the following command:

yum list installed firewalld
Installed Packages

firewalld.noarch 0.9.11-1.el18 8 Ranaconda

If the "firewalld" package is not installed, ask the System Administrator if another
firewall application (such as iptables) is installed.

If an application firewall is not installed, this is a finding.

Check to see if the firewall is loaded and active with the following command:
systemctl status firewalld

firewalld.service - firewalld - dynamic firewall daemon
Loaded: loaded (/ust/lib/systemd/system/firewalld.service; enabled)

Active: active (running) since Tue 2014-06-17 11:14:49 CEST; 5 days ago

If "firewalld" does not show a status of "loaded" and "active", this is a finding.

Check the state of the firewall:
firewall-cmd --state

running

If "firewalld" does not show a state of "running", this is a finding.

Not a Finding. NetWitness Platform firewalldservice is disabled because it uses IP
Tables, not FirewallD.

CCE-80854-3 Ensure /var/log/audit Located On Separate Partition

Check

Comments

Determine if the operating system is configured to have the "/var/log/audit" path is on a
separate file system.

grep /var/log/audit /etc/fstab

If no result is returned, or the operating system is not configured to have
"/var/log/audit" on a separate file system, this is a finding.

Verify that "/var/log/audit" is mounted on a separate file system:

mount | grep "/var/log/audit"

If no result is returned, or "/var/log/audit" is not on a separate file system, this is a
finding.

Not a Finding. NetWitness Platform has the /var/log directory as a separate partition.
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CCE-80851-9 Ensure /tmp Located On Separate Partition

Check Verify that a separate file system/partition has been created for "/tmp". Check that a file
system/partition has been created for "/tmp" with the following command:

systemctl is-enabled tmp.mount

enabled

If the "tmp.mount" service is not enabled, check to see if "/tmp" is defined in the fstab
with a device and mount point:

grep -1 /tmp /etc/fstab

UUID=a411dc99-2al-4c87-9e¢05-184977be8539 /tmp ext4
rw,relatime,discard,data=ordered,nosuid,noexec, 0 0

If "tmp.mount" service is not enabled or the "/tmp" directory is not defined in the fstab
with a device and mount point, this is a finding.

Comments  Future Feature - NetWitness Platform does not meet this requirement. NetWitness
plans to fix this in a future release of NetWitness Platform.

CCE-80852-7 Ensure /var Located On Separate Partition
Check Verify that a separate file system/partition has been created for "/var". Check that a file
system/partition has been created for "/var" with the following command:
grep /var /etc/fstab
UUID=c274f65f /var ext4 noatime,nobarrier 1 2
If a separate entry for "/var" is not in use, this is a finding.

Comments Not a Finding. Hardware is dedicated for NetWitness, and NetWitness software is
installed in /var/netwitness by default and a separate partition is on /var/netwitness.

Rules Supported in a Future Release

The following checks for non-compliance to STIG rules are not supported in NetWitness Platform and
will be added in a future release.

CCE-80920-2 Disable Kernel Parameter for Accepting Source-Routed Packets on
IPv4 Interfaces by Default

To set the runtime status of the net.ipv4.conf.default.accept source route
kernel parameter, run the following command:

$ sudo sysctl -w net.ipv4.conf.default.accept source route=0

Check
To make sure that the setting is persistent, add the following line to a file in the

directory /etc/sysctl.d

net.ipvéd.conf.default.accept source route = 0

Comments Future Feature.
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CCE-86220-1 Disable Kernel Parameter for IPv4 Forwarding on all IPv4 Interfaces

Check

Comments

To set the runtime status of the net.ipv4.conf.all.forwarding kernel parameter,
run the following command:

$ sudo sysctl -w net.ipvéd.conf.all.forwarding=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé4.conf.all.forwarding = 0

Future Feature.

CCE-81006-9 Disable Accepting ICMP Redirects for All IPv6 Interfaces

Check

Comments

To set the runtime status of the net.ipv6.conf.all.accept redirects kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv6.conf.all.accept redirects=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé6.conf.all.accept redirects = 0

Future Feature.

CCE-81013-5 Disable Kernel Parameter for Accepting Source-Routed Packets on

all IPv6 Interfaces

Check

Comments

To set the runtime status of the net.ipvé6.conf.all.accept source route
kernel parameter, run the following command:

$ sudo sysctl -w net.ipvé6.conf.all.accept source route=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé6.conf.all.accept source route = 0

Future Feature.

CCE-82863-2 Disable Kernel Parameter for IPv6 Forwarding

Check

Comments

To set the runtime status of the net.ipv6.conf.all.forwarding kernel parameter,
run the following command:

$ sudo sysctl -w net.ipv6.conf.all.forwarding=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé.conf.all.forwarding = 0

Future Feature.
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CCE-81007-7 Disable Accepting Router Advertisements on all IPv6 Interfaces by

Default

Check

Comments

To set the runtime status of the net.ipv6.conf.default.accept ra kernel
parameter, run the following command:

$ sudo sysctl -w net.ipv6.conf.default.accept ra=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé6.conf.default.accept ra = 0

Future Feature.

CCE-81010-1 Disable Kernel Parameter for Accepting ICMP Redirects by Default

on IPv6 Interfaces

Check

Comments

To set the runtime status of the net.ipv6.conf.default.accept redirects
kernel parameter, run the following command:

$ sudo sysctl -w net.ipv6.conf.default.accept redirects=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé6.conf.default.accept redirects = 0

Future Feature.

CCE-81015-0 Disable Kernel Parameter for Accepting Source-Routed Packets on
IPv6 Interfaces by Default

Check

Comments

To set the runtime status of the net.ipv6.conf.default.accept source route
kernel parameter, run the following command:

$ sudo sysctl -w net.ipvé6.conf.default.accept source route=0

To make sure that the setting is persistent, add the following line to a file in the
directory /etc/sysctl.d:

net.ipvé6.conf.default.accept source route = 0

Future Feature.
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Troubleshoot NetWitness Platform

For information about troubleshooting NetWitness, see the following topics:

¢ Debugging Information

e Error Notification

e Miscellaneous Tips

o NwLogPlayer: see the Log Parser Customization Guide for details.

¢ Troubleshoot Feeds
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Debugging Information

NetWitness Log Files

The following files contain NetWitness log information.

N

rabbitmg /var/log/rabbitmg/nw@localhost.log
/var/log/rabbitmg/nw@localhost-sasl.log

collectd /var/log/messages

nwlogcollector /var/log/messages

nwlogdecoder /var/log/messages

sms /opt/rsa/sms/wrapper.log

sms /opt/rsa/sms/logs/sms.log

sms /opt/rsa/sms/logs/audit/audit.log

NetWitness /var/lib/netwitness/uax/logs/nw.log
NetWitness /var/lib/netwitness/uax/logs/audit/audit.log
NetWitness /opt/rsa/jetty9/logs

Files of Interest

The following files are used in key NetWitness components, and can be useful when trying to track
down miscellaneous issues.

N S

RabbitMQ configuration file. This
configuration file partially drives the

rabbit /etc/rabbitmg/rabbitmg.config behavior of RabbitMQ,
particularly around network/SSL
settings.
RabbitMQ environment
rabbit /etc/rabbitmg/rabbitmg-env. configuration file. This file specifies
conf the RabbitMQ node name and

location of the enabled plugins file.
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N S

rabbit

rabbit

rabbit

/etc/rabbitmg/rsa enabled plugins

/etc/rabbitmg/ssl/truststore.pem

/var/log/rabbitmg/mnesia/
nw@localhost

This file specifies the list of enabled
plugins in RabbitMQ. This file is
managed by the RabbitMQ server,
with the rabbitmg-plugins

command. This file overrides the
/etc/rabbitmg/enabled

plugins path to work around
issues with upgrading the Log
Collector from early versions.

The RabbitMQ trust store. This file
contains a sequence of PEM-
encoded X.509 certificates,
represented trust CAs. Any clients
that connect to RabbitMQ and
present a certificate that is signed by
a CA in this list is considered a
trusted client.

The RabbitMQ Mnesia directory.
Mnesia is the Erlang/OTP database
technology, for storing Erlang
objects persistently. RabbitMQ uses
this technology for storing
information such as the current set
of policies, persistent exchanges and
queues, and so forth.

Importantly, the msg_store_
persistentandnﬁg_store_
transient directories are where
RabbitMQ stores messages that have
been spooled to disk, for example,
if messages are published as
persistent messages, or have paged
off to disk due to memory
limitations. Keep a close eye on this
directory if disk or memory alarms
have tripped in RabbitMQ.

Caution: Do not delete these files
manually. Use RabbitMQ tools to
purge or delete queues. Modifying
these files manually may render
your RabbitMQ instance
inoperable.
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Error Notification

NetWitness has a set of error message types associated with different components and operations.
NetWitness displays feedback in the form of a simple error notification and a log entry.

When an error notification dialog is displayed, you have two options: simply acknowledge the message
or view the system log for more information.

Trial License Expired

If you want to view the system log for more information when an error notification is displayed, click

View log. The log opens in the v (Admin) > System view with a list of messages. Timestamp and
message level are also listed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS  SYSTEM SECURITY

ie System Logging
Updates )
Realtime Historical Settings
Licensing
ALL v | Keywords Search
Email
Timestamp Level Message

Global Notifications
2023-10-17T19:12:50.256  INFO  Recurring Feed Job execution started for feed - TestAvenger4Rec

feeacliouticatons 2023-10-17T19:12:50.256  INFO The input stream to JobFileStore for Recurring Feed Job

I System Logging 2023-10-17T19:12:50.283  INFO  File exists for Recurring Feed Job. The file name is TestAvengeraRec.csv
Global Auditing 2023-10-17T19:12:50.284  INFO  File deleted for Recurring Feed Job. The file name is TestAvengerdRec.csv
Jobs 2023-10-17T19:12:50.284  ERROR  File TestAvengerdRec.xml does not exist! java.io.|OException: File TestAvenger4Rec.xml does not exist! at com.rsa.netwitness.carlos.scheduling.store JobFileStore.get(jobFileStore javai124...

2023-10-17T19:12:50.284  INFO Job avengers_admin.6e900e15-9764-464d-8687-c(686115a446 threw a : org.quartz.JobExecutionException: job Execution failed for TestAvenger4Rec: File TestAveng

Live Services
2023-10-17T19:13:56.854  INFO  Fetching data for chart /Hunting/Investigation Context from 2023-10-17 18:39:59.999 +0000 to 2023-10-17 19:12:59.999 +0000
URL Integration
8 2023-10-17T19:13:56.857  INFO  Fetching data for chart /Hunting/Investigation Categorization from 2023-10-17 18:39:59.999 +0000 to 2023-10-17 19:12:59.999 +0000
Context Menu Actions 2023-10-17T19:13:56.878  INFO Completed fetching data for chart /Hunting/Investigation Context with result size 0

Investigation 2023-10-17T19:13:56.886  INFO  Completed fetching data for chart /Hunting/Investigation Categorization with result size 0
HTTP Proxy Settings
NTP Settings

Dashboard Settings
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Miscellaneous Tips

Audit Log Messages
It can be useful to see which user actions result in which log message types in the /var/log/messages
file.

The event categories spreadsheet included in the log parser package in the NetWitness Parser v2.0.zip
archive lists the event categories and the event parser lines to help with building reports, alerts, and
queries.

NwConsole for Health & Wellness

RSA has added the command option logParse in NwConsole. This command option supports log
parsing, a convenient way to check a log parser without setting up the full system to perform log parsing.
For more information about the 1ogParse command, at the command line, type help logParse.

Thick Client Error: remote content device entry not found

The remote content device entry was not found error can be generated for a correlation rule applied to a
Concentrator. In NetWitness Investigate, if you click the correlation-rule—-name meta value in
the Alert meta key, you do not get session information.

Instead of using correlation rules on Decoders and Concentrators, use ESA rules. The ESA rules do
record the correlation sessions that match the ESA rule.

View Example Parsers

Since Flex and Lua parsers are encrypted when they are delivered by Live, you cannot easily view their
contents.

However, some plain text examples are available here: https://www.dell.com/support/home/en-us.

Configure WinRM Event Sources
The following Inside Dell article has a video that walks through the process of setting up Windows RM
(Remote Management) collection: https://inside.dell.com/docs/DOC-122732,

Additionally, it contains two scripts that are shortcuts for procedures described in the "Windows Event
Source Configuration Guide."
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Troubleshoot Feeds

Overview
The purpose of the feed generator is to generate a mapping of an event source to the list of groups to
which it belongs.

If you have an event source from which you are collecting messages, and it is not displayed in the
correct event source groups, this topic provides background and information to help you track down the
problem.

Details
The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source meta with the groupName collected on the Log
Decoder.

How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there are any
changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event-source-to-group mapping, and pushes the same feed to all of the
Log Decoders that are connected to NetWitness.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events meta data
with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to ESM. At this
point, you should see the Group Name column under the Event Source Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds after you
add a new group or event source, before the Group name is displayed.

Note: If the event source type attribute changes when the feed is updated, NetWitness adds a new
logstats entry rather than updating the existing one. Thus, there will be two different logstats entries in
logdecoder. Previously existing messages would have been listed under the previous type, and all
new messages are logged for the new event source type.

Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipvé, or hostname, depending on which of these have been
defined for the event source.

The following is a sample of the feed file:
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"12.12.12.12","d6", "NETFLOW", "grpl"

"12.12.12.12","1d4", "netflow", "grpl"
"12.12.12.12","d6", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242", "apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",, "apache", "Apachegrp"
"Appliancel234",,"apache", "Apachegrp"
"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apachegrp"

Troubleshooting

You can check the following items to narrow down where the problem is occurring.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip

Do not modify this file.

Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST and
check logstats:

http://LogDecoderIP:50102/decoder?msg=logStats&force-content-type=text/plain

This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8 count=1301
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lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19

groups=Al10therGroup,ApacheTomcatGroup

In the above text, the group information is bold.

Device Group Meta on Concentrator

Verify that the Device Group meta data exists on the Concentrator, and that events have values for the
device.group field.

Device Group (8 values) L
testgroup (28.878) - localgroup (3.347) - squid (3,346) - allothergroup (780) - apachetomcatgroup (561) - ip1234group (457) - cacheflowelff (219) - apachegroup (21)

sessionid = 22133

time = 2015-02-05T14:35:03.0
size = o

le.cid = "NWAPPLIANCE10304" =~
forward.ip = 127.0.0.1

device.ip = 20.20.20.20 ~
medium = 32

device.type = "unknown"
device.group = "TestGroup" ~
kig_thread = "g"

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are examples informational messages:

Feed generator triggered...
Created CSV feed file.
Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>
The following are examples of error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed: Unable to
create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>

Unable to push the ESM Feed: CSV file is empty, make sure you have al-least on
group with al-least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.
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Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip archive
"/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not be opened

Unable to push the ESM Feed: <reason>

Verify Logstats Data is Getting Read and Published by ESMReader
and ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to Event Source
Management.

ESMReader
1. On LogDecoders add the debug "true" flag in /etc/collectd.d/NwLogDecoder ESM.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all"> port "56002"

ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%al6bbaae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%al65aae.pem"

interval "600"

query "all"

<stats></stats></Module><Module "NgEsmReader" "update"> port
"56002" ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%albbaae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%al65aae.pem"

interval "60"

query "update"

<stats></stats></Module></Plugin>
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2. Run the command:
collectd service restart

3. Run the following command:

tail -f /var/log/messages | grep collectd

Verify that ESMReader is reading logstats and there are no errors. If there are any read issues, you

will see errors similar to the following:
Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader all:
error getting ESM data for field "groups" from logstat device=checkpointfwl
forwarder=PSRTEST source=1.11.51.212. Reason: <reason>Apr 29 18:58:36
NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader update: error getting ESM
data for field "forwarder" from logstat device=apachetomcat

source=10.31.204.240. Reason: <reason>

ESMAggregator
1. On NetWitness, uncomment the verbose flag in /etc/collectd.d/ESMAggregator.conf:

# ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"

<Module "ESMAggregator">
verbose 1
interval "eQ"
cache save interval "600"
persistence dir "/var/lib/netwitness/collectd"

</Module> </Plugin>

2. Run the following command:
collectd service restart

3. Run the following command:
run “tail -f /var/log/messages | grep ESMA
Look for for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaData[0]
logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e9%9al6baae
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Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e%al6baae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:

MetaData[l]

MetaData[2]

MetaData[3]

MetaData[4]

Dispatching

ESM stat NWAPPLIANCE15788/esma_ update-cacheflowelff/esm counter-3.3.3.3 with a

value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
logdecoder[0] = 767354a8-5e84-4317-bcb6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
logdecoders = 767354a8-5e84-4317-bcb6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:

MetaData[0]

MetaData[l]

MetaData[2]

MetaData[3]

MetaData[4]

Dispatching

RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm counter-3.3.3.3 with a

value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can change this by

using jconsole.

To change the feed generator job interval:

1. Open jconsole for the SMS service.

2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > Attributes.

3. Modify the value for the property FeedGeneratorJobIntervallnMinutes.
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4. Go to Operations under the same navigation tree, an click commit(). This persists the new value in
the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is restarted.

Setting a new value reschedules the feed generator job for the new interval.
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Troubleshooting Cert-Reissue Command

You must contact Customer Support (https://community.netwitness.com/t5/support-information/how-to-
contact-netwitness-support/ta-p/563897) to troubleshoot problems. You know there is a problem if any
<host-id> does not return a SuccessStatus. Success indicates that certificates were reissued for a
host.

Argument Options Used for Troubleshooting

You use the following argument options with cert-reissue --host-all to troubleshoot problems.

You can run cert-reissue --host-all<arguments> multiple times without an adverse effect.

Note: Use the following Argument Options with caution. They force the cert-reissue command to
execute for all the hosts.

--skip-health-checks Reissues certificates for all hosts at one time without applying system health
checks (force Reissue). This means that the command does not:

¢ verify that all hosts are online line.

 verify that all services are running.

Use case: You have numerous hosts and you know that a small minority of
them will fail. This updates all the hosts that conform to the checking rules
and you can reissue certificates for the others subsequently with the help of
Customer Support.

—}—15 kikp—version— Do not verify that hosts are running version 11.4.0.0 or later.

checks
Use Case: You have numerous hosts and your know that some of them are
not updated to 11.4 or later. This reissues certificates for all the hosts that
are at 11.4 or later and you can reissue certificates for the others
subsequently with the help of Customer Support.

--ignore-trigger- Ignore any errors that trigger failures. This option forces the cert reissue

errors

process to continue disregarding the errors instead of aborting or failing the
cert reissue command quickly.

When a cert reissue for a host succeeds, the reissued certificates on that host
are not provisioned to other dependent hosts (referred to as trusts). In this
case, the:

¢ host with reissued certificates is reported as “Partial.”

e the hosts with trusts that failed to update are listed separately in the
summary table to tell you that these hosts may require a refresh using the
new --refresh-trusts-only option.
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o Sfresh—Errsta- Refreshes trusts exclusively for host identified by <id> (does not reissue
onzy certificates for that host).

Problems and How to Troubleshoot Them

This section describes solutions to problems that you may encounter when running the cert-reissue
command to reissue certificates with suggested causes and solutions.

Failed!

2019-02-06 13:34:39.646 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking host connections...
2019-02-06 13:34:57.861 ERROR 8540 --- [ main]

c.r.n.i.o.client.HostValidator : Host '192.168.200.99' (nw-platform-esa-
primary) verification failed!

2019-02-06 13:34:57.862 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking status of services...
2019-02-06 13:35:57.931 ERROR 8540 --- [ main]
c.r.n.i.o.client.HostValidator : Service 'nw-platform-node-zero -

Investigate Server' not available!

bommmmm o e e - +
| | Host | Status | Message |
ommmmmeee oo ommmmee e |
| <host-id>| <IP-address> |Failed! |failed to connect, is host online? |
| <host-id>| <IF-address> |Failed! |service(s) down |
| <host=id>| <IP-address> |N/A | [ Skipped... ] |
| <host-id>| <IP-address> |N/A | [ Skipped... 1 |
| <host-id>| <IF-address> IN/A | [ Skipped... ] |
e fmmmm——mm———————————— fmmmm——— e e ———— +

cert-reissue --host-all failed because one or more hosts are offline or one or
more run time services are unreachable. You can force this command to run in spite of

this error by specifying the ——skip-health-checks option, that is:
cert-reissue --host-all--skip-health-checks

1. Bring appropriate hosts back online or make sure the NW Server hosts run time
services are running.

2. Run cert-reissue for the hosts affected.
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Failed!

| Status | Message |

|
|<host-id>| <IP-address> |Failed! |version <version-earlier-than-11.3.0.0> not supported|
|<host-id>| <IP-address> |Failed! |version <version-earlier-than-11.3.0.0> not supported|
|<host-id>| <IP-address> IN/B I'[ Skipped... ]
| <host-id>»| <IP-address> IN/A I[ Skipped... ]

|<host=id>»| <IP-address> IN/A I[ Skipped... ]

+-- + + +

cert-reissue -host-all command string failed because one or more hosts are
running a version earlier than 11.4.0.0

Note: You can force the reissue of certificates for the remaining hosts using the -
skip-version-checks argument.

Update the host to 11.4 or later and run cert-reissue for that host again.
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Partial

2019-02-06 02:27:09.078 ERROR 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-decoder)

2019-02-06 02:27:09.079 ERROR 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-concentrator)

2019-02-06 02:27:09.118 WARN 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

|<hoat-id>| <JP-address> |

|<host-id>| <IP-address> |

P ——————— e ———————— e +

jmmmmnaan e ——————— jmmmm e e e ———— L
| | Host | Status | Message |
R————————= A e e e |
|<host-id>| <IP-address> |Partial |Reissue completed, triggers failed |
| <host-id>| <IP-address> IN/R I[ Skipped.. ] |
|<hoat-id>| <IP-address> IN/A | [ Skipped... ] |
| <host-id»| <IP-address> IN/A | [ Skipped... ] |
|<host-id>| <JP-address> J. 74,9 | [ Skipped... ] |
e —————— e mmmm——— e e — e ————————— +

cert-reissue command completed on NW Server host however one or more triggers
failed. This aborted the cert-reissue command for other hosts.

Address all the errors and run the cert-reissue --host-all<arguments>
command string again.
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Partial

2019-02-06 14:18:03.208 ERROR 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host
'192.168.200.82"'" (nw-platform-node-x)

2019-02-06 14:29:05.200 WARN 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

Fmm—————— Fo e ———————————— +

o ———— o ———————————— pmm—————— e e e +
| | Host | Status | Message |
fmmm——— e e e o e e =
|<host-id>| <JIP-address> |Failed! ICert reissue failed! |

|<host-id>| <JP-address> |Partial |Reissue completed, triggers failed |
|<host-id>| <]P-address> |Success | Cert reissue successful |
|<host-id>| <JP-address> |Success | Cert reissue successful |
|<host-id>| <IP-address> Iﬁggcess [ Cer?_reissug successful |
fomm————— fommmmmmme———————————— tPomm————— o e e e e ———————— +

One or more hosts did not pass system health checks. In addition, one or more of the
unhealthy hosts are running core services, which will result in the NW Server host cert-
reissue to fail (because of failed triggers explained above). By disabling health checks
and trigger errors, you can continue the process and reissue certificates for the remaining
hosts. The NW Server host Status is reported as Partial because the cert-reissue
command completed for the NW Server but downstream triggers failed for other hosts.

Manually refresh the failed core hosts (to synchronize trust peers).

Submit the following command string to reissue certificates for healthy hosts.
cert-reissue --host-all --skip-health-checks --ignore-trigger-
errors
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References

This section describes the NetWitness user interface views in which you can perform system
maintenance tasks. You use this interface to:

* Monitor and maintain services (settings, statistics, command and message syntax, REST API,
NetWitness Console utility, and protocols supported in NetWitness).

* Display the current NetWitness version and license status.

e Manage your Local Update Repository from which you apply software version updates to hosts.

The following topics describe each interface in detail:
o Health and Wellness View

Health and Wellness View - Alarms View

Event Source Monitoring View

Health and Wellness Historical Graphs

o Historical Graph View for Events Collected from an Event Source

o Historical Graph for System Stats

Health and Wellness Settings View - Archiver

Health and Wellness Settings View - Event Sources

Health and Wellness Settings View - Warechouse Connector

Monitoring View

Policies View

System Stats Browser View

e New Health & Wellness Tab

e System View - System Info Panel

e System Updates Panel - Settings Tab

e System Logging - Settings View

e System Logging - Realtime Tab

e System Logging - Historical Tab

References
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Health and Wellness View

The Health and Wellness settings allow you to set and view alarms, monitor events, and view policies
and system statistics. For more details on each of these, see the following topics:

e Health and Wellness View - Alarms View

e Event Source Monitoring View

e Health and Wellness Historical Graphs

e Health and Wellness Settings View - Archiver

e Health and Wellness Settings View - Event Sources

e Health and Wellness Settings View - Warehouse Connector

e Monitoring View

¢ Policies View

e System Stats Browser View
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Health and Wellness View - Alarms View

You can monitor hosts and services to determine when user-defined limitations have been reached by
viewing all the active alarms. Policy rules, that you define or assign to hosts and services, in the Policies
tab trigger these alarms. You can:

¢ View all the alarms that are currently active for all your systems and services

e Select an alarm and view its details

What do you want to do?

Administrator ~ View the alarm status of NetWitness Monitor Alarms
Servers and services.

Administrator ~ View detailed information about a specific ~Monitor Alarms
alarm.

Related Topics

Manage Policies

Quick Look

Q
The required permission to access this view is Manage services. To access the Alarms view, go to
(Admin) > Health & Wellness. The Health & Wellness view opens with the Alarms tab displayed. The

Alarms tab contains an alarms list and an Alarm Details panel.

NETWITNESS U 5 d s admin v

HOSTS

LERLEIN  Monitoring

2019-02.08 08:25:23 PM

o s ] o 7] o o

Rule Name servie Hostname 17 Adress siet velue )

e L L A

2l Hos: Unreachadle Host broker Processinfo/Appliance Down True

2019.02.08 07:26:25 PM 2l Host Unreachadle Host archiver Pracessinfo/Appliance Down True

S|IRIaC) WLE

20190205 03:37:12 PM sl Log Decoder Capture Not Started Log Decoder logdec Capture/Caprure Status stopped

2019.01-2903:43:03 PM 2l Critical Flesystem Usage on Rabbitmg Message .. Host dec FileSystem/Mounted Flesystem Disk Ussge Perc.. 77%
20190117 04:2219 P =l Decoder Packet Caprure Poal Depleted Decoder dec Pool/Packet Capture Queue [}

20190117 042219 PM 2l Decoder Capture Not Started Decoder dec Capture/Capiure Stats stopped

2019.01-10 08:28:08 PM 2l Decoder Capture Rate Zero Decoder aec Capture/Capiure Packet Rate (current) o

2019-01-10 08:16:56 PM sl Archiver Aggregation Stopped Archiver archiver Archiver/Status stopped
2019.01-1008:15:41 PM =l Broker Aggregation Stopped Broker broker Broker/Status stopped
2019-01-1006:51:03 PM &l Concentracor Meta Rate Zero Concentracor conc Concentrator/Mets Rate (current) [
2019-01-10 06:49'52 PM 5l Log Decader Capture Rate Zero Log Decader logdec Capture/Capture Packet Rate {current) [
2019-01-10 04:50:53 PM sl Respond Server in Critical State Respond Server s Processinfo/Oversll Processing Status Indicator ERROR
2019-01-10 04:50:48 PM sl Broker Aggregation Stopped Broker s Broker/Status stopped
2019-02-08 09:20:43 PM Communication Failure Between Master NetWitn...  Hast E Error: ehestunre...
20190208 07:22:43 PM Communication Failure Besween Master NetWitn...  Host s starting
2019-01-2903:55:08 PM High Filesystem Usage Host dec FileSystem/Mounted Filesystem Disk Usage Perc..  95%
2019-01-2903:53:08 PM High Filesystem Usage Host dec 98%
2019.01-29 03:38:08 PM High Filesystem Usage on Rebbitmq Messags Br. Host dec FileSystem/lounted Fllesystam Disk Ussge Perc . 66%
20190110 08:15:41 PM Broker Session Rate Zero Broker broker Broker/Session Rate (current) [

20190110 04:50:48 PM Broker Session Rate Zero Broker Bl Broker/Session Rate (current) 0

“0000000o00ooooooooooooan

| Page 1 |of1 | | C ™ AuwoRefresh Items 1-22 of 22
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Time when the alarm was triggered.
AN Status of the alarm:

e Active - the statistical threshold was crossed triggering the alarm.

* Cleared - the clearing threshold was crossed and the alarm is no longer active.
RN Severity assigned to this alarm:

¢ Critical
e High
e Medium

e Low

Name of the rule that triggers the alarm.

Service defined in the rule.

n Host on which the alarm is triggered.

Statistic selected in the rule that triggers the alarm.
“ Value of the statistic that triggered the alarm.
n Identification number of the alarm.

Note: NetWitness sorts the alarms in time order. You can sort the relevant parameters in ascending or
descending order.

This figure shows the Alarms tab with the Alarm Details panel expanded.

NETWITNESS v ate pond Users Hosts Files Dashboard Reports admin v
SERVICES ~ EVENT SOURCES ~ ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM  SECURITY
Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness
= Delete Alarm Details
Time state severy | Rule Name sevice Hostname
[m] broker T
[m] archiver
[m] coder logdec
O dec
[m] dec
[m] dec
[m] dec
O archiver
[m] broker
Concentrator
54 Log Decoder logdec
O Respond Server 2
[m] Brol sa
[m] Host E]
m] Host = Capture/Capture Packe: Rate (current)
O Host jec 0
[m] Host ec !
[m] n Rabbitmq Message Br. Host dec
[m] Broker broker (1)
= Braker - (2]
o o
o (4]
51E
o
(7]
o
g te 34b1-53dc-def-
» gdecoder_decoder/gauge
| Page 1 of1 | | C ™ AuwoRefresh Items 1-22 of 22
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Alarm Details Panel

The Alarm Details panel displays information for the alarm selected in the Alarms list. It contains all the
information in the Alarms list plus the following fields.

Alarm Notified time

Suppression start time

Suppression end time

Suppression start (selected time zone)
Suppression end (selected time zone)
I3 The Policy ID

The Rule ID

n The Host ID

BB The Stat ID

Item key
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Event Source Monitoring View

Note: For NetWitness 11.3.1, this view has been deprecated: this functionality is now available in the

4
viS (Admin) > Event Sources > Discovery view. To manage Event Sources, see "About Event
Source Management" in the NetWitness Event Source Management Guide.
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Health and Wellness Historical Graphs

Configuring Archiver monitoring enables you to automatically generate notifications when critical
thresholds concerning Archiver aggregation and storage have been met. The Historical Graph view
provides a visualization of historical data.

Note: Historical graphs are not available for non-numeric statistics, and is indicated by a greyed-out
icon.

See the following topics for more details:

e Historical Graph View for Events Collected from an Event Source

e Historical Graph for System Stats
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Historical Graph View for Events Collected from an Event Source

A
Note: For NetWitness 11.4.1, this view has been deprecated. To manage Event Sources, use the
(Admin) > Event Sources view. For details, see "About Event Source Management" in theNetWitness
Event Source Management Guide.
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Historical Graph for System Stats

To access the Historical Graph for the System Stats:

1. Goto (Admin) > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

The System Stats Browser tab is displayed.

3. In the Historical Graph column, select i
The Historical graph for the selected statistic for a host is displayed.

The figure displays the system stats view for the Memory Utilization statistics.

Historical Graph

Concentrator: Memory Utilization Time Frame | Current Day
Zoom 1h 6h  12h 14 Al From | Feb 1, 2019 To | Feb 1, 2019
aM §
£
m
35M
30M
08:00 0%:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00
— _.ll
| I P 2 D——— T ) 12:00 e —S = Ty W
1 m v
— awverage
Click and drag in the plot area to zoom in

Parameters

You can customize the graph view as required. The table lists the various parameters used to customize
the historical graph view.

Time Frame Select the time frame for which you want to view the historical data.
The available options are: Current Day Current Week, Current Month, and
Current Year.

From <date> To Select the date range for which you want to view the historical data,
<date>

You can zoom in for a detailed view of the data in the Historical graph.
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Zoom in function 1 and 2:

You can select one of the values to view the historical data for the selected value. The figure below
displays an example for the 6h frame selected for zoom in. The slider bar at the right bottom corner is
also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Moni v
Zoom 1w 2w 3w Im Al From | Jun 29, 2017 To | Jul 14, 2017

7

6.5
s 5
E
m

5.5

5

45

30. Jun 2. Jul 4. Ju 6. Jul 8. Jul 10. Ju 12, Jul 14, Jul
19. Jun 26. Jun 3. Ju 10 Julf
] m *
average
Click and drag in the plot area to zoom in

Zoom in function 3:
You can click and drag in the plot area to zoom in for a required frame of time.

The figure below displays an example of how the graph appears while you click and drag.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v

Zoom Tw 2w 3w Im Al From | Jul 10, 2017 To | Jul 13, 2017

-

Tuesday, Jul 11, 18:00 -
average: 6.00

o
anep

08:00 16:00 11 Ju 08:00 16:00 12. Ju 08:00 16:00 13. Ju 08:00

19 Jun 26_ Jun 3 Ju Tt/

average

Click and drag in the plot area to zoom in
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Health and Wellness Settings View - Archiver

To access the Archiver Monitoring view:

A
1. Goto (Admin) > Health & Wellness.

2. Select Settings > Archiver.

What do you want to do?

Administrator Monitor service details of Archiver Monitor Service Details

Quick Look

NETWITNESS

HEALTH & WELLNESS

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring [lSSULECE  New Health & Wellness

To monitor Event Sources select the Manage tab in Event Source Management. To monitor Archiver and Warehouse Connector, see Health Polic

Archiver | Warehouse Connector

Archiver Monitoring

These settings allow for notifications to be generated when critical thresholds concerning Archiver aggregation and
storage have been met.

Aggregation Status
Notify After ) v

For Failed Offline

Aggregation Connection

Notify After Failing For < Minutes v

Storage Connection

Notify After Failing For < Minutes v

Storage Capacity

Storage Threshold By ~ ® Space Time
When Storage Size Is < %Full When Warm Storage Size Is S % Full
Type

Notificati

NetWit

Apply Cancel

s Platfors Email Syslog Notification SNMP Trap Notification

I Displays Archiver Monitoring Panel

P Configures Archiver Monitoring Panel to automatically receive notification

Features

The following table lists the parameters required to configure Archiver to automatically generate
notification when critical thresholds are reached.
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Aggregation
Status

Aggregation
Connection

Storage
Connection

Storage
Capacity

Notification
Type

Notify After

For

Notify After Failing
for

Notify After Failing
for

Storage Threshold By

When Storage Size Is

When Warm Storage
Size Is

Configure email or
distribution list

Configure Syslog and
SNMP Trap servers

NW Console,
Email,

Syslog Notification,
SNMP Trap
Notification

Number of minutes or hours after which you are notified of
aggregation status

Failed - If enabled, you are notified when the

Archiver aggregation status is failed for the defined number
of minutes or hours.

Offline - If enabled, you are notified when the

Archiver aggregation status is offline for the defined number
of minutes or hours.

Number of minutes or hours after which you receive
notification if the Archiver aggregation connection fails.

Number of minutes or hours after which you receive
notification if the Archiver storage connection fails.

Select Space if you want to receive a notification when the
Archiver storage capacity exceeds the percentage defined in
the When Storage Size Is field.

Select Time if you want to receive a notification when the
files stored in the Archiver exceeds the defined number of
days in the When Oldest Storage File Is field.

Enter the percentage of used storage to trigger a notification.

Enter the percentage of used storage on the warm server to
trigger a notification.

Click to configure email so that you can receive notifications
in NetWitness.

Click to configure audit logs.

Enable NW Console to get notifications on the NetWitness
UI notification toolbar.

Enable Email to get email notifications.
Enable Syslog Notification to generate syslog events.

Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Health and Wellness Settings View - Event Sources

A
Note: For NetWitness 11.4.1, this view has been deprecated. To manage Event Sources, use the
(Admin) > Event Sources view. For details, see "About Event Source Management" in theNetWitness
Event Source Management Guide.
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Health and Wellness Settings View - Warehouse Connector

Configuring the Warehouse Connector monitoring enables you to automatically generate notification
when critical thresholds concerning Warehouse Connector and storage have been met.

Access the Warehouse Connector Monitoring view

4
1. Goto (Admin) > Health & Wellness.

2. Select Settings > Warehouse Connector.

What do you want to do?

Administrator View the details of Warechouse connector Warehouse Connector Details View

Related topics

Monitor Service Details

Quick Look

The Warehouse Connector Monitoring view is displayed.

NETWITNESS nvestigate Respond Users Hosts Dashboard

HEALTH & WELLNESS TE URITY

Alarms  Monitoring  Policies  System Stats Browser  Event Source Monitoring [ECSSUEEMN New Health & Wellness

To monitor Event Sources select the Manage tab in Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy

Archiver | Warehouse Connector 4—-

Warehouse Connector Monitoring

These settings allow for notifications to be generated when critical thresholds concerning Warehouse Connector and
storage have been met

Source or Destination Status

Notify Offline For C Minutes v

Stream Status.

Notify Stopped For < Minutes v
Disk Is & % rul n
Source Is Behind £ | sessions

Rejected Folder Size Is | %Full

Number Of Files In Permanent s

Failure Folder ~

Notification Type

[] NetWitness Platform Console ] Email [ Syslog Notification [ SNMP Trap Notification

Displays the Warehouse Connector Monitoring view panel.
Allows you to configure Warehouse Connector Monitoring parameters.
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Warehouse Connector Monitoring parameters

The following table lists the parameters required to configure the Warehouse Connector to automatically
generate notification when critical thresholds are reached.

Source or
Destination
Status

Stream Status

Notification
Type

Notify Offline For

Notify Stopped For

Disk Is

Source Is Behind

Rejected Folder Size Is

Number Of Files in
Permanent Failure
Folder

Configure email or
distribution list

Configure Syslog and
SNMP Trap servers

NW Console,
Email,

Syslog Notification,
SNMP Trap
Notification

Number of minutes or hours after which you receive a
notification if the source or destination connection fails.

Number of minutes or hours after which you receive a
notification when the Stream goes offline.

The limit on the percentage of disk usage after which
you would like to receive a notification.

Number of sessions after which a notification is raised if
the source goes behind the defined number of sessions.

Limit on the percentage of folder usage after which you
receive a notification.

Limit on the number of files in the permanent failure folder
after which you receive a notification.

Click to configure email so that you can receive
notifications in NetWitness,

Click to configure audit logs.

Enable NW Console to get notifications on the NetWitness
UI notification toolbar.

Enable Email to get email notifications.

Enable Syslog Notification to generate syslog events.
Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Monitoring View

NetWitness provides detailed statistics and other information about the host and the individual
NetWitness services in Details views. You can view the current health of all the hosts and the services
running on the hosts in the Monitoring view.

What do you want to do?

Administrator View and Perform Procedures Monitor Hosts and Services

Quick Look

To access this view:

A
1. Goto (Admin) > Health & Wellness.
2. Click the Monitoring tab.

The Monitoring view is displayed.

Respond Users Hosts Files Dashboard Reports  Reports admin v

ENDPOINT SOURCES ~ HEALTH & WELLNESS ~ SYSTEM  SECURITY ¥

System Stats Browser  Event Source Monitoring ~ Settings  New Health & Wellness

Groups Hosts Filter
Name Sount Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
San o 0 9 0 host(s) 0 host(s) 0 host(s)
B adminserver Status: @ CPU:432% Memory: 30.75 GB/31.42 GB =
Service Health Status  Rate Name. Service Type cpPu Memory Usage Uptime.
® Ready L ] 0 adminserver - Broker Broker 0.4% 29.41MB 1 week 6 days 23 hours 20 minutes 6 seconds
® Ready s} adminserver - Reporting Engine  Reporting Engine 0.5% 24168 1 week 6 days 23 hours 40 minutes 59 seconds
® Ready [S] jonSe... O Server 0.9% 1.00GB 1 week 6 days 23 hours 45 minutes 9 seconds
® Ready o adminserver - Security Server Security Server 07% 110GB. 1 week 6 days 23 hours 37 minutes 42 seconds
® Ready [ ] adminserver - Admin Server Admin Server 0.7% 1.43GB 1 week 6 days 23 hours 45 minutes 15 seconds
® Ready o adminserver - Config Server Config Server 0.8% 1.03GB 1 week 6 days 23 hours 44 minutes 56 seconds
® Ready ° erver - Investigate Server  Investigate Server 09% 20268 1 week 6 days 23 hours 29 minutes 27 seconds
® Ready - adminserver - Respond Server Respond Server 0.4% 12068 1 week 6 days 23 hours 23 minutes 15 seconds
® Ready o adminserver - Integration Server  Integration Server 0.5% 1.66GB. 1 week 6 days 23 hours 31 minutes 17 seconds
® Ready a - adminserver - Content Server Content Server 0.7% 150GB. 1 week 6 days 23 hours 25 minutes 43 seconds
® Ready o - adminserver - Source Server Source Server 07% 1.25G8 1 week 6 days 23 hours 33 minutes 14 seconds.
B decoder Status: @ CPU:23% Memory: 5.20 GB/7.80 GB .
l 3
| Page 1 of1 | | C Displaying 1-5 of 5

The Monitoring tab shows health statistics for the NetWitness Platform hosts and services.
The Group panel enables you to view statistics for a selected group.
The Hosts panel displays operational statistics.

Groups Panel

The Groups panel lists all of the groups of hosts available. When you select a group, the associated
content is displayed in the Hosts panel.
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Note: If the total host count in the Groups panel is lower than the actual number of hosts displayed in
the Hosts panel, refer to the Troubleshooting Health & Wellness topic for possible causes of this issue
and recommended solutions.

Hosts Panel

The Hosts panel displays operational statistics for hosts and the services running on each host.

Filter

Stopped
Services

Stopped
Processing

Physical drive
Problems
<#> host(s)

Logical Drive
Problems
<#> host(s)

Full
Filesystems
<#> host(s)

Type a host name or a service name in the Filter field to display the corresponding
hosts and services in the Host panel.

Click Stopped Services to display a list of all stopped services. It also displays the
host on which the service is installed.

Click Stopped Processing to display a list of all the hosts that have services installed
on them that are in the stopped processing status.

Click to view the hosts that have physical drive problems.

Click to view the hosts that have logical drive problems.

Click to view the hosts that have full file systems.

Note: The summary information in the boxes at the top displays the System Statistics for all of the
hosts configured in NetWitness and does not change with the application of filters on the groups.

Below the boxes at the top of the Hosts panel is a list of hosts, the services installed on them, and
information regarding the hosts and services.

Host Name

Status

CPU

Memory

Displays the host name.

If a host has services installed that are not in view, you will see a & prefixed to the
host name.

Click E to view all the services installed on the host.

Displays the status of the Host.
@ - The host is active and running.

® _ The host is stopped or yet to start processing.
Displays the current CPU usage of the host.

Displays the Memory used by the host.
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When you click E2 prefixed to the host name, a list of all the services installed on the host is displayed.
The table below describes parameters displayed for a service and their description.

Service

Health Status

Rate

Name

Service Type
CPU

Memory
Usage

Uptime

Displays the status of the service.
@ Ready - The service is active and running.
® Stopped - The service is stopped or yet to start processing.

Displays the processing status of the service.
(" - The process is running and the data is being processed at a rate greater than

Zero.
® _ The processing is stopped.
- The processing is turned on but the data is not being processed.

Shows the rate at which data is being processed.

Name of the service in the format <host> - <service>, Click the link in the
Name field to get additional service details.

Name of the type of service.
Shows the current CPU usage of the service.

Displays the Memory used by the service.

Displays the time for which the service has been running.
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Archiver Details View

The Archiver Details view provides information about the Archiver. The following figure shows the
Archiver details.

NETWITNESS Inv e d Hosts Files D Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness.

HOST AND SERVICES ; :
Archiver Details
Host
Service
I Archiver
cpPU 3% Used Memo; 319.57 MB
Workbench v
Running Since 2019-Mar-04 20:50:06 Max Process Memory 125.64GB
Build Date 2019-Feb-26 15:10:02 Version Information 11.3.00
Details
Aggregation State started Time Begin 2019-Feb-28 14:16:00
Session Free Pages 157 Time End 2019-Mar-06 16:45:23
Meta Fres Pages 37500 Session Rate Max 31564
Database Status Session Rate 0
Database Session Rate Database Session Free Space
Database Session Rate Max Database Session Volume Bytes

For the related procedure, see Monitor Service Details

This section displays the current generic statistics for the service.

Description

Aggregation  State of data aggregation.
State

Time Begin Time (UTC) when the first session was tracked by the index.

Session Free ~ Session pages available for aggregation.

Pages

Time End Time (UTC) when the last session was tracked by the index.
Meta Free Pages available for aggregation.

Pages

Session Rate ~ Maximum sessions per second rate.
Max
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Database
Status

Session Rate

Database
Session Rate

Database
Session Free
Space

Database
Session Rate
Max

Database
Session
Volume Bytes

Status of databases. Valid values are:

e closed - not available for QUERY and UPDATE (databases are being initialized).
This value is seldom seen.

e opened - available for QUERY and UPDATE.

e failure - failed to open. This can happen for any number of reasons. You can
check this if CAPTURE fails to start or if queries fail to return data. This is
normally caused by database corruption.

Sessions per second rate.

Per second rate at which the service is writing sessions to the database.

Amount of session free space available for aggregation.

Maximum per second rate at which the service is writing sessions to the database.

Number of session bytes in the database.
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Broker Details View

The Broker Details view provides information about the Broker. The following figure shows the Broker
details.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings DEVEEGRANEIGEC adminserver @

HOST AND SERVICES Broker Details

Host
Service
I Broker
cPU 0.8% Used Memol 292.20 MB
Reporting Engine Y
Running Since 2022-Aug-08 09:30:54 Max Process Memory 62.92GB
Orchestration Server
Build Date 2022-Aug-04 05:31:48 Version Information 12.1.0.0
Security Server
Admin Server Details
Config Server Aggregation State started Meta Rate 367
Investigate Server Session Rate 0 Meta Rate Max 172058
Session Rate Max 5072

Respond Server
Integration Server
Content Server

Source Server

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Meta Rate Metadata objects per second rate.

Session Rate Sessions per second rate.

Meta Rate Max Maximum metadata objects per second rate.

Session Rate Max Maximum sessions per second rate.
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Concentrator Details View

The Concentrator Details view provides information about the Concentrator. The following figure shows
the Concentrator details.

NETWITNESS L D: eports admin v

Hc s Endpoint Sources  Health & Wellnes

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver concentrator @

HOST AND SERVICES .
: Concentrator Details
Host

Service
I Concentrator
CcPU 1.4% Used Memory 17057 MB
Running Since 2019-Feb-01 04:47:17 Max Process Memory 7.80GB
Build Date 2019-Jan-28 18:52:20 Version Information 11.3.00
Details
Aggregation State started Time Begin 2016-Jun-24 06:19:03
Meta Rate o Time End 2019-Feb-01 20:21:02
Meta Rate Max 238
Session Rate 0
Session Rate Max ]

For the related procedure, see Monitor Service Details

The section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Time Begin Time (UTC) when the first session was tracked by the index.
Meta Rate Metadata objects per second rate.
Time End Time (UTC) when the last session was tracked by the index.

Meta Rate Max Maximum metadata objects per second rate.
Session Rate Sessions per second rate.

Session Rate Max Maximum sessions per second rate.
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Decoder Details View

The Decoder Details view provides information about the Decoder. The following figure shows the
Decoder details.

Users  Hosts es  Dashboard  Reports

NETWITNESS Investigate  Respond

\DPOINT SO HEALTH & WELLNESS

Alarms  Monitoring ~ Policies  System Stats Browser ~ Event Source Monitoring ~ Settings  New Health & Wellness IS

HOST AND SERVICES Decoder Details
Host

Service

| pecoder

Warehouse Connector o 0% Used Memory 72778
Running Since 2021-May-01 15:26:57 Max Process Memory 7.80 GB
Build Date 2021-Apr-05 16:52:31 Version Information 11.6.0.0
Details
Capture Status stopped Meta Bytes Obytes
Capture Kept 0bytes Meta Total o
Capture Dropped o Packet Bytes 0 bytes
Capture Dropped Percent 0% Packet Total ]
Capture Rate o Session Bytes 0bytes
Capture Rate Max o Session Total o
Time Begin Pool Packet Write o
Time End Pool Packet Assembler [

13

Assembler Packet Pages 0 Pool Packet Capture

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:

S e starting - Starting data capture (not capturing data yet).

* started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

¢ stopped - Not capturing data.
e disabled - Not configured as a Decoder service.
Meta Bytes  Number of meta bytes in the database.

Capture Number of packets kept during capture.
Kept

Meta Total  Amount of metadata in the database.

Capture Number of packets reported by the network card as dropped. After the service stops
Dropped capturing data, the rate is reset to zero.

Packet Number of packet bytes in the database.

Bytes
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Capture Packets reported by the network card as dropped as a percentage.
Dropped
Percent

Packet Total Number of packet objects held in the packet database. The total decreases when the
database rolls files off due to size constraints. After the service stops capturing data, the
number is not reset.

Capture Megabits per second rate at which the service is capturing data. Rate is a rolling average
Rate sample over a short time period (10 seconds). After the service stops capturing
data, rate is reset to zero.

Session Number of session bytes in the database.

Bytes

Capture Maximum megabits per second rate at which the service is capturing data. Rate is a
Rate Max rolling average sample over a short time period (10 seconds). After the service stops

capturing data, displays the maximum rate during data capture.

Session Number of sessions held in the session database. This value shrinks when the database
Total rolls files off due to size constraints. After the service stops capturing data, the number
1S not reset.

Time Begin Time when first packet was captured (time when the first packet was stored in the
packet database). This time increases as packets are rolled out of the packet database.

Pool Packet Number of packet pages currently in the PCS pipeline that need to be written to the
Write database.

Time End Time when the last packet was captured (time when packet was written to the database).
The time increases as new packets are captured.

Pool Packet Number of pool packet pages waiting to be assembled.
Assembler

Assembler ~ Number of packet pages waiting to be assembled.
Packet
Pages

Pool Packet Number of packet pages available for capture.
Capture
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ESA Correlation Details View

The ESA Correlation Details view provides information for the ESA Correlation service. The
following figure shows the ESA Correlation service details.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES ~ HEALTH & WELLNESS SYSTEM SECURITY

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring  Settings  New Health & Wellness [REEESetueyl]

HOSTAND SERVICES esaaprimary - ESA Correlation Details
Host

Service
Contexthub Server

. 0.8% 4.40GB
I ESA Correlation U Used Memory

Running Since 2022-Aug-08 09:49:48 Max Process Memory 314268
Build Date 2022-Aug-03 05:53:54 Version Information 12.1.00
Health Stats Jvm
Configuration Update Status Healthy Process Modules Healthy
Process JVM Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy

For the related procedure, see Monitor Service Details.

Many services, including the ESA Correlation service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The JVM
tab shows the total memory used by the selected service and the total memory capacity of the host.

For more information on the ESA Correlation service and ESA Rule memory usage, see the Alerting
with ESA Correlation Rules User Guide.

Health Stats Tab

The Health Stats tab provides information about the health status of the selected service.

Health Stats VM

Configuration Update Status Healthy Process Modules Healthy
Process JVM Memary Healthy Security PKI Certificate Healthy

Data Connection Healthy

The services on this tab can show one of three states:
e Healthy: The service is healthy.
e Unhealthy: The service is mostly functional, but it needs attention to mitigate potential down time.

e Fatal: Action needs to be taken to restore the service.

Description

Configuration  Indicates whether the service requires a restart for configuration changes to take
Update Status  effect. If the Configuration Update Status shows as Unhealthy, restart the service.
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e

Process JVM Indicates the memory usage status. An Unhealthy status occurs when heap memory

Memory usage is greater than or equal to 80%. A Fatal status occurs when heap memory
usage is greater than or equal to 95%. If the service is using too much memory, you
can add more memory or move services to other hosts. For more details on memory
usage, go to the JVM tab.

Data Indicates the health of the database connection of the service to MongoDB.
Connection

Process Indicates the health of the service. If a service is starting up, it shows as Unhealthy
Modules since its health is not yet determined. A service is Healthy if it is up and running

properly. A service shows as Fatal if it is running in upgrade mode or if the service
is running in safe or degraded mode.

Security PKI Indicates the service certificate health. It shows as Healthy if a given X509
Certificate certificate is self-signed.

JVM Tab

The JVM tab shows the total memory used by the selected service and the total memory capacity of the
host.

Health Stats VM

VM Total Memory Max 64.00 GB WM Total Memory Used 2310 GB

m

JVM Total Memory Max  Shows the total memory capacity for the entire host.

JVM Total Memory Used Shows the total memory used by all services and processes on the host.
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ESA Analytics Details View

The ESA Analytics Details view provides health status information about the selected ESA Analytics
service. ESA Analytics services process the data for automated threat detection. It is important that you
address any item that shows a status other than healthy, so that data processing is not interrupted and
critical events are not missed.

The following figure shows the ESA Analytics Details view.

NETWITNESS NV e Re: e Users osts Files Dashboard admin w

HEALTH & WELLNESS SECURITY

Alarms Monitoring Policies Systemn Stats Browser  Event Source Monitoring Settings NEREETGRNE G NWAPPLIANCE10604 @

Event Stream Analytics Server Details
Host

Service

Event Stream Analysis
CPU 0.1% Used Memory 653.36 MB

Contexthub Server ’
Running Since 2021-Apr-30 13:07:44 Max Process Memaory 31.42GE

ity Behavior Analyt .
I BV o e e Build Dats 2021-Apr-05 16:51:58 Version Informaticn

Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process JVW Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy

For the related procedure, see Monitor Service Details.

Many services, including the ESA Analytics service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The JVM
tab shows the total memory used by the selected service and the total memory capacity of the host. For
more information, see Health Stats Tab and JVM Tab.

For more information on ESA Analytics, see the Automated Threat Detection Guide and the ESA
Configuration Guide.
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Host Details View

The Host Details view provides information about a host, as shown in the following figure.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings INEWRSEETGRAVEIGES adminserver @

HOST AND SERVICES

Host Details
I Host
System Info
Broker
Host dminserver Memory Utilization 84.54%
Reporting Engine
cpU 4345 Used Memory 53.19GB
Orchestration Server
Running Since 2022-Aug-08 08:35:24 Total Memory 629268
Security Server Current Time 2022-5ep-26 11:10:01 Cached Memory 1081 GB
el Sy Uptime 7 weeks 2 hours 34 minutes 37 seconds Swap Utilization 0:09%
System Info Used Swap 3.51 MB
Linux 3.10.0-1160.71.1./7.x86_64 x86_64
Config Server nax €170 6A X0 Total Swap 4.00GB
Investigate Server
Respond Server Physical Drive | Logical Drive  File System Adapter Message Bus
Integration Server State Enclosure slot Failure Count Raw Size Inquiry Data

Content Server

Source Server

The options panel on the left displays the host and the services installed on the host. You can click on a
host or service to view the statistics and other pertinent information for that host or service.

The Details panel displays information that is specific to the host and provides additional information
regarding the hardware of the host.

For the related procedure, see Monitor Service Details

The top section displays the current performance, capacity, and historical statistics for the host.

Parameter Description

Host Hostname.

CPU Current CPU usage of the host.

Running Since Time when the host was started.
Current Time Current time on the host

Uptime Time for which the host has been active.
System Info OS version installed on the host.

Memory Utilization Percentage of memory utilized by the host.
Used Memory Memory used in GB.

Total Memory Capacity of the memory installed on the system.
Cached Memory Memory that is cached to disk in GB.
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Swap Utilization Percentage of system swap in use.
Used Swap Swap used in GB.
Total Swap Capacity of the swap installed on the system.

The lower section displays the current generic statistics for the host in the tabs described in the following
table.

Physical ~ Type of physical drive, its usage and additional information of the physical drive on the
Drive host.

Logical Logical drive on the host.
Drive

File File system information, the size, current usage, and available capacity on the host.
System

Adapter Adapter used on the host.

Message  Publish In Rate - rate at which incoming messages are published to the message bus

Bus queue.
Total Messages Queued - number of messages in the message queue.
Memory Used - amount of memory used by the message bus (in bytes).
Disk Free - free disk space available for the message bus (in bytes).
Memory Limit - system memory limit. If the memory usage exceeds this value, this trips
the Memory Alarm and NetWitness stops accepting messages.
Disk Free Limit - limit of free disk space available for the message bus. If the available
disk space falls below this value, this trips the Disk Free Alarm and NetWitness stops
accepting messages.
Memory Limit Available - Amount of memory available to this message broker (in bytes)
before the Memory Used Alarm is tripped.
Disk Limit Available - Amount of free disk space available to this message broker (in
bytes) before the Disk Free Limit alarm is tripped.
Disk Free Alarm - True or False. True indicates that the available disk space is below the
value set in Disk Free Limit and NetWitness has stopped accepting messages.
Memory Alarm - True or False. True indicates that the available memory is below the
value set in Memory Limit and NetWitness has stopped accepting messages.
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Log Collector Details View

The Log Collector Details view provides information for the Log Collector. The following figure depicts
the Log Collector Details.

NETWITNESS Investigate Respond Users Hosts es Dashboard Reports

EVENT SOURC POINT SOURC HEALTH & WELLNESS URITY

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring ~ Settings  New Health & Wellness [ NS ]

HosTADBEREE Log Collector Details
Host

Service
| Log collector
cpu 1.4% Used Memory 16268 MB
Log Decoder Y
Running Since 2021-May-01 15:16:50 Max Process Memory 78068
Warehouse Connector
Build Date 2021-Apr-23 16:24:32 Version Information 11.6.0.0

Collection  Event Processing

Transport Protocol status EPS Total Events Errors Warnings.
checkpoint stopped 0 0 0 0 -
logstash stopped 0 0
netflow stopped 0 0 0 0
file stopped 0 0 0 0
sdee stopped 0 0 0 0
odbe stopped 0 0 0 0
vmware stopped o 0 0 0
syslog stopped 0 0 0 0 .

For the related procedure, see Monitor Service Details.

The lower section consists of the Collection and Event Processing tabs that display generic statistics for
the service.

Collection Tab

Displays the event collection statistics for each Log Collection protocol you have implemented in
NetWitness (see "Log Collection Getting Started Guide" in the Log Collection Guides).

Event Processing Tab

Displays statistics for the NetWitness internal event processing protocol (that is, the Log Decoder) for
Log Collection.

Parameter | Description

Transport NetWitness protocol use for Log Collections (that is, the Log Decoder).
Protocol
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Status

EPS

Total Events
Errors
Warnings

Byte Rate

Status of the Log Decoder. Valid values are:
e starting - Starting data capture (not capturing data yet).
e started - Capturing data.

* stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

e stopped - Not capturing data.

e disabled - Not configured as a Decoder service.

Rate (events per second) at which this the Log Decoder is processing events from the
Log Collector.

Total events processed by the Log Decoder.
Number of errors encountered.
Number of warnings encountered.

Current throughput in bytes per second.

247



System Maintenance Guide

Log Decoder Details View

The Log Decoder Details view provides information for the Log Decoder. The following figure shows
the Log Decoder Details.

NETWITNESS Investigate ~ Respond ~ Users  Hosts es  Dashboard  Reports

HEALTH & WELLNESS

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring ~ Settings  New Health & Wellness [t ]

HosT D sEREE Log Decoder Details
Host

Service
Log Collector

CcPU 0.5% Used Memor 1.60 GB
| Log Decoder 4
Running Since 2021-May-01 15:09:58 Max Process Memory 7.80 GB

Warehouse Connector
Build Date 2021-Apr-05 16:52:38 Version Information 11.6.0.0

Details

Capture Status stopped Packet Rate Max
Events Per Second Pool Packet Capture

Meta Rate

o o o o

Meta Rate Max

Pool Packet Write

Capture Dropped
Capture Dropped Percent 0% Time Begin
Time End

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

e o

Capture Status of data capture. Valid values are:

Stiime e starting - Starting data capture (not capturing data yet).

e started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

e stopped - Not capturing data.

e disabled - Not configured as a Log Decoder service.

Packet Rate Maximum per second rate at which the service is writing packets to the database. Rate
Max is a rolling average sample over a short time period (10 seconds). After the service stops
capturing data, displays the maximum rate during data capture.

Events Per  Rate (events per second) at which the Log Decoder is processing events from the Log
Second Collector.

Pool Packet Number of packet pages available for capture.
Capture

Meta Rate Per second rate at which the service is writing metadata objects to the database. Rate is
a rolling average sample over a short time period (10 seconds). After the service stops
capturing data, rate is reset to zero.
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Pool Packet
Assembler

Meta Rate
Max

Assembler
Packet
Pages

Capture
Dropped

Pool Packet
Write

Capture
Dropped
Percent

Time Begin

Time End

Number of packet pages waiting to be assembled.

Maximum per second rate at which the service is writing metadata objects to the
database. Rate is a rolling average sample over a short time period (10 seconds). After
the service stops capturing data, displays the maximum rate reached during data capture.

Number of packet pages waiting to be assembled.

Number of packets reported by the network card as dropped. After the service stops
capturing data, rate is reset to zero.

Number of packet pages in the PCS pipeline that need to be written to the database.

Packets reported by the network card as dropped as a percentage.

Time when first packet was captured (time when the first packet was stored in the
packet database). This time increases as packets are rolled out of the packet database.

Time when the last packet was captured (time when packet was written to the database).
The time increases as new packets are captured.
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Malware Details View

The Malware Details view provides information for Malware Analysis. The following figure shows the
Malware Details.

NETWITNESS n Respond Users Hosts d Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness  adminserver

HOST AND SERVICES L
Malware Details
Host
Service
Broker
cPU 0.2% Used Memory 4.37GB
| Malware Analysis ’ i
Running Since 2021-Apr-30113:07:44 Max Process Memory 15.67 GB
Build Date 2021-Apr-05 16:51:58 Version Information 11600
Events B
Number Of Events For Past 24 Hours 2 Average Processing Time 0 milliseconds
Number Of Files For Past 24 Hours 2 Events In Queue
Number Of Past 7 Days 2 Events Processed
Number Of Files For Past 7 Days 2 Events Per Second Throughput
Number Of For Past Month 2 Session Time Of Last Event
Number Of Files For Past Month 2
Number Of Past3Months 2
Number Of Files For Past 3 Months 2

For the related procedure, see Monitor Service Details.

Displays the following event-related statistical information for the Malware Analysis service.
e Number of events for the past 24 hours
* Average processing time

* Number of files for the past 24 hours

e Events in queue

e Number of events for the past 7 days

e Events processed

e Number of events for the past 7 days

e Events per second throughput

e Number of events for the past month

» Session time of the last event

* Number of files for the past month

e Number of events for the past 3 months

e Number of files for the past 3 months
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Warehouse Connector Details View

The Warehouse Connector Details tab provides information for the Warehouse Connector, such as the

date it was built, CPU, and version information. The following figure shows the Warehouse Connector
Details.

NETWITNESS ve e Respond Users Hosts Dashboard Reports

admin v

HOSTS SERVICE EVENT SOURCE ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM CURITY

Alarms  Monitoring  Policies  System Stats Browser Event Source Monitoring ~ Settings  New Health & Wellness [ e ]

Warehouse Connector Details

Host
Service
Log Collector
Py 03% Used Memon 204318
Log Decoder 4
Running Since Max Process Memory 7.80GB
| warenouse connector
Build Date 2021-Apr-05 20:01:25 Version Information 11.6.0.0
Details
Streams Complete 0 Streams Running 0
Streams Incomplete 0 Streams Stopped 0
Streams Total 0

For the related procedure, see Monitor Service Details.
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Policies View

The required permission to access this view is Manage services.

What do you want to do?

Administrator View the policies NetWitness Server and Services Manage Policies

Administrator Add, Edit, Duplicate, and Delete Policies Manage Policies

Quick Look

The figure depicts the Policies view.

NETWITNESS

Ve HEALTH & WELLNESS

Alarms Monitorin ; Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness

Policies Admin Server: Admin Server Monitoring Policy
+ ZI B Rules and suppression schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to 50 modify them
™ Enable Last Modified: 2017-02-20 12:00:00 AM
4 Admin Server [
@& Admin Server Monitoring Policy Services
» Dl Archiver o Choose the hosts, services, and groups that your health policy applies to.
» Clroker o +
» (3 concentrator o [ Name ~ Group Type o
1Al 10 Grou
» [ Config Server [ P
» O content Server [ Rules
» [ Contexthub Server o Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define
the alarm rule, enable or disable the alarm
» (JDecoder [
» [J€sA Correlation [
[J Enable Name ~ Severi Categor Statistic Threshold
ty gory
» CJendpoint Broker Server o N
] ®  Admin Server in Critical... ~Critical Processinfo Overall Processing Status Indicator Alarm = ERROR for 2 MINUTES
» Cendpoint server o ] @  AdminServerinUnheal.. High Processinfo Overall Processing Status Indicator Alarm = PARTIALLY_WORKING for 2 MINUTES
» Ol Host [ ] ®  Admin Server Stopped Critical Processinfo Service Status Alarm 1= started for O MINUTES
‘ y v
» D integration Server o
» Dl investigate Server o Policy Suppression
» Dl Log Collector o Define the time periods to suppress policies.
» [ Log Decoder o -

Policies Panel
Policy Detail Panel

4
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

Policies Panel

In the Policies panel, you can add or delete policies for hosts and services in this panel.

Description

+ - Displays available service types to create a new policy. Select one so that you can define
a policy or policies for it.
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e Jowemn

N

LY
C]

Deletes the selected policy from the Policies panel. You can only delete one policy at a
time.

Allows you to change the name of the policy.

Creates a copy of the selected policy. For example, if you select First Policy and click
=) NetWitness creates a copy of this policy and names it First Policy (1).

Expands the list of policies under the services and hosts in the Policies panel.

Contracts the list of policies under the services and hosts in the Policies panel.
List of:
¢ Services and hosts for which you have defined policies.

¢ NetWitness standard policies that you can apply to hosts and services.

Policy Detail Panel

The Policy Detail panel displays the policy selected from the Policies panel.

Fetrs owrten

Save
Policy Type

Modified
Date

[] Enable

Services

L

Rules

Saves any changes you made in this panel.
Displays the type of policy you selected.

Displays the last date this policy was modified.

Enables or disables the policy.

Displays menu in which you select:

¢ Groups to display the Groups dialog from which you select service groups to this
policy.

e Service/Host to display the Services/Hosts dialog from which you select services to
add to this policy. If the policy type is Host, the menu displays Host (and not
Service). You can select services based on policy type.

Deletes the selected service or group from this policy.

Displays the Add Rule dialog in which you define a rule for this policy.
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e Jowan

4

Deletes the selected rule from this policy.

Displays the Edit Rule dialog for the selected rule.

Policy Suppression

=+

Time Zone

O

Days

Time Range

Notification

-+

Notification
Settings

O

Output

Recipient

Notification
Server

Template

Adds a policy suppression timeframe row.
Deletes the selected policy suppression timeframe row.

Selects the time zone for the Policy from the drop-down list. This time zone applies to
both Policy Suppression and Rule Suppression.

Selects the checkbox to select a policy suppression timeframe row.

Days of the week that you want to suppress the policy according to the time range
specified. Click on the day of the week that you want to suppress the policy. You can
select any combination of days including all days.

Time range during which the policy is suppressed for the days selected.

Adds an EMAIL notification row.
Deletes the selected policy suppression timeframe row.

Opens the Notification Servers view in which you can define the Email notification
settings.

Selects a policy suppression time frame row.

The type of notification defined on the Global Notifications page. Can be email,
SNMP, Syslog, or Script.

The name of the person receiving the notification.

Selects the EMAIL notification server. See "Configure Notification Servers" in the
System Configuration Guide for the source of the values in this drop-down list.

Selects the Template for this EMAIL notification. NetWitness provides the Health &
Wellness Default SMTP Template and the alarms template. See" Configure
Notification Templates"in the System Configuration Guide for the source of the other
values in this drop-down list.

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.
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Groups dialog

P Josscipten

Groups panel

Name Displays the service groups you have defined. You can select:
e All to display all your services in the Services panel.

e A group to display the services in comprise that group in the Services

panel.
Services panel
Name Displays the name of the service.
Host Displays the host on which the service is running.
Type Displays the type of service.

Rules Dialog

e

1 Enable Enables or disables the rule for this policy.

Name Describes the name of the rule.
Description ~ Describes the rule. Include the following information in this field.

o Informational description - purpose of the rule and what problem it monitors.

o Remediation - steps to take to resolve the condition that triggers the alarm for this
rule.

Severity Defines the severity of the rule. Valid values are:
* Critical
e High
* Medium

e Low
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e o

Statistic

Alarm
Threshold

Recovery

Defines the statistics you want to check with this rule. You can select:
¢ Statistical category from the left drop-down list.
e Statistic from the right drop-down list.

Note: For Public Key Infrastructure (PKI) policy, select PKI in the category and
statistics as any one of the following:

- NetWitness Server PKI Certificate Expiration - Displays the time left before the
certificate expires.

- NetWitness Server PKI CRL Expiration - Displays the time left before the
Certificate Revocation List (CRL) expires.

- NetWitness Server PKI CRL Status - Displays the current status of the CRL.

Refer to the System Stats Browser View for examples of the statistics you may want to
check with a rule.

Defines he threshold of the rule that triggers the policy alarm:

o Amount

Note: For CRL expiry the supported format is ddddhhmm, for example:
- 10000 represents 1 day

- 2359 represents 23 hours and 59 minutes

- 10023 represents 1 day and 23 minutes

- 3650100 represents 365 days and 1 hour

e Time in minutes

Defines when to clear the threshold of the rule:

o Operator

¢ Amount

¢ Time in minutes

Rule Suppression

.

O

Time Zone:
time-zone

Days

Time Range

Adds a rule suppression timeframe row.
Deletes the selected rule suppression time frame row.

Selects a rule suppression time frame row.

Displays the Policy time zone. You select the time zone for a policy in the Policy
Suppression panel.

Defines days of the week that you want to suppress the rule according to the time range
specified. Click on the day of the week that you want to suppress the rule. You can
select any combination of days including all days.

Defines the time range during which the rule is suppressed for the days selected.
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Threshold Operators

The Alarm Threshold and Recovery Threshold fields in the Rules dialog prompt you for either
numeric or string operators based on the statistic criteria you specify.

Numeric operators drop-down menu:

o

String operators drop-down menu:

L

=

nRange

llnRange

St

Contains
IContains
Regex Match

IRegex Match
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Health & Wellness Email Templates

Note: Please refer to Include the Default Email Subject Line if you want to include the default Email
subject line from the Health & Wellness template in your Health & Wellness Email notifications for
specified recipients.

Health & Wellness Default SMTP Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off on HOST1000

State
Active

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Palicy
Check Point

Rule
File Collection Service is off

Statistic
Collection State

Value

stopped

Time
April 13, 2018 10:48:13 PM UTC
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Alarms Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off onHOST1000

State
Cleared

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
BootCamp Notification

Rule
Check Point Collection is off

Statistic
Collection State

Value

Policy-Disabled

Time

April 14, 2018 2:31:21 AMUTC
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NetWitness Platform Out-of-the-Box Policies

The following table lists the NetWitness Out-of-the-Box Policies with the rules defined for each policy.
You can perform the following tasks on any of these policies:

¢ Change service and group assignments.

¢ Disable or enable policies.

You cannot perform the following tasks on any of these policies:
¢ Delete them.

¢ Edit Policy names.

Note: Additional information about the Out-of-the-Box Policies can be found in the User Interface

under
Health & Wellness > Policies.

Policy Name Alarm Triggered

Communication Failure Host is down, Network is down, Message Broker
Between Master NetWitness is Down, or Invalid or missing security
Server Host and a Remote Host  certificates for 10 minutes or more.
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Policy Name Alarm Triggered

NetWitness
Server
Monitoring
Policy

Critical Usage on Rabbitmq
Message Broker Filesystem

Filesystem is Full

High Filesystem Usage

High System Swap Utilization

High Usage on
Rabbitmq Message Broker
Filesystem

Host Unreachable

LogCollector Event Processor
Exchange Bindings Status

LogCollector Event Processor
Queue with No Bindings

LogCollector Event Processor
Queue with No Consumers

Power Supply Failure
RAID Logical Drive Degraded

RAID Logical Drive Failed

RAID Logical Drive Rebuilding

RAID Physical Drive Failed

RAID Physical Drive Failure
Predicted

RAID Physical Drive
Rebuilding

RAID Physical Drive
Unconfigured

SD Card Failure

For var/lib/rabbitmg, Mounted Filesystem
Disk Usage goes over 75%.

Overall Mounted Filesystem Disk Usage reaches
100%.

Overall Mounted Filesystem Disk Usage goes
over 95%.

Swap Utilization goes under 5 % for 5 minutes
or more.

Mounted Filesystem Disk Usage for
var/lib/rabbitmg goes over 60%.

Host down.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Host not receiving power.

For Raid Logical Drive, Drive State equals
Degraded or Partially Degraded.

For Raid Logical Drive, Logical Drive State
equals Offline, Failed, or Unknown.

For Raid Logical Drive, Logical Drive State
equals Rebuild.

For Raid Physical Drive, Physical Drive
State does not equal Online, Online Spun Up, or
Hotspare.

For Raid Physical Drive, Physical Drive
Predictive Failure Count is greater than 1.

For Raid Physical Drive, Physical
Drive State equals Rebuild.

For Raid Physical Drive, Physical
Drive State contains Unconfigured (good).

SD Card Status does not equal ok.

261



System Maintenance Guide

Policy Name Alarm Triggered

NetWitness

Archiver
Monitoring
Policy

NetWitness
Broker
Monitoring
Policy

NetWitness

Concentrator
Monitoring
Policy

Archiver Aggregation Stopped
Archiver Database(s) Not Open

Archiver Not Consuming From
Service

Archiver Service in Bad State
Archiver Service Stopped

Broker >5 Pending Queries

Broker Aggregation Stopped

Broker Not Consuming From
Service

Broker Service in Bad State
Broker Service Stopped

Broker Session Rate Zero

Concentrator >5 Pending
Queries

Concentrator Aggregation
Behind >100K Sessions

Concentrator Aggregation
Behind >1M Sessions

Concentrator Aggregation
Behind >50M Sessions

Concentrator Aggregation
Stopped

Concentrator Database(s) Not
Open

Concentrator Meta Rate Zero

Concentrator Not Consuming
From Service

Concentrator Service in Bad
State

Concentrator Service Stopped

Archiver Status does not equal started.
Database Status does not equal opened.

Devices Status does not equal consuming.

Service State does not equal started or ready.
Server Status does not equal started.

Queries Pending greater than or equal to 5 for 10
minutes or more.

Broker Status does not equal started.

Devices Status does not equal consuming.

Service State does not equal started or ready.
Server Status does not equal started.

Session Rate (current) equals 0 for 2 minutes or
more.

Queries Pending greater than or equal to 5 for 10
minutes or more.

Devices Sessions Behind is greater than or equal
to 100000 for 1 minute or more.

Devices Sessions Behind is greater than or equal
to 1000000 for 1 minute or more.

Devices Sessions Behind is greater than or equal
to 50000000 for 1 minute or more.

Broker Status does not equal started.

Database Status does not equal opened.
Concentrator Meta Rate (current) equals 0 for 2
minutes or more.

Devices Status does not equal consuming.

Service State does not equal started or ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness

Decoder
Monitoring
Policy

NetWitness
Event Steam
Analysis
Monitoring
Policy

NetWitness
IPDB
Extractor
Monitoring
Policy

NetWitness
Incident
Management
Monitoring
Policy

Decoder Capture Not Started

Decoder Capture Rate Zero

Decoder Database Not Open

Decoder Dropping >1% of
Packets

Decoder Dropping >10% of
Packets

Decoder Dropping >5% of
Packets

Decoder Packet Capture Pool
Depleted

Decoder Service in Bad State
Decoder Service Stopped

ESA Overall Memory
Utilization > 85%

ESA Overall Memory
Utilization > 95%

ESA Service Stopped
ESA Trial Rules Disabled

IPDB Extractor Service in Bad
State

IPDB Extractor Service Stopped

Incident Management Service
Stopped

Capture Status does not equal started.

Capture Rate (current) equals 0 for 2 minutes or
more.

Database Status does not equal opened.

Capture Packets Percent Dropped (current) is
greater than or equal to 1%.

Capture Packets Percent Dropped (current) is
greater than or equal to 10%.

Capture Packets Percent Dropped (current) is
greater than or equal to 5%.

Packet Capture Queue equals 0 for 2 minutes or
more.

Service State does not equal started or ready.
Server Status does not equal started.

Total ESA Memory Usage % is greater than or
equal to 85 %.

Total ESA Memory Usage % is greater than or
equal to 95 %.

Server Status does not equal started.
Trial Rules Status does not equal enabled.

Service State does not equal started or ready.

Server Status does not equal started.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness Log Log Collector Service Stopped
Collector

Server Status does not equal started.

Monitoring Log Decoder Event Queue > Number of events currently in the queue is using
Policy 50% Full 50% or more of the queue.
Log Decoder Event Queue > Number of events currently in the queue is using
80% Full 80% or more of the queue.
Log Collector Service in Bad Service State does not equal started or ready.
State
NetWitness Log Decoder Dropping>10% of Capture Packets Percent Dropped (current) is
Decoder Packets greater than or equal to 10%
Monitoring
Policy Log Capture Not Started Capture Status does not equal started.
Log Decoder Capture Rate Zero Capture Rate (current) equals 0 for 2 minutes or
more.
Log Decoder Database Not Database Status does not equal opened.
Open
Log Decoder Dropping >1% of  Capture Packets Percent Dropped (current) is
Logs greater than or equal to 1%.
Log Decoder Dropping >5% of  Capture Packets Percent Dropped (current) is
Logs greater than or equal to 5%.
Log Decoder Packet Capture Packet Capture Queue equals 0 for 2 minutes or
Pool Depleted more.
Log Decoder Service Stopped Server Status does not equal started.
Log Decoder Service in Bad Service State does not equal started or ready.
State
NetWitness Malware Analysis Service Server Status does not equal started.
Malware Stopped
Analysis
Monitoring
Policy
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Policy Name Alarm Triggered

NetWitness
Reporting
Engine
Monitoring
Policy

NetWitness
Warehouse
Connector
Monitoring
Policy

NetWitness
Workbench
Monitoring
Policy

Reporting Engine Alerts Critical
Utilization

Reporting Engine Available
Disk <10%

Reporting Engine Available
Disk <5%

Reporting Engine Charts
Critical Utilization

Reporting Engine Rules
Critical Utilization

Reporting Engine Schedule Task
Pool Critical Utilization

Reporting Engine Service
Stopped

Reporting Engine Shared Task
Critical Utilization

Warehouse Connector Service in
Bad State

Warehouse Connector Service
Stopped

Warehouse Connector Stream
Behind

Warehouse Connector Stream
Disk Utilization > 75%

Warehouse Connector Stream in
Bad State

Warehouse Connector Stream
Permanently Rejected Files >
300

Warehouse Connector Stream
Permanently Rejected Folder >
75% Full

Workbench Service in Bad State

Workbench Service Stopped

Alerts Utilization is greater than or equal to 10
for 5 minutes or more.

Available disk space is less than 10%.

Available disk space is less than or equal to 5%.

Charts Utilization is greater than or equal to 10
for 5 minutes or more.

Rules Utilization is greater than or equal to 10
for 5 minutes or more.

Schedule Task Pool Utilization is greater than or
equal to 10 for 15 minutes or more.

Server Status does not equal started.

Shared Task Pool Utilization is greater than or
equal to 10 for 5 minutes or more.

Service State does not equal started or ready.

Server Status does not equal started.

Stream Behind is greater than or equal to
2000000.

Stream Disk Usage (Pending Destination Load)
is greater than or equal to 75.

Stream Status does not equal consuming or
online for 10 minutes r more.

Number of files in the permanently rejected files
is greater than or equal to 300.

Rejected folder usage is greater than or equal to
75%.

Service State does not equal started or ready.

Server Status does not equal started.

265



System Maintenance Guide

System Stats Browser View

NetWitness provides a way to monitor the status and operations of hosts and services. The System Stats
Browser tab displays key statistics, service system information, and host system information for a host or
service.

You can customize the stats view depending on the parameter you select to filter the data.

To access the System Stats Browser view:

4
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

What do you want to do?

Administrator View the System Stat Historical Graph Historical Graph for System Stats

Related Topics

Monitor Service Statistics

Filter System Statistics

Quick Look

The System Stats Browser view is displayed.

NETWITNESS e  Respond Hosts ashboard Reports admin v

SERVICES  EVENT SOURCES  ENDP SOURCES ~ HEALTH & WELLNESS  SYSTEN SECURITY

Monitoring ~ Policies  [SVECIISEISINWERS uent source MONIONNG  Seiligs  New Heaili & weliess
Host Component Category Statistic Order By
Any v Any v Any v I cear ‘_‘u )
[IRegex [IRegex @Ahscending O Descending =3
o
Host Component. Category Statistic Subitem Value Last Update Historical Graph I
3
logdecoder Host FileSystem Error Status 0 2021-05-14 12:00:14 PM o 7
f
3.88 GB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage rdev 0 bytes used 2021-05-14 12:00:14 PM o
3.88 GB available
3.90 GB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage Irun 192.80 MB used 2021-05-14 12:00:14 PM o
3.71 GB available
3.90 GB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage Isysifs/cgroup 0 bytes used 2021-05-14 12:00:14 PM o
3.90 GB available
3.90GB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage Idevishm 400.00 KB used 2021-05-14 12:00:14 PM 0
3.90 GB available
9.99 GB size
logdecoder Host Filesystem Mounted Filesystem Disk Usage thome 3230 MB used 2021-05-14 12:00:14 PM 0
9.96 GB available
29.99 GB size
logdecoder Host Filesystem Mounted Filesystem Disk Usage i 5.53 GB used 2021-05-14 12:00:14 PM o
24.46 GB available
140.24 GB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage Ivar/netwitness 768.76 MB used 2021-05-14 12:00:14 PM o
139,49 GB available
1014.00 MB size
logdecoder Host FileSystem Mounted Filesystem Disk Usage /boot 75.84 MB used 2021-05-14 12:00:14 PM o
938.16 MB available -
| Page 1 ofd0 | ) N | C Items 1 - 50 of 1994

Displays System Stats Browser View
Toolbar used to filter and customize the System Stats Browser View
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Note: Historical graphs are enabled, and can be displayed, for statistics with numeric values. However,
historical graphs are disabled for statistics with string values, for example, Health checks (Healthy),
and are displayed as gray in the UL

Filters

This table lists the various parameters you can use to filter and customize the System Stats view.

Host Select a host from the drop-down menu to display the stats of the selected host.
Select Any to list all the available hosts.

Component Select a component from the drop-down menu to display the stats for the selected
component.
Select Any to list out all the components on a selected host.

Category Type the category to display the stats for the required category.
Select Regex to enable Regex filter. It performs a regular expression search against
text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.

Statistic Type the statistic to display the required statistic on all the hosts or components.
Select Regex to enable Regex filter. This performs a regular expression search
against text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.

Order By Select the order in which the list needs to be filtered.
Select Ascending to filter the list it in an ascending order.

Commands
_
Apply Click to apply the filters chosen and display the list accordingly.
Clear Click to clear the chosen filters.

System Stats View Display

Displays statistics, service system information, and host system information for a host or service.
Access Stats Details

Select one of the stats and click Stats Details on the right hand side of the panel.

The Stats details panel opens with details of the selected stats.
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Stat Details
Hostname
Component IC

Lomponent

Category
Last Updated Time

Value

ctat rollertor ver
Sl LI Wi

A

viulti Walu

it

111Conc

meszagebus

MessageBus

Mode Sockets Used
rabbit@b619194b-60a2-4508-25c4-4eh53df02 eed

meszagebus_localhost

Zauge
rabbit@be19194b-6ba2-4508-35c4-
4ah53df02eed_sockets_used

Mumber sockets used by this message broker.
MessageBus

2019-02-01 07:31:55 PM

6

6.0

b519194b-6ba2-4508-95cd-
4eh53df02eed/messagebus_localhost/zauge-
rabbit@be15154b-6ba2-4508-95c4-
42p53df02eed _sockets_used

b519194b-6ba2-4508-95cd-
deh33df0Zesd/messagebus_localhost/igauge-
rabhit@b615194b-6ba2-4508-85c4-
deh53dfi2eed sockets_used

11.3.0.0

false
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New Health & Wellness Tab

In New Health & Wellness tab, you can filter alerts (monitors) and add the notifications which sends a
notification message when an alert is triggered, suppress the notification for a time period and pivot to
New Health and Wellness dashboards.

To access this view:

Q
1. Goto (Admin) > Health & Wellness.

2. Click the New Health & Wellness tab.
The figure depicts the New Health & Wellness view.

What do you want to do?

Administrator Manage Notification Manage Notification and Suppression

Administrator Manage Suppression Manage Notification and Suppression

Related Topics

Monitoring through Dashboards

Monitoring through Alerts

Managing Notifications

Quick Look

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness Z
—_—ee — ———————
Y Filters Pivot to Dashboard View Notifications Settings

SUPPRESSION APPLIED MONITOR NAME TRIGGER NAME SEVERITY SUPPRESSION

O Show Only Suppression Applied
Archiver Aggregation Stopped Aggregation Stopped Critical

MONITOR NAME Archiver Service in Bad State Bad State Critical

Equals

Broker >5 Pending Queries More than 5 Pending Queries Medium

TRIGGER NAME Broker Aggregation Stopped Aggregation Stopped Critical

Equals ge

(m]

[m]

[m]

[m]

[m]

[0 Broker Service in Bad State Bad State Critical
SEVERITY 00 Broker Session Rate Zero Session Rate is O Critical
O Concentrator >5 Pending Queries More than 5 Pending Queries Medium
O  Concentrator Aggregation Stopped Aggregation Stopped Critical
O  Concentrator Database(s) Not Open Database(s) Not Opened Critical
[m]

Concentrator Invalid Rule(s) Detected Rule Error Count >0 Medium

I Notification Panel: You can view the list of alerts (monitors) along with the trigger name,
severity and suppression.

Monitor Name - Name of the monitor.
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suppression policy is applied.

Filters Alerts. You can filter alerts on Suppression Applied, Monitor Name, Trigger Name, and
Severity. To reset filters, click Reset,

Pivot to Dashboard. You can view New Health and Wellness Dashboards. For more
information, see Accessing New Health and Wellness Dashboards.

View Notification Settings. You can define notification settings which sends a notification
message when an alert is triggered. For more information, see Adding Alert Notifications.

View Suppression Policy. You can suppress notifications for a time period by specifying a
suppression policy. For more information, see Suppressing Notifications,

Trigger Name - Name of the trigger.

Severity - Severity assigned to the alert. The options are Critical, High, Medium, and Low.

Suppression - Indicates whether suppression policy is applied or not. Green tick indicates
4
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System View - System Info Panel

This topic describes the System Information panel, which displays information about the system version
and license status.

The required role to access this view is Manage System Settings.

To access this view, do one of the following:
Q
* Goto (Admin) > System.
The System Information panel is displayed by default.

¢ When you receive a notification that a new version of NetWitness is available in the Notifications
tray, click View.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

I Info . .
Version Information
Upekizs Current Version 12
Licensing Current Build 2310
Email License Server ID 005C
Global Notifications
Legacy Notifications Customer Experience Improvement Program

System Logging The NetWitness Platform Customer Experience Improvement Program (CEIP) is a voluntary program that collects information about

Global Auditin how people use NetWitness Platform. The CEIP collects usage data without interrupting users or personally identifying users. The
g information that is collected helps RSA improve the features that are used most often and create solutions to common issues. Below,
655 you can change the CEIP participation preference for this installation of NetWitness Platform.

If you choose not to participate, certain in-product help features, such as guides and help center, as well as opportunities to provide

L nevlees feedback and input on the product will not be available.

URL Integration
Learn more about what information is being collected.

Context Menu Actions
[¥ 1 agree to participate in the NetWitness Platform CEIP.
Investigation

HTTP Proxy Settings
NTP Settings

Dashboard Settings

The Version Information section displays version information about the version of NetWitness that is
currently installed. The following table describes the features of the Version Information section.

Description

Displays the version of NetWitness that is currently running. The format of the version is
major-relase.minor-release.stability-id. build-number, Possible values for the stability-id
are:

e 1 - Development

Current

Version 2 - Alpha
e 3 -Beta
e 4-RC
¢ 5-QGold
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Current
Build

License

Server ID

License
Status

Identifies the current build revision for use in troubleshooting situations.

Each client host is shipped with the Local Licensing Server (LLS) installed to manage host
licenses. This field indicates whether the LLS is installed for this instance of NetWitness,

e When the LLS is installed, the Licensing Server ID is displayed.

¢ Unknown indicates that the LLS is not installed.

Indicates whether or not the license is enabled. If the license is:

e Enabled, Enabled is displayed in this field and there is a Disable button to the right so
you can disable it.

¢ Disabled, Disabled is displayed in this field and there is an Enable button to the right
S0 you can enable it.

272



System Updates Panel - Settings Tab

System Updates Settings tab describes the interface you use to set up a connection to Live Update
Repository. These settings ensure that the NetWitness can reach the Live Update Repository and
synchronize it with your Local Update Repository.

The required permission to access this view is Apply System Updates.

To access this view:

Q
1. Goto (Admin) > System.
2. Select Updates.

What do you want to do?

Administrator ~ Automatically download Enable automatic synchronization with the NetWitness
updates update repository.

Related Topics

Manage NetWitness Platform Updates

Quick Look
The System Updates Settings panel is displayed.

Info

System Updates Settings

I Updates . H Configure Live account (required) l E

Configure proxy settings

Licensing
[# Automatically download information about new updates every day
Email
e Appl
Global Notifications
Legacy Notifications

System Logging

VR B W L

Displays System Update Setting Tab
Configure Account and Setting for Automatic Updates

Features

This table describes the features in the System Updates Settings panel.
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Configure Live account

Configure proxy settings

Automatically download
information about new
updates every day

Apply

Q
Displays the (Admin) > System > Live Services panel in which you
can configure your Live Account credentials if they are not configured.

QA
Displays the (Admin) > System > HTTP Proxy Settings panel in
which you can configure an HTTP proxy if it is not configured.

Select to enable automatic synchronization with the NetWitness update
repository. If there are new updates available, information will

automatically be displayed in the (Admin) > HOSTS panel.

Applies the settings in this tab.
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System Logging - Settings View

The NetWitness Settings view in the System Logging panel configures the size of the log files, the
number of backup log files maintained, as well as the default logging levels for the packages within

NetWitness. The "Configure Log File Settings" topic in the System Configuration Guide provides
detailed procedures.

To access the Settings tab:

1. Goto (Admin) > System.
2. In the options panel, select System Logging.

The System Logging panel opens to the Realtime tab by default.
3. Click the Settings tab.

What do you want to do?

Administrator ~ Configure the size of the See the "Configure Log File Settings" topic in the System
Log files Configuration Guide

Related Topics

System Logging - Historical Tab

System Logging - Realtime Tab

Quick Look

NETWITNESS

HOSTS  SERVICES  EVENT SOURCES

System Logging

Updates
Realtime | Historical | Settings
Li

Log Settings -

4194304
Global Notifications.

Legacy Notifications

ax # iles
Apply

Global Auditing

Jobs
Package Configuration
Live Services
28 com
URL
ntegration B[ Jgooglecode
Context Menu Actions

B[ Jmchange

Investigation

HTTP Proxy Settings

NTP Settings

Dashboard Settings
B850

Bl apache

[ atmosphere (WARN) d

Package
Log Level

] Reset recursively
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Displays System Logging Panel
Displays Settings Tab
Configure Log Settings
Configure Packages

Features

The Settings tab has two sections: Log Settings and Package Configuration.

Log Settings

The Log Settings section configures the size of the NetWitness log files and the number of backup logs
that NetWitness maintains.

o Towemn

Max Log Configures the maximum size in bytes of each log file. The minimum value for this
Size setting is 4096,

Max # Specifies how many backup log files are maintained. The minimum value for this setting
Backup is 0. When the maximum number of log files is attained, and a new backup file is made,
Files the oldest backup is discarded.
D Displays ERROR, STACK, and TRACE log messages.
Show
Error Stack
Trace
Apply Puts the settings into effect immediately for all future logs.

Package Configuration

The Package Configuration section shows the NetWitness packages in a tree structure.

e

Package tree  Contains all the packages used within NetWitness. You can drill down into the tree to
view the log levels of each package.

The root logging level represents the default log level for all packages that are not
explicitly set. The root level is set to INFO

Package The name of the selected package when you select a package in the Package tree.
field

Log Level If the selected package has a log level explicitly set, the value is displayed in the Log
Level field.

M Reget Resets the log recursively.
recursively
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Apply Puts settings into effect immediately for all future logs.

Reset Resets the selected package to the log level of root,

277



System Logging - Realtime Tab

This topic describes the features of the System Logging > Realtime tab and the Services Logs view >
Realtime tab.

The Realtime tab is a view of the NetWitness log or a service log. When it is initially loaded, the view
contains the last 10 log entries. As new entries become available, the view is updated with those entries.

To access the Realtime tab:

Q
1. Goto (Admin) > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

What do you want to do?

Administrator See details of Log entry Display System and Service Logs

Related Topics

System Logging - Settings View

System Logging - Historical Tab

Quick Look

The following is an example of the Realtime tab in the System Logging panel.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

SERVICES ~ EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS ~ SYSTEM  SECURITY

i System Logging
Updates
> Bl——" recitime | Historical | settings
Licensing
ALL | Keywords Search
Email
Timestamp Level Message

Global Notifications
2021-05-14T10:49:09.847 INFO  Received Config Update from metrics-server

Legacy Notifications 2021-05-14T11:02:14.457  INFO  LicensingMiscConfiguration changed by admin
I System Logging ‘_- 2021-05-14T11:04:36.662 WARN  Conversion to List failed as connection to ContextHub was not established
Global Auditing 2021-05-14T11:09:34.970  INFO  Pushing http config to sms is already done for the day. [Last Updated Date : 202105141
2021-05-14T11:19:09.729  INFO  Received Config Update from metrics-server

obs
: 2021-05-14T11:28:22.887  WARN null timed out in receive(): 81d4, . closed: false, connection: true, queue: 0
Live Services 2021-0514T11:28:22.925  ERROR  Falled to retrieve authentication entry
URL Integration 2021-05-14T11:2822.925 ERROR  java.utilconcurrent.Rejected: Task com.rsa.netwitr i mon.SharedT] rejected from com.rsa.netwit rlos.common.SharedThre

Context Menu Actions 2021-05-14T11:28:24.127  WARN  Skipping URI variable 'service' because request contains bind value with same name.

2021-05-14T11:34:36.667  WARN Conversion to List failed as connection to ContextHub was not established
Investigation
HTTP Proxy Settings
NTP Settings

Dashboard Settings

Displays System Logging Panel
Displays Realtime Tab
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The following is an example of the Realtime tab in the Services Logs view, which is similar.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports (o]

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM SECURITY

+ Change Service | WM adminserver - Broker | Logs.

System Logging

Realtime Historical

ALL | Keywords Broker v | search
Timestamp Level  Message

2021-05-14T11:31:55.000  INFO  Running task /sys with message telemtry ( fdBEVEWD: 7XAA3ftoLrEaCCl USa+SpAO TW2NILJ 1 nTpapCoZ50Yx5U340¢ Jj77Ipt U2mp6x716Ct
2021-05-14T11:33:56.000 INFO  Running task /sys with message telemtry (1 fdB8VEWD 7XAA3ftOLrEACCIq9e0SUSa+SpAO3dhkSCWNbbHN7W2NiLJHbeKkfgkw32yw 1 nTpapCozsoYxsU34l i< U2mp6x716Ct
2021-05-14T11:35:05.000  INFO  Accepting connection from trusted peer with subject name CN = rsa-nw-metrics-server

2021-05-14T11:35:05.000  AUDIT  User metrics-server (session 72526, - ) has logged in
2021-05-14T11:35:10.000  AUDIT  User metrics-server (session 72526, 1 has logged out
2021-05-14T11:35:57.000  INFO  Running task /sys with message telemtry (1 fdBEVEWD: 7XAA3ftoL rEaCCIq9e05USa+SpAO3dhkScWnbbHN7W2NiLJHbeKkfgkwa2yw1 nTpapCoZ5oYx5 U340 Uq77Ip: i) U 16Cteesgo8X3,
2021-05-14T11:37:58.000 INFO  Running task /sys with message telemtry (14P/rkoOva+GOfdB8VgwDzZgFI3wf8BroedsEV7XAASftoL rEaCCIq9e05USa+SpAO3dhkScWnbbHN7W2NiLJHbeKkfgkw32yw1 nTpapC9Z50Yx5U340CmTnkzi NSUCj77Ip U 16Ct
2021-05-14T11:38:58.000 INFO  Accepting connection from trusted peer 1 1 with subject name C = US, ST = VA, L = Reston, O = RSA, OU = NetWitness, CN = b
2021-05-14T11:38:58.000  AUDIT  User admin (session 72561, 2) has logged in
2021-05-14T11:38:58.000  AUDIT  User escalateduser (session 72604, ) has logged in

Features

The Realtime tab has a toolbar with input fields to allow filtering of the entries, and below the toolbar is
a grid containing the log entries.

Toolbar

Description

Log Level drop-  Selects the log level for entries to display in the grid. The Log Level drop-down
down shows the available log levels for the system or the service.

ALL Y1 System logs have seven log levels.
ALL

TRACE
DEBUG
INFO ¢ The default is ALL log entries.
WARN

ERRCR

FATAL

¢ Service logs have only six log levels because they do not include the TRACE
level.

Keywords field  Specifies a keyword to use when filtering entries. This field is the same for
system and service log filtering.

Service field Specifies the service type to use when filtering service log entries. Possible
(Service Logs values are the host or the service.
only)

Search button  Click to activate filtering based on the log level, keyword, and service selections.
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Log Grid Columns

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.
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System Logging - Historical Tab

The Historical tab provides a searchable view of a NetWitness log or a service log in a paged
format. When initially loaded, the grid shows the last page of the log entries for the system or the
system.

To access the Historical tab:

1. Goto (Admin) > System.
2. In the options panel, select System Logging.

The System Logging panel opens to the Realtime tab by default.
3. Click the Historical tab.

What do you want to do?

Administrator View the Historical Graph Historical Graph for System Stats

Related Topics

System Logging - Realtime Tab

System Logging - Settings View

Quick Look

The following is an example of the Historical tab in the System Logging panel. It shows the NetWitness
logs.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS  SERVICES  EV SOURCES ~ ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM  SECURITY

i System Logging
Updates §
Realtime | Historical Settings
Licensing - -
Start Date End Date ALL v || Keywords Search [ Export -
Email
Timestamp Level  Message

Global Notifications

2021-05-14T08:46:08.758  WARN  Could not determine host for certificate CN=metricheat, OU=NetWitness,0=RSA,L=Reston ST=VA C=US: metricbeat
Legacy Notifications

2021-05-14T08:49:15.065  INFO  Received Config Update from metrics-server

| system Logging ‘—- 2021-05-14T09:04:36.629  WARN  Conversion to List failed as connection to ContextHub was not established

Global Auditing 2021-05-14T09:09:34.969  INFO  Pushing http config to sms is already done for the day. [Last Updated Date : 2021-05-14 ]
Jobs 2021-05-14T09:19:13.966  INFO  Received Config Update from metrics-server
2021-05-14T09:34:36.643  WARN  Conversion to List failed as connection to ContextHub was not established
Live Services
2021-05-14T09:39:33.090  WARN  Service has not received update, resetting decoder - Decoder
URL Integration 2021-05-14T09:39:33.002  WARN  Service has not received update, resetting decoder - Warehouse Connector
Context Menu Actions 2021.05-14T09:49:12357  INFO  Received Config Update from metrics-server

Investigation 2021-05-14T10:04:36.648  WARN  Conversion to List failed as connection to ContextHub was not established

2021-05-14T10:0934970  INFO  Pushing http config to sms is already done for the day. [Last Updated Date : 2021-05-14]
HTTP Proxy Settings
2021-05-14T10:19:11.544  INFO  Received Config Update from metrics-server

b Sl 2021-05-14T10:34:36.657 WARN  Conversion to List failed as connection to ContextHub was not established

Dashboard Settings 2021-05-14T10:49:09.847 INFO  Recelved Config Update from metrics-server
2021-05-14T11:02:14457 INFO  LicensingMiscConfiguration changed by admin
2021-05-14T11:0436.662  WARN  Conversion to List failed as connection to ContextHub was not established
2021-05-14T11:09:34.970  INFO  Pushing htp config to sms is already done for the day. [Last Updated Date : 2021-05-14 ]

2021-05-14T11:19:09.720  INFO  Received Config Update from metrics-server =

&« €| Page 49 of49 | I c Displaying 2401 - 2428 of 2428

Displays System Logging Tab
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Displays Historical Tab

The following is an example of the Historical tab in the Services Logs view. It shows the services logs.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports (o] = % @ admin

HOSTS  SERVICES  EVENT SOURCES ~ ENDPOINT SOURCES ~ HEALTH & W SYSTEM  SECURITY

%, Change Service | 8 endpointloghybrid1 - Log Collector | Logs

System Logging

Realtime Historical

Start Date [ EndDate [ AL v Keywords Log Collector v | Search 2 Export ©

Timestamp Level | Message

2021-05-14T11:16:01.000  INFO Running task /sys with message telemtry (oFN2bJ EurFD! 4t6v mbjcZ8I3PCUXBDBSOE +blw|bfDGBOgngoSIkdcRi/7x50HUU7evNhtsyFOJfR/USTFHPSQzV3FLxplemrHx66e0hgCZmyPUVsBRpxDjarDNEHIHafLF..
2021-05-14T11:18:02000  INFO  Running task /sys with message telemiry (oFN2b) EurfD! UXED: Ri/7x50HUU7eVNhisyFOJfR/USTFHPSQZVAFLiplcmrHxG6e0hgCZmyP UVSBRpXDjarDNEHIHaf2LF.
2021-05-14T11:20:03.000  INFO Running task /sys with message telemtry (oFN2bJYWbIZjlckq28EurFD At6VT mbjcZ8I3PCU: blw)bi Ri/7x50HuU7evNhtsyFOjfR/USFHpSQzV3FLxplemrHx66e0hgCZmyPUvs8RpxDjarDNEHIHafzLF..
2021-05-14T11:22:04.000  INFO Running task /sys with message telemtry (oFN2b) EurFD UXBD! il Ri/7x50HUU7evN htsyFOJfR/USTFHPSQZV3FLXplcmrHX66e0hgCZmyPUVsBRpXDjarDNEHIHafZLF.
2021-05-14T11:24:05.000 INFO  Running task /sys with message telemtry (oFN2bJYWbiZjlckq28EurFD! 4ty UXBDBSOE+blwjbi Ri/7x50HUU7evNhtsyFOJfR/uSTFHPSQZV3FLiplcmrHx66e0hgCZmyPUvsBRpxDjar DNEHIHfLF.
2021-05-14T11:26:06.000  INFO Running task /sys with message telemtry (oFN2bJ EurFD! 4t6v’ mbjcZ8I3PCUXBDBSOE +blw]bfDGBOgNgoSIkACRI/7x50HUU7evNhtsyFOjfR/USFFHPSQzV3FLxplcmrHx66e0hgCZmyPUvsBRpxDjarDNEHIHafZLF...

2021-05-14T11:27:54.000  WARN  User admin has a mismatch for query.timeout in local account and trusted credentials. Using supplied value 5.

2021-05-14T11:27:54000 WARN ~ User admin has a mismatch for session.threshold in local account and trusted credentials. Using supplied value 100000,

2021-05-14T11:27:54.000  AUDIT  User admin (session 395254, 17 “ 27 757 *74:45495) has logged in

2021-05-14T11:27:54.000  INFO Accepting connection from trusted peer 154 with subject name C = US, ST = VA, L = Reston, O = RSA, OU = NetWitness, CN = I

2021-05-14T11:27:54.000  AUDIT User admin (session 395283, 10.1 as logged in

2021-05-14T11:27:54000  AUDIT  User escalateduser (session 395296, 1) has logged in

2021-05-14T11:28:07.000  INFO Running task /sys with message telemtry (oFN2bJYWbIZjlckq28EurFD 4t6v mbjcZ8I3PCU: blw)bi Ri/7x50HuU7evNhtsyFOjfR/USFHpSQzV3FLxplemrHx66e0hgCZmyPUvs8RpxDjarDNEHIHafLF..
2021-05-14T11:28:22.000 AUDIT  User escalateduser (session 188245, ) has logged out

2021-05-14711:28:22.000  AUDIT User admin (session 395254, 7 5) has logged out

2021-05-14T11:28:22.000  INFO Connection 0 (' 1) logged off user

2021-05-14T11:28:23.000  INFO Accepting connection from trusted peer 1 1with subject name C = US, ST = VA, L = Reston, O = RSA, OU = NetWitness, CN = .
€ € | Page 200 of 200 C Displaying 9951 - 10000 of 10000

Features

The Historical tab has a toolbar with input fields to allow filtering of the entries, a grid containing the log
entries, and paging tools.

Description

Start Date  The Start Date and End Date range search options limit the log entries to a point in time.
and End  When used, you must provide both a start and end date. The times are optional. The date
Date range is validated to assure that the end date is not before the start date.

Log Level Selects the log level for entries to display in the grid. The Log Level drop-down shows

drop-down the available log levels for the system or the service.

ALL ~

ALL ¢ System logs have seven log levels.
TRACE
DEBUG
INFO

WARN

ERROR e The default is ALL log entries.

FATAL

e Service logs have only six log levels because they do not include the TRACE level.

Keyword  Specifies a keyword to use when filtering entries. This field is the same for system and
field service log filtering.

Service Specifies the service type to use when filtering service log entries. Possible values are the
field host or the service.
(Service
Logs only)

Search Click to activate a search based on the start and end date, log level, keyword, and service
button selections.
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Export Click to export the currently viewed grid entries to a text file. You can select either
comma-separated or tab-separated format for the entries in the file.

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.

The paging tools below the grid provide a way to navigate through the pages of log entries.
| Page 1 ofi6 | » » | C

Search Log Entries

To search the results shown in the Historical tab:

1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.
2. (Optional) For system and service logs, select a Log Level and a Keyword, or both.

3. (Optional) For service logs, select the Service: host or service.

4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To view
complete details:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and Message,
is displayed.
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Timestamp 2017-09-27T09:22:02.505
Logger Name Index

Thread

Level INFO

Message Indexes are being initialized

Close

2. When finished viewing, click Close.

Page Through the Entries
To view the different pages of the grid, use the paging controls on the bottom of the grid as follows:
* Use the navigation buttons

e Manually enter the page you want to view, and press ENTER.

Export

To export the logs in the current view:

Click Export, and select one of the drop-down options, CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example, a
NetWitness system log exported with comma-separated values is named UAP log export CSV.txt,
and an appliance log exported with tab-separated values is named APPLIANCE log export TAB.txt.
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